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ESG Family Signal Generators

1 Preparing for Use

This chapter contains procedures that show you how to install your signal generator and
how to perform a functional check to verify signal generator operation. Also, look here for
our Internet address for the Agilent Technologies ESG family.
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Installing the Signal Generator

This section contains procedures for properly installing your signal generator:
= checking the shipment

< installing front handles and rack flange kits

< meeting electrical and environmental requirements

= adjusting the display

« selecting the signal generator's GPIB address

= selecting the programming language

Checking the Shipment

1. Inspect the shipping container for damage.

Look for signs of damage such as a dented or torn shipping container, or cushioning
material that shows signs of unusual stress or compacting.

2. Carefully remove the contents from the shipping container and verify that your order is
complete. A power cord and a documentation set are shipped standard with your signal
generator. Verify that you have received any options that you ordered.

Installing Front Handles and Rack Mount Flanges

You can attach handles to the front of the signal generator to facilitate transportation of
the instrument. Handles are available in a kit which can be ordered when the signal
generator is purchased (Option 1CN), or at any time afterward. Assembly instructions are
included with the kit. The kit part number is listed in Table 1-1.

You can also rack mount the signal generator. Hardware is available in Kits to install rack
mount flanges on the signal generator without or with handles. These Kkits can be ordered
when the signal generator is purchased (Options 1CM and 1CP), or at any time afterward.
Assembly instructions are included with the kits. The kit part numbers are listed in
Table 1-1.

Table 1-1 Front Handle and Rack Mount Flange Kits

Option Description Part Number
Option 1CN Front Handle Kit 5063-9227
Option 1CM Rack Mount Kit without Handles 5063-9214
Option 1CP Rack Mount Kit with Handles 5063-9221
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Meeting Electrical and Environmental Requirements

Line Settings

CAUTION This product has an autoranging line voltage input. Be sure that the supply
voltage is within the specified range.

The available AC power source must meet the following requirements:
Voltage:

100/115 volts nominal (90-132 volt range)

e 230/240 volts nominal (198-254 volt range)

Frequency:
= for 100/115 volts: 50/60/400 Hz nominal
= for 230/240 volts: 50/60 Hz nominal
Power:

e 200 watts maximum

WARNING This is a Safety Class 1 Product (provided with a protective earthing
ground incorporated in the power cord). The mains plug shall only
be inserted in a socket outlet provided with a protective earth
contact. Any interruption of the protective conductor inside or
outside of the product is likely to make the product dangerous.
Intentional interruption is prohibited.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure
to ensure adequate earth grounding by not using this cord may cause product
damage.

Verify that the power cable is not damaged and that the power source socket outlet
provides a protective earth contact.

Install the instrument so that the detachable power cord is readily identifiable and is
easily reached by the operator. The detachable power cord is the instrument disconnecting
device. It disconnects the mains circuits from the mains supply before other parts of the
instrument. The front panel switch is only a standby switch and is not a LINE switch.

Alternatively, an externally installed switch or circuit breaker (which is readily
identifiable and easily reached by the operator) may be used as a disconnecting device.
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Ventilation

CAUTION Ventilation Requirements: When installing the product in a cabinet, the
convection into and out of the product must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the product by 4 °C for every 100 watts dissipated in the
cabinet. If the total power dissipated in the cabinet is greater than 800 watts,
then forced convection must be used.

Cooling holes are located on the sides and bottom of the instrument cover and the rear
panel of the instrument. Do not allow these holes to be obstructed as they allow air flow
through the signal generator.

Environment
This product is designed for use in the following environmental conditions:

< indoor use
e < 15,000 feet (4,572 meters) altitude
« 0to 55 °C temperature, unless specified differently

< maximum relative humidity 80% for temperatures up to 31 °C, decreasing linearly to
50% relative humidity at 40 °C

CAUTION This product is designed for use in INSTALLATION CATEGORY Il and
POLLUTION DEGREE 2, per IEC 1010 and 664 respectively.

Proper Usage and Cleaning

The signal generator protects against finger access to hazardous parts within the
enclosure, but does not protect against the ingress of water.

WARNING If this product is not used as specified, the protection provided by
the equipment could be impaired. This product must be used in a
normal condition only (in which all means for protection are intact).

WARNING To prevent electrical shock, disconnect the signal generator from
mains before cleaning. Use a dry cloth or one slightly dampened with
water to clean the external case parts. Do not attempt to clean
internally.
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Adjusting the Display Contrast

You can adjust the contrast of the display by pressing the decrease contrast key or
the increase contrast key . These keys are located on the front panel below the
display.

Pressing the decrease contrast key and holding it down causes the display background to

gradually darken in comparison to the text on the display. The minimum contrast setting

is not a completely black display. Some contrast between the background and the text will
still be visible.

Pressing the increase contrast key and holding it down causes the display background to
gradually brighten in comparison to the text on the display. If the background does not
appear to change, it is probably set to the maximum contrast.

Selecting Inverse Video

The normal display mode for the signal generator is dark text on a light background. To
change to inverse video (light text on a dark background), press Utility > Display and set
Inverse Video Off On to On. Inverse video is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Adjusting the Screen Saver

You can increase the life expectancy of the signal generator’s display light by turning on
the screen saver. Leaving the display lit for long periods of time or turning the display on
and off frequently decreases the life of the bulb. With the screen saver on, the display light
is turned off after a defined period of time with no input to the front panel. The display
light turns on again when any front panel key is pressed or when a remote command is
sent.

The screen saver is set to off at the factory. You can turn it on by pressing Utility > Display >
Screen Saver Off On. Each time you press Screen Saver Off On the selection toggles between oOff
and on.

You can adjust the screen saver mode to turn the light on and off or to turn both the light
and text on and off. Press Utility > Display > Screen Saver Mode. You can toggle between Light
Only and Light & Text. Setting the mode to Light Only turns the display light off but leaves the
text visible at a low intensity. To prevent the text from burning the display, if you are
leaving the display unchanged for long periods of time, set the mode to Light & Text. This
mode turns the display light and the text off.

The screen saver delay is set to 1 hour at the factory. You can view and change the delay by
pressing Screen Saver Delay in the same menu. The current screen saver delay is displayed in
the softkey label and also in the active entry area. To change the delay, enter a new value
using the numeric keypad and then press Enter, or rotate the front panel knob. The
acceptable range of delay values is 1 through 12 hours in 1 hour increments.

The screen saver settings do not change when Preset is pressed, nor when power to the
instrument is cycled.
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Selecting the Signal Generator’'s GPIB Address

The signal generator's GPIB address is set to 19 at the factory. You can view and change
the address by pressing Utility > GPIB/RS-232 > GPIB Address. The current GPIB address is
displayed in the softkey label and also in the active entry area. To change the address,
enter a new value using the numeric keypad and then press Enter, or rotate the front panel
knob. The acceptable range of addresses is 0 through 30.

The GPIB address is a persistent state; it is not affected by an instrument preset or by a
power cycle.

Selecting the Signal Generator’s Programming Language

The default programming language for the signal generator is Standard Commands for
Programmable Instruments (SCPI). You can change this language selection by pressing
Utility > GPIB/RS-232 > Remote Language. The Remote Language menu allows you to select
between Agilent 8656/57-compatible language, Agilent 8648-compatible language, and
SCPI language. If you have Option UNS8, the Remote Language menu allows you to select
between Agilent 8656/57-compatible language, Agilent 8657D language (NADC digital
modulation capability), Agilent 8657D language (PDC digital modulation capability), and
Agilent 8657J (PHS digital modulation capability). Press the softkey for the selection that
you desire.

You can also change the language selection by sending the appropriate command over
GPIB. Refer to the programming guide for instructions for changing the language over
GPIB.

You can set the signal generator to default to a selected language as a persistent state
(remains unchanged after an instrument preset or power cycle). Press Utility >

Power On/Preset > Preset Language. The Preset Language menu allow you to select between
SCPI, the Agilent 8656/57-compatible programming languages, and

Agilent 8648-compatible language. Press the softkey for the selection that you desire.
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Verifying Signal Generator Operation

The operator’s check is appropriate as a daily functional check by users, or whenever the
integrity of the signal generator is in question. Use the operator’s check to verify proper
operation of the signal generator. The operator’s check does not ensure performance to
specifications. To verify specifications, refer to the calibration guide.

Operator’s Check

Perform the following tasks in order:

Power On the Signal Generator and Check for Error Messages

This procedure verifies that the signal generator powers up and that the internal
instrument check identifies no errors.

1. Turn power on to the signal generator by pressing the power switch. The green LED
will light. Let the instrument warm up for one hour.

2. Cycle the power to the signal generator. The green LED should again be lit and the
instrument will perform a check.

3. When the display is lit, check to see if the ERR annunciator is turned on.

4. If the ERRannunciator is turned on, review the error messages in the queue by pressing
Utility > Error Info. The first error message in the queue will be shown in the text area of
the display. Refer to the error messages guide for information about the error message.

If there is more than one error message (each message will be designated as 1 of n),
press the View Next Error Message softkey until you have seen all of the messages.

5. When you have resolved all of the error messages, press Clear Error Queue(s) to delete the
messages. Then restart this procedure at step two.

NOTE For ESG-AP, ESG-DP, and Option 1E5 signal generators, ERROR 514,
Ref erence Oven Col d, will occur whenever the signal generator is first
connected to AC line power. The OVEN COLD annunciator and the ERR
annunciator will both turn on. The OVEN COLD annunciator will automatically
clear after approximately 5 minutes. The error queue cannot be cleared,
however, until the OVEN COLD annunciator has turned off.

Verify Maximum Specified Power is Available at the Maximum Frequency

This procedure verifies that there are no unleveled power indications or error messages at
the maximum specified frequency and power level.

1. Calibrate the power meter with the power sensor. (Refer to the power meter’'s manual
for assistance.)

2. Connect the power sensor to the signal generator's RF OUTPUT connector as shown in
Figure 1-1.
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Figure 1-1 Operator’'s Check Equipment Setup
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3. Preset the signal generator to the factory-defined conditions:
a. Press utility > Power On/Preset and toggle Preset until Normal is highlighted.
b. Press Preset.

4. Set the signal generator to its maximum specified frequency:
a. Press Frequency.

b. Use the numeric keypad to enter the signal generator's maximum specified
frequency as shown in Table 1-2.

c. Terminate your entry by pressing the GHz softkey.
5. Set the signal generator to its maximum specified power level:
a. Press Amplitude.

b. Use the numeric keypad to enter the signal generator’'s maximum specified power
level as shown in Table 1-2.

c. Terminate your entry by pressing the dBm softkey.

6. Toggle the front panel RF on/Off key to turn on RF power to the RF OUTPUT connector.
The display RF ON annunciator will turn on.

7. Verify that the power meter reads the maximum specified output power including the
power level accuracy limits.

8. Check to see if the UNLEVEL or ERR display annunciators have turned on. If these
annunciators are on, refer to the service guide for troubleshooting information.
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Table 1-2 Frequency and Power Level Limits

Preparing for Use

Verifying Signal Generator Operation

ESG Model

Maximum
Specified
Frequency

Maximum
Specified
Power

Power Level
Accuracy

Limits?

E4400B
E4430B
E4423B
E4434B

1 GHz

+13 dBm

0.7 dB

E4420B
E4431B
E4424B
E4435B

2 GHz

+10 dBm

+0.7 dB

E4421B
E4432B
E4425B
E4436B

3 GHz

+10 dBm

+1.0dB

E4422B
E4433B
E4426B
E4437B

4 GHz

+7 dBm

+1.0dB

1. The values provided are confidence levels only; they are
not specifications and may vary with installed options.
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See Agilent Technologies ESG Family Internet Page for
the Latest Information
Get the latest news, product and support information, application literature and more.

Agilent Technologies Internet address for the ESG family is:
http://www.agilent.com/find/esg.
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2 Using Functions

This chapter contains procedures that show you how to use some of the major functions of
your signal generator including setting frequency and power levels, setting up
modulations, creating step and list sweeps, saving and recalling instrument states, and
enabling options.

Information is also provided on what you should do if you encounter a problem with your
signal generator.
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Setting Frequency and Power Levels
Using these procedures, you will learn how to:

= set the RF frequency

= set a frequency reference and a frequency offset

= set the RF output power level

= set an amplitude reference and an amplitude offset

To Set the RF Frequency

1. Turn on power to the signal generator: press the power switch, [®T |, so that the green
LED is on. The signal generator will perform an internal check.

2. Press the green preset key. The signal generator will return to a set of factory-defined
conditions.

NOTE You can change the preset conditions to a user-defined instrument state.
However, for the purpose of these examples, use the factory-defined preset
state (the Preset Normal User softkey in the Utility menu must be set to Normal).

3. Observe the frequency area of the display (in the upper left-hand corner). It should
display the maximum specified frequency of your signal generator.

4. The signal generator is set to output an RF signal, however the RF on/0ff key must be set
to on before the RF signal is available at the RF OUTPUT connector. Press RF On/Off.
Notice that the display annunciator changes from RF OFF to RF ON. The maximum
specified frequency is now being output at the RF OUTPUT connector.

5. Change the frequency to 700 MHz by pressing Frequency. The current RF frequency is
now displayed in the active entry area of the display. Using the numeric keypad, enter
700 and then press the MHz terminator softkey. The new 700 MHz RF frequency is now
displayed in the frequency area of the display and also in the active entry area.

6. Frequency is still the active function until you press another front panel function key.
Change the frequency again by pressing the up arrow key once. Each press of the up
arrow key increases the frequency by the increment value last set with the Incr Set key.
The increment value is displayed in the active entry area.

The down arrow works like the up arrow. Practice stepping the frequency up and down
in 1 MHz increments. Use the Incr Set key to change the increment value to 1 MHz, if
necessary.

7. You can also adjust the RF frequency using the front panel knob. As long as frequency is
the active function (the frequency is displayed in the active entry area), the front panel
knob will increase and decrease the RF frequency. Use the front panel knob to adjust
the frequency back to 700 MHz.
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To Set a Frequency Reference and a Frequency Offset

The following procedure sets the RF output frequency as a reference frequency to which all
other frequency parameters are relative. The frequency initially shown on the display will
be 0 Hz (the frequency output by the hardware minus the reference frequency). Although
the display changes, the frequency output does not change. Any subsequent frequency
changes are shown as incremental or decremental to 0 Hz.

1. Press Preset to return the signal generator to the factory-defined instrument state.
2. Set the RF frequency to 700 MHz.

3. Turn on frequency reference mode and set the current output frequency (700 MHz) as
the reference value. Press Freq > Freq Ref Set. The frequency displayed is 0 Hz (the
frequency output by the hardware, 700 MHz, minus the reference value, 700 MHz).
Notice that the REF indicator is turned on and the Freq Ref softkey has toggled to on.

4. Set the RF On/Off key to on. Notice that the display annunciator has changed from
RF OFF to RF ON. The RF frequency at the RF OUTPUT connector is 700 MHz.

5. Increment the output frequency by 1 MHz. Press the up arrow key. The frequency
display changes to show 1 MHz (the frequency output by the hardware,
700 MHz + 1 MHz, minus the reference frequency, 700 MHz) and the output frequency
changes to 701 MHz.

6. Enter a 1 MHz offset. Press the Freq Offset softkey and enter 1 MHz using the numeric
keypad and pressing the MHz terminator softkey. The frequency display shows 2 MHz
(the frequency output by the hardware, 701 MHz, minus the reference frequency,

700 MHz, plus the offset, 1 MHZz). Notice that the OFFSET indicator is turned on. The
frequency at the RF OUTPUT connector is still 701 MHz.

To Set the RF Output Power Level

1. Press Preset to return the signal generator to the factory-defined instrument state.

2. Observe the amplitude area of the display (in the upper middle of the display). It should
display —135 dBm. This is the normal preset RF output power level.

3. The signal generator is set to output an RF signal, however the RF on/off key must be set
to on before the RF signal is available at the RF OUTPUT connector. Press RF On/Off.
Notice that the display annunciator changes from RF OFF to RF ON. The RF signal is
now being output at a —135 dBm level at the RF OUTPUT connector.

4. Change the power level to —20 dBm. Press Amplitude. The current power level is now
displayed in the active entry area of the display. Using the numeric keypad and the key,
enter -20 and then press the dBm softkey. The new —20 dBm RF output power is now
displayed in the amplitude area of the display and also in the active entry area.

5. Amplitude is still the active function until you press another front panel function key.
You can also change the amplitude using the up and down arrow keys and the front
panel knob. Practice changing the amplitude using these methods also.
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To Set an Amplitude Reference and an Amplitude Offset

The following procedure sets the RF output power as an amplitude reference to which all
other amplitude parameters are relative. The amplitude initially shown on the display will
be 0 dB (the power output by the hardware minus the reference power). Although the
display changes, the output power does not change. Any subsequent power changes are
shown as incremental or decremental to O dB.

1. Press Preset to return the signal generator to the factory-defined instrument state.
2. Set the RF output power to —20 dBm.

3. Turn on amplitude reference mode and set the current output power (=20 dBm) as the
reference value. Press Ampl > More (1 of 2) > Ampl Ref Set. The amplitude displayed is 0 dB
(the power output by the hardware, —20 dBm; minus the reference value, —20 dBm).
Notice that the REF indicator is turned on and the Ampl Ref softkey has toggled to on.

4. Set the RF on/Off key to On. Notice that the display annunciator has changed from
RF OFF to RF ON. The power at the RF OUTPUT connector is =20 dBm.

5. Use the up arrow key to increase the output power by 10 dB. The amplitude display
changes to show 10 dB (the power output by the hardware, —20 dBm; +10 dBm; minus
the reference power, —20 dBm) and the output power changes to -10 dBm.

6. Enter a 10 dB offset. Press the Ampl Offset softkey and enter 10 dB using the numeric
keypad. The amplitude display shows 20 dB (the power output by the hardware,
—-10 dBm; minus the reference power, —20 dBm; plus the offset, 10 dB). Notice that the
OFFS indicator is turned on. The power at the RF OUTPUT connector is still -=10 dBm.

2-4 User’s Guide



ESG Family Signal Generators Using Functions
Setting Up Internally Generated Amplitude Modulation

Setting Up Internally Generated Amplitude
Modulation

Using this procedure, you will learn how to generate an amplitude-modulated signal with
the following characteristics:

< carrier frequency set to 1340 kHz
« power level set to 0 dBm

< AM depth set to 90%

= AM rate set to 10 kHz

Setting the Carrier Frequency

1. Preset the signal generator to the factory-defined instrument state.

2. Press the front panel Frequency key. Frequency becomes the active function and the
normal preset value for frequency is displayed in the active entry area.

3. Enter 1340 kHz using the numeric keypad and pressing the kHz terminator softkey. The
new carrier frequency is shown in the frequency area of the display. You should see
1. 340 000 00 MHz.

Setting the Power Level

1. Press the front panel Amplitude key. Amplitude becomes the active function and the
normal preset value for amplitude is displayed in the active entry area.

2. Enter 0 dBm using the numeric keypad and pressing the dBm terminator softkey. The
new power level is shown in the amplitude area of the display. You should see 0. 00 dBm

Setting the AM Depth

1. Press the front panel Am key. The first level menu of softkeys is displayed.

2. Press the AM Depth softkey. AM depth becomes the active function and the normal preset
value for AM depth is displayed in the active entry area.

3. Enter 90% using the numeric keypad and pressing the % terminator softkey. The new
AM depth is displayed below the AM Depth softkey. You should see 90.0 % in the second
line of the softkey.
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Setting the AM Rate

1. In the same AM menu, press the AM Rate softkey. AM rate becomes the active function
and the normal preset value for AM rate is displayed in the active entry area.

2. Enter 10 kHz using the numeric keypad and pressing the kHz terminator softkey. The
new AM rate is displayed below the AM Rate softkey. You should see 10.0000 kHz in the
second line of the softkey.

Turning On Amplitude Modulation

The signal generator is now configured to output a 0 dBm, amplitude-modulated carrier at
1340 kHz with the AM depth set to 90% and the AM rate set to 10 kHz. The shape of the
waveform is a sinewave (notice that sine is the default for the AM waveform softkey). Follow
these remaining steps to output the amplitude-modulated signal.

1. In the same AM menu, press the AM Off On softkey. AM toggles from off to on. Notice,
also, that the AMdisplay annunciator is turned on indicating that you have enabled
amplitude modulation.

2. Press the front panel RF On/0ff key to toggle RF on. Notice that the display annunciator
changes from RF OFF to RF ON. The modulated signal is now available at the RF
OUTPUT connector.
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Setting Up Internally Generated Frequency
Modulation

Using this procedure you will configure the signal generator to output a
frequency-modulated signal with the following characteristics:

e carrier frequency set to 104.9 MHz
« power level set to 0 dBm

= FM deviation set to 75 kHz

= FM rate set to 10 kHz

Setting the Carrier Frequency

1. Preset the signal generator to the factory-defined instrument state.

2. Press the front panel Frequency key. Frequency becomes the active function and the
normal preset value for frequency is displayed in the active entry area.

3. Enter 104.9 MHz using the numeric keypad and pressing the MHz terminator softkey.
The new carrier frequency is shown in the frequency area of the display. You should see
104. 900 000 00 MHz.

Setting the Power Level

1. Press the front panel Amplitude key. Amplitude becomes the active function and the
normal preset value for amplitude is displayed in the active entry area.

2. Enter 0 dBm using the numeric keypad and pressing the dBm terminator softkey. The
new power level is shown in the amplitude area of the display. You should see 0. 00 dBm

Setting the FM Deviation

1. Press the front panel Fm/oM key. The first level menu of FM softkeys is displayed.

2. Press the FM Dev softkey. FM deviation becomes the active function and the normal
preset value for FM deviation is displayed in the active entry area.

3. Enter 75 kHz using the numeric keypad and pressing the kHz terminator softkey. The
new FM deviation is displayed below the FM Dev softkey. You should see 75.0000 kHz in the
second line of the softkey.
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Setting the FM Rate

1. In the same FM menu, press the FM Rate softkey. FM rate becomes the active function
and the normal preset value for FM rate is displayed in the active entry area.

2. Enter 10 kHz using the numeric keypad and pressing the kHz terminator softkey. The
new FM rate is displayed below the FM Rate softkey. You should see 10.0000 kHz in the
second line of the softkey.

Turning On Frequency Modulation

The signal generator is now configured to output a 0 dBm, frequency-modulated carrier at
104.9 MHz with the FM deviation set to 75 kHz and the FM rate set to 10 kHz. The shape
of the waveform is a sinewave. (Notice that sine is the default for the FM waveform softkey.
Press More (1 of 2) to see the softkey.) Follow these remaining steps to output the
frequency-modulated signal.

1. In the same FM menu, press the FM Off On softkey. FM toggles from off to on. Notice,
that the FMdisplay annunciator is turned on indicating that you have enabled frequency
modulation.

2. Press the front panel RF On/0ff key to toggle RF on. Notice that the display annunciator
changes from RF OFF to RF ON. The modulated signal is now available at the RF
OUTPUT connector.
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Creating a Step Sweep and a List Sweep

Using this procedure, you will learn two ways to set up the signal generator to sweep a
defined set of points. You will create a step sweep and then you will use these points as the
basis for a new list sweep.

In the first procedure, you will create a step sweep with the following ten, equally spaced
points:

= frequency range from 525 MHz to 600 MHz
< power level from -20 dBm to 0 dBm
< dwell time 500 ms at each point

In the second procedure, you will take the step sweep points and edit several points to
change the sweep information.

Configuring a Step Sweep

1. Preset the signal generator to the factory-defined instrument state.

2. Press the front panel sweep/List key. The first level of sweep softkeys is displayed. Toggle
the sweep Type List Step softkey to Step.

3. Press the Configure Step Sweep softkey. Another menu is displayed with softkeys that you
will use to create the sweep points.

4. Change the start frequency of the step sweep. Press the Freq Start softkey. Enter
525 MHz using the numeric keypad and pressing the MHz terminator softkey.

5. Change the stop frequency of the step sweep. Press the Freq Stop softkey. Enter 600 MHz
using the numeric keypad and pressing the MHz terminator softkey.

6. Set the power level for the start of the step sweep. Press the Ampl Start softkey. Enter
—20 dBm using the numeric keypad and pressing the dBm terminator softkey.

7. Set the power level for the end of the step sweep. Press the Ampl Stop softkey. Enter
0 dBm using the numeric keypad and pressing the dBm terminator softkey.

8. Set the number of sweep points. Press the # Points softkey. Enter 8 by rotating the front
panel knob until the number 8 is displayed.

9. Set the dwell time at each point. Press the Step Dwell softkey, then enter 500 ms using
the numeric keypad and pressing the msec terminator softkey.
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Turning On Continuous Step Sweep

1.
2.

Press Return to move up one menu level.

Press the sweep softkey. Another menu is displayed showing you choices for sweeping
either the frequency, amplitude, or frequency and amplitude data. Press the Freq& Ampl
softkey. Selecting this softkey returns you to the previous menu and turns the sweep
function on.

Press the Sweep Repeat Single Cont softkey to toggle from Single to Cont. Notice that the
SVEEP display annunciator is turned on indicating that the signal generator is
sweeping.

Press the front panel RF on/0ff key to toggle RF on. Notice that the display annunciator
changes from RF OFF to RF ON. The swept RF signal is now available at the RF
OUTPUT connector.

Configuring a List Sweep Using Step Sweep Data

1.
2.

Press the sweep Type List Step softkey to toggle from Step to List.

Press the Configure List Sweep softkey. Another menu is displayed with softkeys that you
will use to create the sweep points. Notice that the display shows the current list data.
(When no list has been previously created, the default is one point set to the signal
generator’'s maximum frequency, —135 dBm, with a dwell time of 2 ms.)

Press More (1 of 2) > Load List From Step Sweep >Confirm Load From Step Sweep. The points you
defined in the step sweep are automatically loaded into the list.

Editing List Sweep Points

1.

For point 1, change the dwell time to 100 ms. Press the right arrow key twice until the
dwell time is highlighted. Press More (2 of 2) > Edit Item. The dwell time for point 1
becomes the active function. Enter 100 ms using the numeric keypad and pressing the
msec terminator softkey. Note that the next item in the table (in this case, the frequency
value for point 2) becomes highlighted after you press the terminator softkey.

For point 4, change the frequency to 560 MHz. Using the arrow keys, highlight the
frequency. Press the Edit Item softkey to make the frequency for point 4 the active
function. Enter 560 MHz using the numeric keypad and pressing the MHz terminator
softkey.

. Add a new point between points 7 and 8. Highlight any column in the point 7 row. Press

Insert Row. A copy of the point 7 row is placed between points 7 and 8, creating a new
point 8, and renumbering the successive points.

. Shift frequency values down one row, beginning at point 8. Highlight the frequency item

for point 8, then press Insert Item . Note that the original frequency values for both points
8 and 9 shift down one row, creating an entry for point 10 that has only a frequency
value (the power and dwell time items do not shift down).
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5. The frequency for point 8 is still active. Enter 700 and press the MHz softkey.

NOTE An informational ERR annunciator turns on to indicate that the frequency
and power lists are of unequal size. You will correct this problem in the
following steps, however the annunciator does not turn off until you clear the
error queue in the Utility menu [Utility > Error Info > Clear Error Queue(s)].

6. The power for point 8 should now be highlighted. Press Insert Item and change the value
to 1 dBm. Inserting a new power value at point 8 shifts down the original power values
for points 8 and 9 by one row.

7. Highlight the dwell time for point 9, then press Insert Item. A duplicate of the highlighted

dwell time is inserted for point 9, shifting the existing value down to complete the entry
for point 12.

Turning On List Sweep for a Single Sweep

1.
2.

Press Return to move up one menu level.

Notice that the sweep softkey is still set to sweep both frequency and amplitude data.
You do not need to change it.

Press the Sweep Repeat Single Cont softkey to toggle from Cont to Single. Notice that the
SVEEP display annunciator is turned off. The sweep will not occur until it is triggered.

Press single Sweep. The signal generator will sweep the points in your list once. Notice
that the SVEEP display annunciator is turned on during the sweep.

Change the sweep trigger to occur when you press Trigger > More (1 of 2) > Sweep Trigger >
Trigger Key.

Press More (2 of 2) > Single Sweep to arm the sweep. Notice that the ARVED display
annunciator has turned on.

. Press the front panel Trigger key. The signal generator will sweep the points in your list

once and the SVEEP display annunciator is turned on during the sweep.
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Saving and Recalling an Instrument State

Using this procedure, you will learn how to save instrument settings to a memory register
and to recall the settings.

1. Preset the signal generator to the factory-defined instrument state.
2. Set up the signal generator with the following changes:

a. Set the frequency to 800 MHz.

b. Set the amplitude to 0 dBm.

c. Enable amplitude modulation (AMdisplay annunciator is on).

3. Save this instrument state in the signal generator memory in sequence 1, memory
register 01. Press Save > Select Seq. The sequence humber becomes the active function.
The signal generator will display the last sequence that you have used. Set the
sequence to 1 using the arrow keys.

Press select Reg. The register number in sequence 1 becomes the active function. The
signal generator will either display the last register used [accompanied by the text: (i n
use) ] or, if no registers are in use, will display register 00 [accompanied by the text:
(avai | abl e) ]. Use the arrow keys to select register 01.

4. Press Save Seq[1] Reg[01]. The current instrument settings including the frequency,
amplitude, and modulation changes you made have been stored in signal generator
memory.

5. Preset the signal generator to the factory-defined instrument state.

6. Recall your instrument state. Press the front panel Recall key. Notice that the Select Seq
softkey shows sequence 1. (This is the last sequence that you have used.) You do not
need to change the sequence. Press RECALL Reg. The register to be recalled in sequence 1
becomes the active function. Press the up arrow key once to select register 1. Notice that
your stored instrument settings have been immediately recalled.
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Enabling Options

The ESG Family Signal Generators are a highly flexible platform of instruments that you
can retrofit after purchase to add many new capabilities. Some new optional features are
implemented in hardware that you must install. Some options are implemented in
software but require the presence of optional hardware in the instrument. This example
shows you how to enable both hardware and software options.

Enabling a Hardware Option

1. When you purchase a new hardware option for your signal generator, the hardware and
instructions for installing the hardware will be included in a kit that you receive. Follow
the installation instructions to retrofit your signal generator with the new hardware.

2. Next, on the signal generator press Utility > Instrument Adjustments > Hardware Options to
access the Hardware Options menu. An example of the signal generator display follows:

FREQUENCY AMPLITUOE

400000000000 sz | -13500 @ | ==
H ’7@ Oeselect Item

Harduare Option Selection (Requires harduare for option to operate)

Selected Option Description
— = Oeselect. ALL
[IYE] Items
[0 n] Internal Dual Arbitrary Hawveform Generator
UN7 Internal Bit Error Rate (BER) Analuzer
Froceed Hith
Reconf igurat ion

— Ealiljr“ate'
Selected Items

The display indicates which options are currently enabled for the signal generator. In
this case Option UN3 is enabled, as indicated by the X placed in the “Selected” column.

3. Highlight the new option that you have just installed. (Use the up/down arrow keys or
the front panel knob.)

4. Press Select Item. An X will be placed in the “Selected” column.

Two other selection keys are available in this menu to help you identify the proper
options to be enabled. Deselect Item removes the X from the “Selected” column in the
highlighted option. Deselect All Items removes all occurrences of the X from the “Selected”
column.
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5. Press Proceed With Reconfiguration to enable all selected options. After pressing this
softkey, press Confirm Change to verify that you do want to reconfigure the signal
generator with the options that you have selected. If you do not want to continue, press
Return.

CAUTION If you enable an option that does not have the required hardware installed,
the menus for that option will be activated but the option cannot operate,
despite what the menus may seem to indicate.

6. Once you have installed optional hardware in your signal generator, perform a
download of calibration data from the hardware into non-volatile memory by pressing
Calibrate Selected Items. To confirm that you want to start the calibration, press Start
Calibration and Store Results. The calibration takes several minutes. During the calibration,
a message is displayed indicating the calibration is in progress and showing the percent
complete. When the calibration is finished, the Hardware Options menu is returned.

2-14 User’s Guide



ES

E
1.

G Family Signal Generators Using Functions
Enabling Options

nabling a Software Option

A license key is required to enable each software option. This license key is provided on
the license key certificate that you receive when you purchase the software option.
Access the Software Options menu by pressing Utility > Instrument Adjustments > Software
Options. An example of the signal generator display follows:

FREQUENCY

AMPLITUOE Madifu

400000000000 s |-135.00 cn

Softuare Option Selection Host ID = BA17ZEE3
Option License Key Description

. L7 AFSELFEFSF M1t i-Channel COMA

Hﬁf FE53502B3C9F Multi-Channel H-COMA

Froceed Hith
Reconf igurat ion

Verify that the host ID shown on the display matches the host ID on the license key
certificate. The host ID is a unique number for every instrument. If the host ID on the
license key certificate does not match your instrument, the license key cannot enable
the software option.

. On the display is a list of software options that are already enabled (if any) and the

software options that can be enabled. Software options are linked to specific hardware
options. Before a software option can be enabled, the appropriate hardware option must
be installed. For example, Option UN5, Multi-Channel CDMA, requires that

Option UND, Internal Dual Arbitrary Waveform Generator, be installed. If the software
option that you intend to install is listed in a grey font, the required hardware may not
be installed. (Look for an X in the “Selected” column of the appropriate hardware option
in the Hardware Options menu.)

. To enable the software option, highlight the desired option using the up/down arrow

keys or the front panel knob.

Press Modify License Key. Enter the 12-character license key (from your license key
certificate) using the softkeys and numeric keypad. When you have finished, press the
Enter terminator softkey.

. Press Proceed With Reconfiguration > Confirm Change to verify that you do want to

reconfigure the signal generator with the options for which you have provided a license
key. The instrument will enable the options and reboot.
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If You Encounter a Problem

If the signal generator is not operating as you expected, look for help in the following list of
symptoms and possible solutions. If you do not find a solution here, refer to the service
guide.

No RF Output?

The front panel RF on/off key must be set to on before the RF signal is available at the
RF OUTPUT connector. Check the annunciator on the display. If it reads RF OFF, press
RF On/Off once to toggle the RF output on.

RF Output Power too Low?

If the RF output power seems too low, look for an OFFSET or REF indicator in the amplitude
area of the display.

OFFSET tells you that an amplitude offset has been set. An amplitude offset changes the
value shown in the amplitude area of the display but does not affect the output power. The
amplitude displayed is equal to the current power output by the signal generator hardware
plus the value for the offset. To eliminate the offset, press Ampl > Ampl Offset. Enter 0 using
the numeric keypad and press the dB terminator softkey.

REF tells you that the amplitude reference mode is turned on. When this mode is on, the
displayed amplitude value is not the output power level; rather, it is the current power
output by the signal generator hardware minus the reference value set by the Ampl Ref Set
softkey. To exit the reference mode, press Ampl and toggle the Ampl Ref softkey to oOff. You
can then reset the output power to the desired level.

Optional Features are Not Working?

If you enable an option that does not have the required hardware installed, the menus for
that option will be activated but the option cannot operate, despite what the menus may
seem to indicate. Check to be sure that the required hardware is physically installed in the
sighal generator.

If a software option is disabled but should be enabled, try the following suggestions for
resolution:

= Verify that the optional hardware is installed.
= Verify that the hardware option is enabled.

= Verify that the software option is enabled with the correct license key. Refer to your
License Key Certificate for the correct license key or, if your option was installed by
Agilent Technologies, contact your local service office with the instrument model
number, the host ID, and the software option that should be enabled.
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No Modulation at the RF Output?

Although you can set up and enable various modulations, the RF carrier is modulated by
the enabled modulation only when you have also set Mod On/Off to On. Check the
annunciator on the display. If it reads MOD OFF, press the Mod On/Off key once to toggle the
modulation on.

Can’t Turn Off Sweep Mode?

In the sweep mode menu you can choose to set the sweep to various sweep types or to turn
sweep off. Press Sweep/List > Sweep and choose off from the sweep mode selections.

Recalled a Register and Sweep List is Missing?

Sweep information is not stored as part of the instrument state in a storage register. Only
the current step and list sweep is available to the signal generator and it cannot be stored
nor will it survive a factory preset.

All of the Registers Where You Previously Stored Instrument
States are Empty?

The save/recall registers are backed-up by a battery when AC power to the signal
generator is not connected. The battery may need to be replaced. To verify that the battery
has failed, turn off line power to the signal generator and unplug it. Then plug in the
instrument and cycle power on. If either error message —311 or =700 is stored in the error
message queue, your battery has failed. Refer to the service guide for battery replacement
instructions.

Saved an Instrument State in a Register but the Register is
Empty or Contains the Wrong State?

If you have intentionally, or unintentionally, selected a register number that is greater
than 99, the signal generator will automatically select register 99 to save your instrument

state. If the register number you intended to use is empty or contains the wrong
instrument state, recall register 99 as the instrument state may be saved there.

The Power Supply has Shut Down?

If the power supply is not working, it requires repair or replacement. There is no
user-replaceable power supply fuse. Refer to the service guide for instructions.
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Incorrect List Sweep Dwell Time?

If the signal generator does not dwell for the correct period of time at each sweep list point,
first check the sweep list dwell values for accuracy. Press Sweep/List > Configure List Sweep
and the sweep list values will be displayed. Edit the dwell values if they are incorrect.

NOTE The effective dwell time at the RF OUTPUT connector is the sum of the value
set for the dwell plus processing time, attenuator switching time, and settling
time. This additional time added to the dwell is generally a few milli-seconds.
The TTL output, however, available at the TRIGGER OUT connector, is
asserted high only during the actual dwell time.

If the list dwell values are correct, check to see if the Dwell Type List Step softkey is set to Step.
When step is selected, the signal generator will sweep the list points using the dwell time
set for step sweep rather than the sweep list dwell values. To view the step sweep dwell
time, press Configure Step Sweep and observe the value set for the Step Dwell softkey.

Can’t Turn Off Help Mode?

There are two help modes (single and continuous) available on the signal generator. In
single mode (the factory preset condition) when you press the Help key, help text is provided
for your next key press. Now press any key and you will exit the help function and the
function of the key you pressed is also executed. When you are in continuous help mode,
when you press the Help key, help text is provided for your next key press and that key’s
function is also executed (except for the Preset key). You will stay in this help mode until
you press the Help key again. To change from continuous to single mode, press Utility >
Instrument Info/Help Mode and toggle the Help Mode Single Cont softkey to Single.

LF OUTPUT Signal is a Sinewave but the RF OUTPUT Signal is
a Pulse Squarewave?

The LF OUTPUT connector will output a signal where the frequency and shape is set by
the internal source as it is being used by a modulation. However, if you are generating a
pulse squarewave, the LF OUTPUT signal is correctly output as a sinewave. That
sinewave is later squared by the modulator to generate the pulse modulation.
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Signal Generator is Locked Up?
If your signal generator is locked up, try the following suggestions for resolution:

< Make sure that the signal generator is not in remote mode. (The Rannunciator will be
turned on in the display.) Press Local to halt remote mode and return to listen mode.

< Make certain that the signal generator is not in a local lockout condition.

= Check for a progress bar on the signal generator display which indicates that an
operation is in progress.

< Try an instrument preset.
e Try cycling power.

If none of the previous suggestions resolves the problem, you can try the fail-safe recovery
sequence. This sequence should only be used as a last resort as it will reset the signal
generator but the process will destroy all user files (instrument state, sequence files, data
files), calibration data (unsaved 1/Q calibrations, DCFM/DC®M calibrations), and the
persistent state. Do not attempt to perform any other front panel or remote operations
during the fail-safe sequence.

To run the fail-safe sequence, hold down the Preset key while cycling power. Continue to
hold down the Preset key until the ESG fail-safe recovery sequence message is displayed.

CAUTION Carefully read the entire message! It may list additional risks with the
procedure beyond what is documented here.

Release the Preset key and press Yes to continue with the sequence (or No to abort with no
lost files).

At the conclusion of the sequence, perform the following steps:

1. Cycle power once again. Cycling power restores all previously installed options. You
should expect to see several error messages resulting from calibration files being
restored from EEPROM.

2. Perform the DCFM/DC®M calibration. (Refer to the DCFM/DC®M Cal softkey description
in Chapter 4, “Hardkey and Softkey Reference,” in this manual.)

3. For ESG-D and ESG-DP series signal generators only, perform the 1/Q calibration.
(Refer to the I/Q calibration softkey description in Chapter 4, “Hardkey and Softkey
Reference,” of this manual.)

4. Agilent Technologies is interested in the circumstances that caused you to have to
initiate this procedure. Please contact us at 1-800-452-4844. We'd like to help you
eliminate any repeat occurrences.
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Returning a Signal Generator to Agilent Technologies

If you are returning your signal generator to Agilent Technologies for servicing, please ship
the instrument in the original factory packaging materials. If they are not available, use
similar packaging to properly protect the instrument.

Include as much information as possible about the problem: record any error messages
that appeared on the display, and include performance test results or any other specific
data on the performance of the signal generator.

Return the instrument to the nearest Agilent Technologies sales or service office. A list of
sales and service offices follows on the next page.
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Agilent Technologies Sales and Service Offices
Table 2-1 Contacting Agilent

Online assistance: www. agi | ent. coni fi nd/ assi st

United States
(tel) 1 800 452 4844

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

Canada
(tel) 1877 894 4414
(fax) (905) 282 6495

Europe
(tel) (+31) 20 547 2323
(fax) (+31) 20 547 2390

New Zealand
(tel) 0 800 738 378
(fax) (+64) 4 495 8950

Japan
(tel) (+81) 426 56 7832
(fax) (+81) 426 56 7840

Australia
(tel) 1 800 629 485
(fax) (+61) 3 9210 5947

Singapore
(tel) 1 800 375 8100
(fax0 (65) 836 0252

Malaysia
(tel) 1-800 828 848
(fax) 1 800 801 664

Philippines

(tel) (632) 8426802

(tel) (PLDT subscriber only):
180016510170

(fax) (632) 8426809

(fax) (PLDT subscriber only):

1800 16510288

Thailand

(tel) outside Bangkok:
(088) 226 008

(tel) within Bangkok:
(662) 661 3999

(fax) (66) 1 661 3714

Hong Kong
(tel) 800 930 871
(fax) (852) 2506 9233

Taiwan
(tel) 0800-047-866
(fax) (886) 2 25456723

People’s Republic of
China

(tel) (preferred):
800-810-0189

(tel) (alternate):
10800-650-0021

(fax) 10800-650-0121

India
(tel) 1-600-11-2929
(fax) 000-800-650-1101
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3 Front and Rear Panel

This chapter contains descriptions of the keys and connectors and other hardware on the
front and rear panels. It also describes which information is displayed in the various parts
of the display.
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ESG Family Signal Generators

Front Panel Overview
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1. EXT 1 INPUT Connector

This female BNC input connector accepts a 1-Vy signal for FM, ®M, and AM. For all these
modulations, +1 V. produces the indicated deviation or depth. When AC-coupled inputs
are selected for FM, ®M, or AM, HI/LO annunciators will light if the peak input voltage
differs from 1.0 V by more than 3%. The input impedance is 50Q. The damage levels are

5 Vims and 10 V. If you configure your signal generator with Option 1EM, this input is
relocated to a rear panel, female BNC connector.

2. EXT 2 INPUT Connector

This female BNC input connector accepts a 1-V, signal for FM, ®M, AM, and pulse
modulation. With FM, ®M, or AM, *1 Vpk produces the indicated deviation or depth. With
pulse modulation, +1 V is on and 0 V is off. When AC-coupled inputs are selected for FM,
OM, or AM, HI/LO annunciators will light if the peak input voltage differs from 1.0 V by
more than 3%. The input impedance is 50Q The damage levels are 5 Vs and 10 V. If
you configure your signal generator with Option 1EM, this input is relocated to a rear
panel, female BNC connector.

3. Help Key

Press this hardkey for a short textual description of the function of the front panel
hardkeys and softkeys. Press this key again and you will be returned to normal instrument
operation.

4. Trigger Key

Press this hardkey to begin an event (such as a step or list sweep). This key must first be
selected as the method for activating an event by pressing the Trigger Key softkey, located in
the softkey menus associated with the event.

5. LF OUTPUT Connector

This female BNC connector is the output connector for modulation signals generated by
the LF (low frequency) source function generator. You can also output signals where the
frequency and shape are set by the internal source as it is being used by a modulation. For
pulse modulation, however, the internal source is a sinewave that is later squared by the
modulator to generate the pulse squarewave.

This output is capable of driving 3.5 V,c into a 50Q load. If you configure your signal
generator with Option 1EM, this input is relocated to a rear panel, female BNC connector.

6. Mod On/Off Key

This hardkey toggles all modulation signals on and off. Although you can set up and enable
various modulation states, the RF carrier is not modulated until Mod On/Off is set to On. An
annunciator is always turned on in the display to indicate whether modulation is turned
on or off.
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7. RF OUTPUT Connector

This female Type-N connector is the output connector for RF signals. The source
impedance is 50Q. The damage levels are 50 Vdc, 50 W at < 2 GHz, and 25 W at > 2 GHz
maximum. The reverse power protection circuit will trip, however, at nominally 1 watt. If
you configure your signal generator with Option 1EM, this output is relocated to a rear
panel, female Type-N connector.

8. RF On/Off Key

This hardkey toggles the RF signal on and off at the RF OUTPUT connector. An
annunciator is always turned on in the display to indicate whether RF is turned on or off.

9. Numeric Keypad

The numeric keypad consists of the digit keys (0 through 9), a decimal point key, and a
backspace key, [+-«=]. The backspace key has dual functions for both backspacing and for
changing the sign of a value between positive and negative. Use these keys whenever the
active function requires a value input.

10. Arrow Keys

The up and down arrow keys increase or decrease a numeric value. You can also use these
keys to scroll through displayed lists to select items. The left and right arrow keys choose
the highlighted digit in the active function display; that digit can be modified by the up
and down arrow keys or the knob. You can also use these keys in a list to select items in a
row.

11. Return Key

The Return key cancels the current active function and moves you from your current softkey
menu to the softkey menu that precedes it. It will back up through the menus of the
current hardkey until you reach the first menu of that key.

12. Display Contrast Decrease Key

Press this key and hold it down to cause the display background to darken in comparison
to the text on the display.

13. Display Contrast Increase Key

Press this key and hold it down to cause the display background to brighten in comparison
to the text on the display.

14. Local Key

Press this key to return the signal generator to local (front panel) control from remote
operation.

15. Preset Key

Press this key to set the signal generator to a known state (either the factory-defined state
or a user-defined state).
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16. Standby LED

This yellow LED lights when the instrument is in standby condition. In standby, the power
switch is off but the instrument is still connected to the main power circuit by way of the
power cord.

17. Line Power LED
This green LED lights when power is cycled on to the signal generator.

18. Power Switch

Press this hardkey to turn power to the signal generator either on (green LED on) or to
standby (yellow LED on).

19. Q INPUT Connector

This connector accepts an externally supplied, analog, quadrature-phase component of 1/Q
modulation. The signal level is [z 2 = 0.5 Vs for a calibrated output level. The input
impedance is 50Q The damage level is 1 V. This female BNC connector is provided only
on ESG-D and ESG-DP Series Signal Generators. If you configure your instrument with
Option 1EM, this input is relocated to a rear panel, female BNC connector.

20. 1 INPUT Connector

This connector accepts an externally supplied, analog, in-phase component of 1/Q
modulation. The signal level is [z 2 = 0.5 Vs for a calibrated output level. The input
impedance is 50Q The damage level is 1 V. This female BNC connector is provided only
on ESG-D and ESG-DP Series Signal Generators. If you configure your instrument with
Option 1EM, this input is relocated to a rear panel, female BNC connector.

21. Display

The LCD display provides information on the current instrument state such as modulation
status, frequency and amplitude settings, status indicators, and error messages. Softkey
labels corresponding to their adjacent keys are located on the right-hand side of the
display. For details about the display, see “Display Annotation” on page 3-8.

22. Hold Key

Press this hardkey to deactivate the currently active function and blank the softkey menu.
Once Hold is pressed, the front panel knob, the arrow keys, and the numeric keypad have
no effect. To return to normal operation, press a function or menu hardkey.

23. Softkeys

Press a softkey to activate the function indicated by the corresponding label on the display.

24. Knob

The knob increases or decreases a numeric value. Any of the values that can be set through
the numeric keypad or the step keys can also be set by the knob.
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25. Amplitude Key

Press this hardkey to activate the power level amplitude function so that you can change
the amplitude of the RF output.

26. Frequency Key

Press this hardkey to activate the frequency function so that you can change the frequency
of the RF output.

27. Save Key

This hardkey lets you save up to 100 different instrument states in a combination of 100
memory registers and 10 register sequences. The number of states you can save, however,
is limited by the size of whatever else is stored in the file system.

28. Menu Keys

These hardkeys provide access to the signal generator’s primary functionality. Press these
keys for access to softkey menus where you can configure modulations, step and list
sweeps, and various frequency and power capabilities.

29. Incr Set Key

Press this hardkey to toggle between the current active function and the increment size for
that function. With increment size selected, you can change the current increment value.

30. Recall Key

This hardkey lets you restore any instrument state that you previously saved in a memory
register. You can save up to 100 different instrument states in a combination of 100
memory registers and 10 register sequences. The number of states you can save, however,
is limited by the size of whatever else is stored in the file system.

31. DATA Input Connector

The TTL/CMOS compatible DATA connector accepts an externally supplied data input for
digital modulation applications. The expected input is a TTL or CMOS signal where a
CMOS high is equivalent to a data 1 and a CMOS low is equivalent to a data 0.

The maximum input data rate is 50 Mb/s if the user supplies the data. If the signal
generator is supplying any of the data, the maximum rate is 5 Mb/s. The leading edges
must be synchronous with the DATA CLOCK rising edges. The data must be valid on the
DATA CLOCK falling edges. The damage levels are > +8 and < —4V.

This female BNC connector is provided on instruments with Option UNS. It is also present
but not functional on instruments with Option UND. On instruments with Option 1EM,
this input is relocated to a rear panel SMB connector.
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32. DATA CLOCK Input Connector

The TTL/CMOS compatible DATA CLOCK connector accepts an externally supplied
data-clock input for digital modulation applications. The expected inputisa TTL or CMOS
signal (either bit or symbol) where the rising edge is aligned with the beginning data bit.
The CMOS falling edge is used to clock the DATA and SYMBOL SYNC signals.

The maximum clock rate is 50 MHZz if the user supplies the data. If the signal generator is
supplying any of the data, the maximum rate is 5 MHz. The damage levels are > +8 and
< -4V.

This female BNC connector is provided on instruments with Option UNS8. It is also present
but not functional on instruments with Option UND. On instruments with Option 1EM,
this input is relocated to a rear panel SMB connector.

33. SYMBOL SYNC Input Connector

The CMOS compatible SYMBOL SYNC connector accepts the digital-modulation symbol
synchronization signal from an external source. This signal synchronizes the serial
multi-bit symbol transmission. The expected signal may be continuous or a single, one-bit
wide pulse to synchronize the first bit of the first symbol. The CMOS rising edge must be
synchronous with the DATA CLOCK rising edges. The synchronization signal must be
valid on the DATA CLOCK falling edges. The damage levels are > +8 and < —4V.

This female BNC connector is provided on instruments with Option UNS8. It is also present
but not functional on instruments with Option UND. On instruments with Option 1EM,
this input is relocated to a rear panel SMB connector.

34. PULSE IN Connector

This connector accepts an externally supplied TTL-compatible pulse signal. The pulse
signal is activated with the Fast Pulse Off On softkey or via SCPI command. The maximum
input for this connector is £15 volts. This female BNC connector is provided only on
instruments with Option 1ES6.
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4. Error Message Area

1. Frequency Area

The current CW frequency setting is shown in this portion of the display. Indicators are
also displayed in this area when a frequency offset or multiplier is set or if frequency
reference mode is turned on.

2. Amplitude Area

The current output power level setting is shown in this portion of the display. Indicators
are also displayed in this area when an amplitude offset is set or if amplitude reference
mode is turned on.

3. Softkey Labels

These labels define the function of the corresponding softkeys immediately to the right of
the label.

4. Error Message Area

Abbreviated error messages are reported in this space. When multiple error messages
occur, only the most recent message remains displayed. All of the reported error messages
with details can be viewed by pressing Utility > Error Info > View Next Error Message.
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5. Text Area

This area is used to display status information about the signal generator such as the
modulation status, to enter information such as creating sweep lists, and to manage
information such as displaying the catalog of files and deleting unwanted files.

6. Active Entry Area

The current active function is shown in this area. For example, if frequency is the active
function, the current setting will be displayed in the active entry area and that setting will
change as you enter a new value. If the active function has an increment value associated
with it, that value is displayed here also.

7. Annunciators

The display annunciators described in the following list show the status of some of the
signal generator functions, and indicate any error conditions. An annunciator position may
be used by more than one annunciator, as with the digital modulation annunciators. This
does not cause a problem, because only one of the functions, that shares a location can be
active at a time.

>M This annunciator appears when phase modulation is turned on. A second
annunciator, FM will appear in the same position if frequency modulation
is turned on. Frequency modulation and phase modulation cannot be
turned on at the same time, so the two annunciators will never conflict.

ALC OFF This annunciator appears when the automatic leveling control (ALC)
circuit is disabled. A second annunciator, UNLEVEL, will appear in the same
position if the signal generator’'s automatic level control is unable to
maintain the output level. When the ALC is disabled, the unleveled
annunciator has no meaning, so these annunciators will never conflict.

AM This annunciator appears when amplitude modulation is turned on.

ARVED This annunciator appears when a sweep has been initiated and the signal
generator is waiting for the sweep trigger event.

ATTEN HOLD  This annunciator appears when the attenuator hold function is turned on.
When this function is on, the attenuator is frozen at its current setting.

BERT This annunciator appears whenever the Option UN7, bit error rate test
(BERT), or Option 300, base station BERT extension, functions are turned
on.

Digital Modulation

Annunciators All digital modulation annunciators appear in the same position, but there
is no conflict because only one of these functions can be active at any given
time.

ENVLP This annunciator appears if the burst envelope modulation is turned on.
This annunciator is present only on ESG-D and ESG-DP Series Signal
Generators.
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ERR

EXT1 LO HI

EXT2 LOH

EXT REF

FM

1/Q

MOD OFF

OVEN COLD

PULSE

RF OFF

SWEEP

ESG Family Signal Generators

This annunciator appears when an error message is placed in the error
gueue. This annunciator will not turn off until you have either viewed all
of the error messages or cleared the error queue. You can view and delete
error messages using the Utility menu.

This annunciator toggles between EXT1 LOand EXT1 HI . This annunciator
appears if the AC-coupled signal to the EXT 1 input is less than 0.97 V
or greater than 1.03 V.

This annunciator toggles between EXT2 LOand EXT2 HI . This annunciator
appears if the AC-coupled signal to the EXT 2 input is less than 0.97 V,,,
or greater than 1.03 V.

This annunciator appears when an external 1, 2, 5, or 10 MHz frequency
reference is in use.

This annunciator appears when frequency modulation is turned on. A
second annunciator, ®M will appear in the same position if phase
modulation is turned on. Frequency modulation and phase modulation
cannot be turned on at the same time, so the two annunciators will never
conflict.

This annunciator appears when I/Q modulation is turned on. This
annunciator is present only on ESG-D and ESG-DP Series Signal
Generators.

The L annunciator appears when the signal generator is in the listen mode
and receiving information or commands over the GPIB or RS-232.

This annunciator toggles between MOD OFF and MOD ON and is always
visible in the display. This annunciator indicates whether the modulations
that you have enabled are modulating the RF carrier.

This annunciator appears when the temperature of the internal ovenized
reference oscillator (ESG-AP, ESG-DP, and Option 1E5) has dropped below
an acceptable level. When this annunciator is on, frequency accuracy is
degraded. This condition should occur only if the signal generator is
disconnected from line power. The annunciator is timed, and automatically
turns off after a specified period.

This annunciator appears when pulse modulation is turned on.

The Rannunciator appears when the signal generator is in remote GPIB
operation.

This annunciator toggles between RF OFF and RF ON and is always visible
in the display. This annunciator indicates whether the RF signal is present
at the RF OUTPUT connector.

The S annunciator appears when the signal generator has generated a
service request (SRQ) over the GPIB.

This annunciator appears when the signal generator is sweeping in list or
step mode.
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UNLEVEL

UNLOCK

Display Annotation

The T annunciator appears when the signal generator is in the talk mode
and is transmitting information over the GPIB or RS-232.

This annunciator appears when the signal generator is unable to maintain
the correct output level. The UNLEVEL annunciator is not necessarily an
indication of instrument failure. Unleveled conditions can occur during
normal operation, for example if I/Q modulation is turned on and no 1/Q
signals are connected. A second annunciator, ALC OFF, will appear in the
same position when the automatic leveling control circuit is disabled.
When the ALC is disabled, the UNLEVEL annunciator has no meaning, so
these annunciators will never conflict.

This annunciator appears when any of the signal generator’s phase locked
loops are unable to maintain phase lock. You can determine which loop is
unlocked by interrogating the error messages.
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ESG Family Signal Generators

Rear Panel Overview
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1. AC Power Receptacle

The power cord receptacle accepts a three-pronged cable that is shipped with the
instrument. The line voltage is connected here.

2. GPIB Connector

The GPIB connector allows communications with compatible devices such as external
controllers. It is functionally equivalent to the AUXILIARY INTERFACE connector.

3. SYMBOL SYNC OUT Connector

The TTL/CMOS compatible SYMBOL SYNC OUT connector outputs a symbol
synchronization pulse, one data clock period wide, for use in digital modulation
applications. The pulse output is synchronized with the first symbol in the internal pattern
generator sequence. The damage levels are > +8 and < -4 V. This female BNC connector is
provided only on instruments with Option UND or UNS8. If you configure your instrument
with Option 1EM, this output is changed from a BNC to an SMB connector. With

Option 201 you can select from several different output signals for this connector.

4. AUXILIARY INTERFACE Connector

This male DB-9 connector is an RS-232 serial port that can be used for controlling the
signal generator remotely. It is functionally equivalent to the GPIB connector. The
following table shows the description of the pinouts.

Pin Number Signal Description Signal Name
1 No Connection
2 Receive Data RECV
3 Transmit Data XMIT
4 +5V
5 Ground, 0 V
6 No Connection
7 Request to Send RTS
8 Clear to Send CTS
9

No Connection

S5e¢ 40 30 2¢ 1e

9¢ 8e 78 6e

View looking into
rear panel connector

pk763a
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5. DATA CLK OUT Connector

The DATA CLK OUT connector outputs a clock signal for digital modulation data. The
output signal level is TTL or CMOS with the rising edge aligned with the beginning of the
data bit and the falling edge occurring when the data and symbol synchronization signal
are valid. The damage levels are > +8 and < -4 V. This female BNC connector is provided
only on instruments with Option UND or UNS8. If you configure your instrument with
Option 1EM, this output is changed from a BNC to an SMB connector. With Option 201
you can select from several different output signals for this connector.

6. SWEEP OUT Connector

This female BNC connector provides a voltage range of 0 to +10 V. When the signal
generator is sweeping, the SWEEP OUT signal ranges from 0 V at the beginning of the
sweep to +10 V at the end of the sweep regardless of the sweep width. In CW mode this
connector has no output. The output impedance is less than 1Q and can drive 2 kQ.

7. DATA OUT Connector

The DATA OUT connector outputs digital modulation data sourced from an externally
supplied signal at the DATA input or from the internal pattern generator. The output
signal level is a TTL or CMOS signal where a CMOS high is equivalent to a data 1 and a
CMOS low is equivalent to a data 0. This female BNC connector is provided only on
instruments with Option UND or UNB8. If you configure your instrument with Option
1EM, this output is changed from a BNC to an SMB connector. With Option 201 you can
select from several different output signals for this connector.

8. TRIGGER OUT Connector

This female BNC connector outputs a TTL signal that is asserted high at the start of a
dwell sequence, or at the start of waiting for the point trigger in manual sweep mode, and
low when the dwell is over, or when the point trigger is received, or once per sweep during
an LF sweep. The logic polarity can be reversed.

9. TRIGGER IN Connector

This female BNC connector accepts a TTL signal for triggering operations, such as
point-to-point in manual sweep mode or an LF sweep in external sweep mode. Triggering
can occur on either the positive or negative edge. The damage level is=2+10V or< -4 V.

10. 10 MHz IN Connector

This female BNC connector accepts a —3.5 to +20 dBm signal from an external timebase
reference that is within £10 ppm (standard timebase) or £1 ppm (high stability timebase).
The nominal input impedance is 50Q. The signal generator detects when a valid reference
signal is present at this connector and automatically switches from internal to external
reference operation.

11. 10 MHz OUT Connector

This female BNC connector provides a nominal signal level of +7 dBm +2 dB, and an
output impedance of 50Q. The accuracy is determined by the timebase used.
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12. PATTERN TRIG IN Connector

This input can accept either a TTL/CMOS low to TTL/CMOS high or TTL/CMOS high to
TTL/CMOS low edge trigger. The minimum trigger input pulse width, high or low, is
100 ns. The damage levels are > +8 and < -4 V. This female BNC connector is provided
only on instruments with Option UN8 or UND. If you configure your instrument with
Option 1EM, this input is changed from a BNC to an SMB connector.

With Option UNS8 turned on, the input to the PATTERN TRIG IN connector is used to
trigger the internal digital modulation pattern generator to start a single pattern output or
to stop and re-synchronize a pattern that is being continuously output. The trigger edge is
latched and then sampled by the falling edge of the internal data bit clock to synchronize
the trigger with the data bit clock timing. The minimum delay from the trigger edge to the
first bit of the frame is 1.5 to 2.5 bit clock periods. For more information on pattern
triggering, refer to the “Operation” chapters in the user’s and programming guides.

With Option UND turned on, this connector is the source for the external trigger for all of
the ARB waveform generator triggers. With Option 201 this connector is used for system
reset trigger input.

13. BURST GATE IN Connector

The BURST GATE IN connector accepts a TTL or CMOS signal for gating burst power in
digital modulation applications. The burst gating is used when you are externally
supplying data and clock information. The input signal must be synchronized with the
external data input that will be output during the burst. The burst power envelope and
modulated data are internally delayed and re-synchronized. The input signal must be
CMOS high for normal burst RF power or CW RF output power and CMOS low for RF off.
The leading edges must be synchronous with the DATA CLOCK rising edges. The signal
level must be valid on the DATA CLOCK falling edge. The damage levels are > +8 and

< -4 V. This female BNC connector is provided only on instruments with Option UND or
UNS. If you configure your instrument with Option 1EM, this output is changed from a
BNC to an SMB connector. With Option 201 this connector is used for even second
synchronization input.

14. COHERENT CARRIER OUT Connector

This connector outputs RF that is not modulated with AM, pulse, or I/Q modulation, but is
modulated with FM or ®M. The output power is nominally 0 dBm %5 dB. The output
frequency range is from 249.99900001 MHz to the maximum specified frequency of your
signal generator. If the RF output frequency is below this range, the COHERENT
CARRIER OUT signal will have the following frequency: Frequency of coherent

carrier = (1E9 - Frequency of RF output) in Hz. The damage levels are 20 Vdc and 13 dBm
reverse RF power. This SMA connector is present only on ESG-D and ESG-DP Series
Signal Generators.

15. ALT PWR IN Connector

This BNC connector accepts a CMOS signal for synchronization of external data and
alternate power signal timing. Damage levels are > +8 V and < —4 V. This connector is
active only with Options UNA or 201. With Option 201 this connector is used for Long
Code State Latch strobe input.
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16. EVENT 1 Connector

With Option UNS8 turned on, this TTL/CMOS compatible connector outputs a pulse that
can be used to trigger the start of a data pattern, frame, or timeslot. It is adjustable to
within plus or minus one timeslot with one bit of resolution. With Option UN5 turned on
(Option UNS5 requires Option UND hardware), an even second output is generated. A
marker is output every two seconds indicating the beginning of each short code sequence
for use in synchronizing CDMA analysis instruments.

With Option UND turned on, there is a marker on/off condition associated with each
waveform point. A marker (TTL high when positive polarity is selected; TTL low when
negative polarity is selected) is output on the EVENT 1 connector whenever a Marker 1 is
turned on in the waveform. (Markers are automatically turned on whenever you set them
in a waveform segment. When you combine waveform segments that contain Marker 1 into
a sequence, the markers are automatically turned off until you toggle them on in either the
Edit Selected Waveform Sequence menu or in the Build New Waveform Sequence menu.)

The damage levels for this connector are > +8 V and < —4V. This female BNC connector is
provided only on instruments with Option UN8 or UND. If you configure your instrument
with Option 1EM, this output is changed from a BNC to an SMB connector. With
Option 201 you can select from several different output signals for this connector.

17. EVENT 2 Connector

With Option UN8 turned on, this TTL/CMOS compatible connector outputs a data enable
signal for gating external equipment. The output is applicable when the external data is
clocked into internally generated timeslots. Data is enabled when the signal is low. With
Option UNS5 turned on (Option UN5 requires Option UND hardware), a marker is output
on the EVENT 2 connector every 26.67 milliseconds, corresponding to the start of each
short code.

With Option UND turned on, there is a marker on/off condition associated with each
waveform point. A marker (TTL high when positive polarity is selected; TTL low when
negative polarity is selected) is output on the EVENT 2 connector whenever a Marker 2 is
turned on in the waveform. (Markers are automatically turned on whenever you set them
in a waveform segment. When you combine waveform segments that contain Marker 2 into
a sequence, the markers are automatically turned off until you toggle them on in either the
Edit Selected Waveform Sequence menu or in the Build New Waveform Sequence menu.)

The damage levels are > +8V and < —4V. This female BNC connector is provided only on
instruments with Option UN8 or UND. On instruments with Option 1EM, this output is
changed from a BNC to an SMB connector. With Option 201 this connector is used for
system reset output.
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18. BASEBAND GEN REF IN Connector

With Option UNS8 enabled, the BASEBAND GEN REF IN connector accepts a 0 to

+20 dBm sinewave or TTL squarewave signal from an external 13 MHz timebase
reference. This digital modulation reference clock is used by the internal pattern generator
in GSM applications (only the internal digital data generator can be locked to this external
reference; the RF frequency remains locked to the 10 MHz reference). The nominal input
impedance is 50Q at 13 MHz, AC-coupled.

With Option UND enabled, this connector accepts a TTL or > -10 dBm sinewave external
reference at rates from 250 kHz through 20 MHz. The internal clock for the arbitrary

waveform generator is locked to this signal when external reference is selected in the ARB
setup. The minimum pulse width must be > 10 ns. The damage levels are > +8V and < —-8V.

This female BNC connector is provided only on instruments with Options UND or UNS.
On instruments with Option 1EM, this output is changed from a BNC to an SMB
connector.

19. | OUT Connector

The 1 OUT connector outputs the analog, in-phase component of 1/Q modulation from the
internal baseband generator. The nominal output impedance of this connector is 50Q,
DC-coupled. The damage levels are > +2 VV and < -2 V. The DC origin offset is typically

< 10 mV. The output signal levels into a 50Q load are as follows:

= 0.5V, typical, corresponds to one unit length of the 1/Q vector.

= 0.69 Vp (2.84 dB), typical, maximum crest factor for peaks for 4 DQPSK with
alpha = 0.5.

= 0.71 Vy (3.08 dB), typical, maximum crest factor for peaks for 174 DQPSK with
alpha = 0.35.

= Typically 1V, , maximum (Option UND only).

This female BNC connector is provided only on instruments with Option UND or UNS8. If
you configure your instrument with Option 1EM, this output is relocated from a BNC to an
SMB connector.
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20. Q OUT Connector

The Q OUT connector outputs the analog, quadrature-phase component of 1/Q modulation
from the internal baseband generator. The nominal output impedance of this connector is
50Q, DC-coupled. The damage levels are > +2 V and < -2 V. The DC origin offset is
typically < 10 mV. The output signal levels into a 50Q load are as follows:

= 0.5V, typical, corresponds to one unit length of the 1/Q vector.

= 0.69 Vy (2.84 dB), typical, maximum crest factor for peaks for W4 DQPSK with
alpha = 0.5.

= 0.71 Vi (3.08 dB), typical, maximum crest factor for peaks for 4 DQPSK with
alpha = 0.35.

= Typically 1V, , maximum (Option UND only).

This female BNC connector is provided only on instruments with Option UND or UNS8. If
you configure your instrument with Option 1EM, this output is relocated from a BNC to an
SMB connector.

21. BER MEAS END Connector

The BER MEAS END connector outputs a signal that indicates the status of the
bit-error-rate (BER) measurements. BER measurements are being executed when the
signal is high. The damage levels are > +8 and < -4 V. This female SMB connector is
provided only on instruments with Option UN7.

22. BER TEST OUT Connector

The BER TEST OUT connector outputs a signal that indicates the test result of the
pass/fail judgement of the bit-error-rate measurements. The result is guaranteed at the
falling edge of the signal of the MEAS END connector. The result is pass when the signal is
low; the result is fail when the signal is high. The signal is also high when the pass/fail
judgement is set to off. The damage levels are > +8 and < -4 V. This female SMB connector
is provided only on instruments with Option UN?7.

23. BER ERR OUT Connector

The output of the BER ERR OUT connector is normally low. When the maximum data rate
mode is set to 2 Mbps, the BER ERR OUT connector outputs pulse signals that indicate
errors. One pulse with a width of about 80 ns indicates one error bit. Pulses indicating
errors are asynchronous to the BER CLK IN and are only valid during BER measurements
(when BER MEAS END is high). The damage levels are > +8 and < -4 V. This female SMB
connector is provided only on instruments with Option UN?7.

24. BER NO DATA Connector

The BER NO DATA connector outputs a signal that indicates the no data status. The no
data status is reported when there has been no clock input for more than 3 seconds or
there has been no data change for more than 200 bits. This signal is valid only when the
signal of the BER MEAS END connector is high. No data status is detected when the
signal is low. The damage levels are > +8 and < -4 V. This female SMB connector is
provided only on instruments with Option UN7.

3-18 User’s Guide



ESG Family Signal Generators Front and Rear Panel
Rear Panel Overview

25. BER SYNC LOSS Connector

The BER SYNC LOSS connector outputs a signal that indicates the synchronization loss
state. This signal is only valid when the signal of the BER MEAS END connector is high.
Synchronization loss state is detected when the signal is low. The damage levels are > +8
and < -4 V. This female SMB connector is provided only on instruments with Option UN?7.

26. BER DATA IN Connector

Use this connector to input the data streams for the bit-error-rate measurements. The
rising (positive) or falling (negative) edge of the BER CLK IN signal (selected by the
softkey or the GPIB command) is used to trigger the reading of the data. The damage
levels are > +8 and < —4 V. This connector must be terminated with a TTL-compatible high
impedance or 75Q load. If you configure your instrument with Option 1EM, this input is
changed from a BNC to an SMB connector. This female BNC connector is provided only on
instruments with Option UN7.

27. BER CLK IN Connector

Use this connector to input the clock signal for the bit-error-rate measurements. The rising
(positive) or falling (negative) edge of the signal (selected either by softkey or GPIB
command) causes data on the BER DATA IN connector to be sampled. The damage levels
are > +8 and < -4 V. This connector must be terminated with a TTL-compatible high
impedance or 75Q load. If your instrument is configured with Option 1EM, this input
changes from a BNC to an SMB connector. This female BNC connector is provided only on
instruments with Option UN7.

28. BER GATE IN Connector

Use this connector to input the clock gate signal for the bit-error-rate measurements. The
clock signal to the BER CLK IN connector is valid only when the signal to this connector is
a high or low, depending on your softkey selection or GPIB command. The damage levels
are > +8 and < -4 V. This connector must be terminated with a TTL-compatible high
impedance or 75Q load. This connector can be enabled or disabled by a softkey or an GPIB
command. This female BNC connector is provided only on instruments with Option UN7.

29. 321.4 MHz IN Connector

Use this connector to input a downconverted 321.4 MHz GSM signal for base transceiver
station (BTS) loopback measurements. This female SMB connector is present only on
instruments with Option 300.
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4 Hardkey and Softkey Reference

This chapter describes each front panel hardkey and each softkey associated with the
hardkey as well as the default value for each key. The chapter is organized alphabetically
by front panel hardkey.
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AM

AM

AM Depth

Pressing the front panel AM key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

/S VMENUS I

Mode } AM Utility } Freq }

[Fv/ Sweep/ J Ampl J
oM List
fia [LF out

pk726a

This softkey sets the amplitude modulation depth, in percent, for the
AM Path 1 and AM Path 2 configurations. To change the value of the AM
depth, press the softkey once. The current value for AM depth is
displayed in the active entry area. To enter a new value, rotate the front
panel knob until the desired value is displayed, use the up and down
arrow keys, or enter the value using the numeric keypad and press the
% terminator softkey. The range of values allowed is 0.1 to 100%. The
minimum increment allowed is 0.1%. Notice that the new value of AM
depth applies only to whichever AM path configuration (AM Path 1 or
AM Path 2) you have currently selected.

Default Value: 0.1%
Softkey Location: AM > AM Depth

Or: AM > AM Waveform > Dual-Sine > AM Depth

AM Depth Couple Off On

This softkey toggles the AM depth coupling on and off. AM depth
coupling links the AM depth values of AM Path 1 and AM Path 2. When
the values are coupled, any change you make to one AM depth value is
applied to both AM depth values.

Default Value: Off

Softkey Location: AM > AM Depth Couple Off On
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AM Off On

AM

This softkey enables the amplitude modulation for whichever AM path
configuration you have selected, AM Path 1, AM Path 2, or AM Path WB, in the
case of a digitally equipped model. Notice, however, that although you can
enable amplitude modulation with this softkey, the RF carrier is
modulated by the enabled modulation only when you have also set Mod
on/Off to on. Whenever amplitude modulation is enabled, the AM
annunciator is turned on in the display.

There are two paths for AM modulation which can be simultaneously
enabled as long as they use different sources (Int, Extl, or Ext2). The
modulation signals from both paths are summed internally for
composite modulation.

Default Value:; Off

Softkey Location: AM > AM Off On

AM Path 12 WB

NOTE

For the ESG-A and ESG-AP series, this softkey is AM Path 1 2. Wideband
AM is not available on the ESG-A and ESG-AP series.

Use AM Path 1 and AM Path 2 to define two unique amplitude modulation
configurations. For example, select AM Path 1. (AM Path 1 is the default
after a normal preset. If AM Path 1 is not highlighted, press the AM

Path 1 2 WB softkey until the selection toggles to AM Path 1.) Configure the
modulation characteristics (such as depth, source, rate, and waveform)
using the remaining softkeys in the AM menu. Then enable AM by
setting AM Off On to On.

To configure a second amplitude modulation configuration, toggle to
AM Path 2. Define the modulation characteristics for this second
configuration and enable AM by setting AM Off On to On.

The RF carrier is available at the RF OUTPUT connector when you set
RF On/Off to On. Set Mod On/Off to On to modulate the RF carrier with the
modulations that you have enabled.

AM Path 1 and AM Path 2 are summed internally for composite modulation.
Either path can be switched to any one of the modulation sources: Int,
Extl, or Ext2. All modulation types can be simultaneously enabled,
except FM with ®M, AM with external burst source, and wideband AM
with 1/Q. AM, FM, and ®M can sum simultaneous inputs from any two
sources (Int, Extl, and Ext2). Any given source (Int, Extl, or Ext2) can
only be routed to one activated modulation type.
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AM

AM Rate

AM Source

The wideband AM selection (AM Path WB) eliminates the bandwidth
limitations of the ALC loop thereby increasing the bandwidth beyond
that of the standard amplitude modulation. Typical rates for wideband
AM are listed in the technical specifications document. When you select
AM Path WB in the AM menu, you must apply your modulating signal to
the | input. The sensitivity is 0.5 V = 100% AM depth. With AM Path WB
selected, the modulated RF signal will be available at the RF OUTPUT
connector when you turn on both Mod On/Off and RF On/Off.

Default Value: AM Path 1

Softkey Location: AM > AM Path 1 2 WB

Use this softkey to change the internal modulation frequency for the
AM Path 1 and AM Path 2 configurations. To change the value, press the
softkey once. The current value for AM rate is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 10 kHz. (0.1 Hz to

50 kHz is the range allowed if sinewave is selected as the internal
waveform.) The minimum increment allowed is 0.1 Hz. Notice that the
new value of AM rate applies only to whichever AM configuration

(AM Path 1 or AM Path 2) you have currently selected.

Default Value: 400 Hz

Softkey Location: AM > AM Rate

Pressing this softkey reveals a menu of choices for amplitude
modulation sources. You can choose internally-generated amplitude
modulation or select an externally-applied signal from either the EXT
1 INPUT or EXT 2 INPUT connectors. The internal modulation is
always AC-coupled. For the externally-applied signals, you can choose
between AC- and DC-coupled modulation. A 1.0 Vpk input is required
for calibrated AM depth settings. The EXT 1 LOH and EXT 2 LQ HI
display annunciators will turn on if the peak input voltage differs from
1.0 Vpk by more than 3%. (The LO/HI annunciators only function for
AC-coupled external inputs.)

The internal and external 1 and 2 sources have multiple uses. You can
use them for amplitude, frequency, and phase modulation. For burst
modulation, you can only use the external 1 source and you must use
the external 2 source for pulse modulation. However, any given source
can only be routed to one enabled modulation at a time. If, for example,
you were using the external 1 source in a frequency modulation
configuration for FM Path 1, and then you configured AM Path 2 to also use
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AM

the external 1 source, the signal generator would turn off FM Path 1 and
assign the external 1 source to your AM Path 2 configuration. Notice that
for these purposes the external 1 AC-coupled source is the same as the
external 1 DC-coupled source and the external 2 AC-coupled source is
the same as the external 2 DC-coupled source.

Default Value: Internal

Softkey Location: AM > AM Source

AM Start Rate

Use this softkey to change the starting internal modulation frequency
for swept-sine amplitude modulation. To change the value, press the
softkey once. The current value for the AM start rate is displayed in the
active entry area. To enter a new value, rotate the front panel knob
until the desired value is displayed, use the up and down arrow keys, or
enter the value using the numeric keypad and press the Hz or kHz
terminator softkey. The range of values allowed is 0.1 Hz to 50 kHz. The
minimum increment allowed is 0.1 Hz.

This softkey is coupled to the AM Rate softkey in the initial AM Menu
and the AM Tone 1 Rate softkey in the AM Dual-Sine Menu. Any value set
for AM Start Rate is reflected in the AM Rate and AM Tone 1 Rate softkeys.
Conversely, if you change the value for either the AM Rate softkey or the
AM Tone 1 Rate softkey, the value for AM Start Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: AM > AM Waveform > Swept-Sine > AM Start Rate

AM Stop Rate

Use this softkey to change the ending internal modulation frequency for
swept-sine amplitude modulation. To change the value, press the
softkey once. The current value for the AM stop rate is displayed in the
active entry area. To enter a new value, rotate the front panel knob
until the desired value is displayed, use the up and down arrow keys, or
enter the value using the numeric keypad and press the Hz or kHz
terminator softkey. The range of values allowed is 0.1 Hz to 50 kHz. The
minimum increment allowed is 0.1 Hz.

This softkey is coupled to the AM Tone 2 Rate softkey in the AM Dual-Sine
Menu. Any value set for AM Stop Rate is reflected in the AM Tone 2 Rate
softkey. Conversely, if you change the value for the AM Tone 2 Rate
softkey, the value for AM Stop Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: AM >AM Waveform > Swept-Sine > AM Stop Rate
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AM Sweep Time

Sets the sweep time for swept-sine amplitude modulation. The signal
generator will vary the AM rate from the specified start rate to the stop
rate in the time set with this softkey. Enter the desired sweep time
using the up and down arrow keys, the front panel knob, or enter a
value using the numeric keypad and press the sec or msec terminator
softkey. The range of values allowed is 1 ms through 65.535 s. The
minimum increment allowed is 1 ms.

Default Value: 100.0 msec

Softkey Location: AM > AM Waveform > Swept-Sine > AM Sweep Time

AM Sweep Trigger

Reveals a menu of choices for triggering swept-sine amplitude
modulation. You can choose triggering that occurs immediately,
triggering that is supplied by the GPIB, triggering on either the positive
or negative edge of a signal supplied to the TRIGGER IN connector, or
triggering by the front panel Trigger key.

Default Value: Immediate

Softkey Location: AM > AM Waveform > Swept-Sine > AM Sweep Trigger

AM Tone 1 Rate

Sets the internal modulation frequency for the AM tone 1. Enter the
desired rate using the up and down arrow keys, the front panel knob, or
enter a value using the numeric keypad and press the kHz or Hz
terminator softkey. The range of values allowed is 0.1 Hz through

50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the AM Rate softkey in the initial AM Menu
and the AM start Rate softkey in the AM Swept-Sine Menu. Any value set
for AM Tone 1 Rate is reflected in the AM Rate and AM Start Rate softkeys.
Conversely, if you change the value for either the AM Rate softkey or the
AM Start Rate softkey, the value for AM Tone 1 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: AM > AM Waveform > Dual-Sine > AM Tone 1 Rate
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AM Tone 2 Ampl Percent Of Peak

For example, if the Tone 2 amplitude is 0%, then there would be no
amplitude for Tone 2; all of the signal strength would be present in Tone
1. If AM Tone 2 Ampl Percent Of Peak is set to 50%, then Tone 2 and Tone 1
would have equal amplitudes, or half of the amplitude of both tones
combined.

Default Value: 50.0%

Softkey Location: AM > AM Waveform > Dual-Sine >
AM Tone 2 Ampl Percent Of Peak

AM Tone 2 Rate

Press this softkey to set the internal modulation frequency for the AM
tone 2. Enter the desired rate using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the kHz or Hz terminator softkey. The range of values allowed is 0.1 Hz
through 50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the AM Rate softkey in the initial AM Menu
and the AM Stop Rate softkey in the AM Swept-Sine Menu. Any value set
for AM Tone 2 Rate is reflected in the AM Rate and AM Stop Rate softkeys.
Conversely, if you change the value for either the AM Rate softkey or the
AM Stop Rate softkey, the value for AM Tone 2 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: AM > AM Waveform > Dual-Sine > AM Tone 2 Rate

AM Waveform

Bus

Pressing this softkey reveals a menu of AM waveform choices for your
AM Path 1 and AM Path 2 configurations. Select from sine, triangle, square,
ramp, noise, dual-sine, and swept-sine waveforms. Notice that your
waveform selection applies only to whichever AM path configuration
you have currently selected.

Default Value: Sine

Softkey Location: AM > AM Waveform

This softkey is one of the choices in the AM Sweep Trigger menu. With
Bus selected, you use the GPIB to trigger single sweeps of swept-sine
amplitude modulation.

Softkey Location: AM > AM Waveform > Swept-Sine > AM Sweep Trigger > Bus
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Dual-Sine

Reveals a menu of choices for setting the dual-sine amplitude
modulation parameters. In this menu you can set the AM rates for two
separate tones. In addition, you can set the AM depth for AM Path 1 and
AM Path 2 and also set a ratio of the tone 2 AM depth to the tone 1 AM
depth.

Softkey Location: AM > AM Waveform > Dual-Sine

Ext

Being one of the choices in the AM Sweep Trigger menu, choosing Ext
allows you to trigger swept-sine amplitude modulation using the signal
applied to the TRIGGER IN rear panel connector. Set the polarity of the
trigger signal using the Trigger In Polarity Neg Pos softkey.

Softkey Location: AM > AM Waveform > Swept-Sine > AM Sweep Trigger > Ext

Ext 1 AC-Coupled

Inputs an external, AC-coupled, amplitude modulation signal to the
EXT 1 INPUT connector. The modulation signal is tested for voltage
and a display annunciator will report a high or low condition if the
voltage is > £3% of 1 Vpk.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in a frequency modulation configuration for FM Path 1, and then
you configured AM Path 2 to also use the external 1 input, the signal
generator would turn off FM Path 1 and assign the external 1 input to
your AM Path 2 configuration. (For the purpose of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
input.)

Softkey Location: AM > AM Source > Ext 1 AC-Coupled

Ext 1 DC-Coupled

Inputs an external, DC-coupled, amplitude modulation signal to the
EXT 1 INPUT connector.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in a frequency modulation configuration for FM Path 1, and then
you configured AM Path 2 to also use the external 1 input, the signal
generator would turn off FM Path 1 and assign the external 1 input to
your AM Path 2 configuration. (For the purpose of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
input.)

Softkey Location: AM > AM Source > Ext 1 DC-Coupled
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Ext 2 AC-Coupled

This softkey lets you input an external, AC-coupled, amplitude
modulation signal to the EXT 2 INPUT connector. The modulation
signal is tested for voltage and a display annunciator will report a high
or low condition if the voltage is > £3% of 1 Vpk.

The external 2 input has multiple uses, but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in a frequency modulation configuration for FM Path 1, and then
you configured AM Path 2 to also use the external 2 input, the signal
generator would turn off FM Path 1 and assign the external 2 input to
your AM Path 2 configuration. (For the purpose of this discussion, the
external 2 AC-coupled input is the same as the external 2 DC-coupled
input.)

Softkey Location: AM > AM Source > Ext 2 AC-Coupled

Ext 2 DC-Coupled

This softkey lets you input an external, DC-coupled, amplitude
modulation signal to the EXT 2 INPUT connector.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in a frequency modulation configuration for FM Path 1, and then
you configured AM Path 2 to also use the external 2 input, the signal
generator would turn off FM Path 1 and assign the external 2 input to
your AM Path 2 configuration. (For the purpose of this discussion, the
external 2 AC-coupled input is the same as the external 2 DC-coupled
input.)

Softkey Location: AM > AM Source > Ext 2 DC-Coupled

Immediate

This softkey is one of the choices in the AM Sweep Trigger menu.
Choosing Immediate immediately triggers swept-sine amplitude
modulation in a continuous mode. To stop the sweep, choose a different
trigger such as Ext, or set the waveform to something other than
Swept-Sine.

Softkey Location: AM >AM Waveform > Swept-Sine > AM Sweep Trigger >
Immediate
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Internal

Noise

Ramp

Sine

Square

This softkey lets you connect an internally-generated, calibrated signal
to the AM modulator. The default state of the internal waveform
generator is a 400 Hz sinewave with 0.1% depth.

The internal source has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the internal
source in a frequency modulation configuration for FM Path 1, and then
you configured AM Path 2 to also use the internal source, the signal
generator would turn off FM Path 1 and assign the internal source to your
AM Path 2 configuration.

Softkey Location: AM > AM Source > Internal

This softkey lets you specify noise as the amplitude modulation
waveform for the AM Path 1 and AM Path 2 configurations. Notice that the
selected waveform applies only to whichever AM path configuration you
have currently selected.

Softkey Location: AM > AM Waveform > Noise

This softkey lets you specify ramp as the amplitude modulation
waveform for the AM Path 1 and AM Path 2 configurations. Notice that the
selected waveform applies only to whichever AM path configuration you
have currently selected.

Softkey Location: AM > AM Waveform > Ramp

This softkey lets you specify sine as the amplitude modulation
waveform for the AM Path 1 and AM Path 2 configurations. Notice that the
selected waveform applies only to whichever AM path configuration you
have currently selected.

Softkey Location: AM > AM Waveform > Sine

This softkey lets you specify square as the amplitude modulation
waveform for the AM Path 1 and AM Path 2 configurations. Notice that the
selected waveform applies only to whichever AM path configuration you
have currently selected.

Softkey Location: AM > AM Waveform > Square
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Swept-Sine

Triangle

AM

Pressing this softkey reveals a menu of choices for setting the
swept-sine amplitude modulation parameters. In this menu you can set
the start and stop AM rate and the sweep time. You can set the signal
generator to a single, externally-triggered sweep on either a negative or
positive TTL level or you can choose continuous sweep, triggered
immediately. In this menu you can also select either a positive or
negative polarity for the TRIGGER OUT signal.

Softkey Location: AM > AM Waveform > Swept-Sine

This softkey lets you specify triangle as the amplitude modulation
waveform for the AM Path 1 and AM Path 2 configurations. Notice that the
selected waveform applies only to whichever AM path configuration you
have currently selected.

Softkey Location: AM > AM Waveform > Triangle

Trigger In Polarity Neg Pos

Press this softkey to toggle between a negative TTL level trigger (0 V)
and a positive TTL level trigger (+5 V) for externally triggering
swept-sine amplitude modulation.

This softkey is coupled to the Trigger In Polarity Neg Pos softkey for
swept-sine FM, ®M, and LF Out, and to the Ext Neg and Ext Pos sweep
trigger selections in the Sweep/List Menu. If you set the

Trigger In Polarity Neg Pos softkey in the AM Swept-Sine Menu to Neg, the
Trigger In Polarity Neg Pos softkey is also set to Neg for swept-sine FM, ®M,
and LF Out. In addition, if the step or list sweep is set to externally
trigger, the selection will automatically be set to Ext Neg. The same
softkeys will toggle to Pos or to Ext Pos if you select Pos in the Swept-Sine
AM Menu.

Conversely, if the Trigger In Slope Neg Pos softkey is toggled in the
swept-sine FM, ®M, or LF Out menus, it will cause the swept-sine AM
softkey to toggle also. This is also true for the Ext Neg and Ext Pos step or
list sweep trigger selections.

Default Value: Pos

Softkey Location: AM > AM Waveform > Swept-Sine >
Trigger In Polarity Neg Pos
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Trigger Key

This softkey is one of the choices in the AM Sweep Trigger menu. With
Trigger Key selected, when you press the Trigger front panel key you
immediately trigger a single sweep of swept-sine amplitude
modulation.

The Trigger key has autorepeat capability. Hold it down and you will
repeatedly trigger sweeps until you release the key.

Softkey Location: AM > AM Waveform > Swept-Sine > AM Sweep Trigger >
Trigger Key

Trigger Out Polarity Neg Pos

This softkey toggles the polarity of the TTL signal that is output at the
rear panel TRIGGER OUT connector. When Trigger Out Polarity Neg Pos is
set to Pos, the output signal is asserted high (+5 V) at the start of the
swept-sine amplitude modulation sweep and low (0 V) when the sweep
is concluded. Setting Trigger Out Polarity Neg Pos t0 Neg reverses the
polarity, where a highis 0 V and a low is +5 V.

This softkey is coupled to the Trigger Out Polarity Neg Pos softkey in the
swept-sine FM, ®M, and LF Out menus and the sweep/list menu. When
the polarity is toggled for this softkey in any one of these menus, it
affects all locations of the softkey.

Default Value: Pos

Softkey Location: AM > AM Waveform > Swept-Sine >
Trigger Out Polarity Neg Pos

4-12

User’s Guide



ESG Family Signal Generators

Ampl

Hardkey and Softkey Reference
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Pressing the front panel Ampl key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

/S VENUS I

[Mode

[AM

[Utility

[Freq

[FM/
oM

{Pulse

Sweep/
List

Ampl

I/Q

ALC BW Normal Narrow

Default Value: Normal

Softkey Location: Ampl > ALC BW Normal Narrow

Press this softkey to toggle between ALC normal and narrow
bandwidth modes. The bandwidth is automatically set to narrow when
external 1/Q modulation is turned on, and automatically set to normal
when I/Q modulation is turned off. Setting ALC BW Normal Narrow t0
Narrow limits the bandwidth to 100 Hz which can improve EVM. Narrow
bandwidth mode may, however, also slow the settling time for frequency
changes to as much as 40 ms. This softkey is inactive when internal 1/Q
modulation is turned on.
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ALC Off On

NOTE

This softkey toggles the automatic leveling control (ALC) circuit off and
on.

The ALC is normally on. The RF output power of the signal generator is
constantly monitored and controlled by the ALC circuit. Its purpose is
to hold output power at its desired level in spite of drift due to
temperature and time.

There are some modulation conditions which the ALC circuit cannot
handle properly which lead to output level errors. In these conditions,
better power level accuracy can be obtained by turning the ALC off and
using power search. (Refer to the Power Search Manual Auto softkey
documented in this section for more information about power search.)
ALC Off is useful with pulse modulation with a pulse width narrower
than 2 ps and with certain external 1/Q modulation.

Pulse modulation is accomplished using a modulator which precedes
the ALC detector. The ALC must, therefore, measure a pulsed signal,
and it is able to do this if the pulse width exceeds 2 ps. For narrower
pulses, set the ALC softkey to Off.

With external 1/Q modulation, the ALC loop acts to hold the signal
generator’s average output power constant, in spite of variations in the
1/Q input power (12 + Q4). Rapid variations of (1 + Q%) propagate to the
output, while slow variations are removed by the ALC loop, with a
high-pass corner of 1 kHz. If you do not want this high-pass filtering,
set the ALcC off On softkey to off. With ALC off, the I/Q modulation will be
DC-coupled. Using power search, power level accuracy is preserved if
JIZ+Q? =0.5 Vi

When ALC is off, the ALC OFF display annunciator will turn on.

An alternative to setting the ALC off is to set the ALC bandwidth to
narrow. See the ALC BW Normal Narrow softkey in the this section.

Default Value: On

Softkey Location: Ampl > ALC Off On

Alternate Amplitude (Option UNA Only)

Pressing this softkey reveals a menu used to configure the alternate
amplitude function. The menu includes softkeys for configuring the
alternate amplitude state (on or off), delta, triggering (internal,
external, or manual), and subsequently, manual triggering between the
main and alternate amplitudes. This softkey and its subfunctions are
only available with the Alternate Timeslot Power Level Control option.

Softkey Location: Ampl > Alternate Amplitude
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Alt Ampl Delta (Option UNA Only)

Press this softkey to set the delta value for the alternate amplitude
function. The actual alternate amplitude is equal to the delta value plus
the main RF output amplitude plus the amplitude offset value minus
the amplitude reference value.

Default Value: 0.00 dB

Softkey Location: Ampl > Alternate Amplitude > Alt Ampl Delta

Alt Ampl Off On (Option UNA Only)

Toggles the operating state of the alternate amplitude function between
off and on. The alternate amplitude mode must be turned on in order to
switch the RF output power between main and alternate amplitudes.

Default Value: Off

Softkey Location: Ampl > Alternate Amplitude > Alt Ampl Off On

Alt Ampl Trigger (Option UNA Only)

Reveals a menu of choices for the alternate amplitude trigger source.
These choices include Int (internal from the baseband generator), Ext
(external source provided at the rear panel TRIGGER IN connector),
and Manual (softkey-driven) triggering.

Internal triggering is mainly used during framed-data generation. Each
timeslot is allowed to output power with a user-selected main or
alternate amplitude. For instruments without baseband generators, the
Int softkey will be nonfunctional.

For instruments containing baseband generators, internal triggering is
automatically selected during framed data transmission with at least
one activated timeslot with alternate amplitude, or during non-framed
external data generation.

In cases regarding non-framed external data generation, an external
trigger to the ALT PWR IN rear panel connector is required. This
external trigger input is routed to the data generator for processing.

Default Value: Manual

Softkey Location: Ampl > Alternate Amplitude > Alt Ampl Trigger
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Ampl Offset

Ampl Ref Set

Sets a value for amplitude offset. An amplitude offset changes the value
shown in the amplitude area of the display but does not affect the
output power. For example, if the current output power is 0 dBm and
you enter an amplitude offset of -3 dBm, the output power will remain
at 0 dBm but the display will show an amplitude of -3 dBm. This
feature lets you simulates the power level at a test point beyond the RF
OUTPUT connector.

An amplitude offset can be entered at any time during normal
operation and also when you are operating in amplitude reference
mode. To enter an offset, press Ampl Offset and enter the desired offset
value using the up and down arrow keys, the front panel knob, or enter
a value using the numeric keypad and press the dB terminator softkey.
When a non-zero offset has been entered, the OFFSET indicator is turned
on in the amplitude area of the display.

Default Value: 0.00 dB

Softkey Location: Ampl > Ampl Offset

This softkey sets the current output power as an amplitude reference
value. It also causes the Ampl Ref Off On softkey to toggle to the On
position, turning on amplitude reference mode. All amplitude
parameters are then set as relative to the reference value.

Default Value: 0.0 dBm

Softkey Location: Ampl > Ampl Ref Set

Ampl Ref Off On

This softkey toggles the amplitude reference mode on and off. When
amplitude reference mode is turned on, the amplitude value displayed
is equal to the current hardware output power minus the reference
value set by the Ampl Ref Set softkey. (The Ampl Ref Set softkey sets the
reference value equal to the current output power. If you have not yet
set the reference value, the normal preset value for amplitude reference
is 0 dBm.) The REF indicator is turned on in the amplitude area of the
display. All amplitude parameters will now be set as relative to the
reference value.

Amplitude offsets can be used with amplitude reference mode. In this
situation, the display will show the amplitude calculated as the current
hardware output power minus the reference value plus the amplitude
offset.
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Amplitude reference mode only changes the display; it does not change
the RF output power. For example, if you set your RF output power to
—20 dBm, set your reference value, and then turn amplitude reference
mode on, your display shows your amplitude as 0 dB but your output
power remains at —20 dBm.

Default Value:; Off

Softkey Location: Ampl > Ampl Ref Off On

Atten Hold Off On

This softkey toggles the attenuator hold function on and off. Turn
attenuator hold on to freeze the attenuator at its current setting. The
ATTN HOLD display annunciator will turn on. Use this function at any
time you want to guarantee that there will be no power discontinuity
normally associated with the attenuator switching during power
adjustments. (When the attenuator is held, only a frequency change
will change the attenuator setting. There will be no attenuator
switching during power adjustments.) With attenuator hold on, the
maximum power adjustment range will vary. However, you will have at
least +4 dB and at least —13 dB range.

Default Value: Off

Softkey Location: Ampl > Atten Hold Off On

Do Power Search

Press this softkey to execute the power search routine one time. Power
search is an internal calibration routine used to achieve calibrated
output power when the ALC is off. You can execute a power search at
any time by pressing this softkey. If you are using external 1/Q
modulation, the power search routine assumes that the 1/Q input level
is |2+Q2 =05 Vrms-

Actual output amplitude will scale directly with 2, 2.

The ALC off On softkey must be set to oOff in order to execute the power
search routine.

Softkey Location: Ampl > ALC Off On > Do Power Search

Manual Trigger Main Delta (Option UNA Only)

Press this softkey to toggle the RF output power between main and
alternate (delta). When Main is highlighted, the main power is present
at the RF output and when Delta is highlighted, the alternate power is
present at the RF output.

Default Value: Main

Softkey Location: Ampl > Alternate Amplitude > Manual Trigger Main Delta
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Power Search

This softkey accesses a menu from which you can change power search
parameters.

Softkey Location: Ampl > ALC Off On > Power Search

Power Search Manual Auto

This softkey toggles between the auto and manual modes of power
search mode. Power search is an internal calibration routine used to
achieve calibrated output power when the ALC is off. When you set
Power Search Manual Auto t0 Auto, power search will execute automatically
with each change to the RF frequency or power, and also with each
change to the AM, burst, pulse, or I/Q modulation state. If you are using
external I/Q modulation, the power search routine assumes that the 1/Q

input level is (2, ;2 = 0.5 V.
Actual output amplitude will scale directly with 1%+ Q.

When you set Power Search Manual Auto to Manual, the power search
routine is not run until the Do Power Search softkey is pressed.

The ALcC off on softkey must be set to Off in order to engage either power
search mode.

Default Value: Manual

Softkey Location: Ampl > ALC Off On > Power Search Manual Auto

Power Search Reference Fixed Modulated

This softkey toggles between fixed and modulated modes of power
search. Power search is an internal calibration routine used to achieve
calibrated output power when the ALC is off. When you set

Power Search Reference Fixed Modulated to Fixed, power search uses a

0.5 Volt reference. When you set Power Search Reference Fixed Modulated to
Modulated, the current 1/Q modulation remains active and the reference
is the RMS value of the current 1/Q modulation.

The ALc off on softkey must be set to Off in order to engage either power
search reference.

Default Value: Fixed

Softkey Location: Ampl > ALC Off On > Power Search >
Power Search Reference Fixed Modulated.
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Amplitude

Amplitude

Amplitude

‘ Frequency Mode J AM } Utility } Freq }

Pulse Sweep/ Ampl
List

Amplitude

Press this front panel hardkey to change the RF output power.
Amplitude becomes the active function and the current value is shown
in the active entry area of the display. To enter a new value for
amplitude, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the dBm, dBuV, dBuVemf, mV, uV, mVemf, Or
uVemf terminator softkey. The output power range allowed depends on
your instrument model. Refer to the technical specifications document.

pk746a

The current RF output power level is always shown in the amplitude
area of the display except under the following conditions:

amplitude reference mode is turned on

an offset is applied

a step or list amplitude sweep is in process

the RF Off On front panel key is off

The amplitude area of the display is blanked whenever an amplitude
sweep is selected.

Default Value: =135 dBm
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Arrow Keys

pk750a

Use the up and down arrow keys to increase and decrease the value of a
numeric parameter by the increment value. For example, when
frequency is the active function, if the current frequency setting is

1 MHz and the increment value set is 1 kHz, pressing the up and down
arrow keys will increase and decrease the 1 MHz frequency in 1 kHz
steps.

In addition, you can use the up and down arrow keys to scroll through
displayed lists to select items.

The left and right arrow keys choose the highlighted digit in the active
entry area, which is modified by the up and down arrow keys. When a
digit is highlighted it overrides the increment value used with the up
and down arrow keys. This override remains in effect until the Incr Set
key is pressed, an instrument preset occurs, or power is cycled. For
example, if frequency is the active parameter and you press the right
arrow key until the 1 kHz position is highlighted, the up and down
arrow keys will increase and decrease the frequency in 1 kHz
increments no matter where the Incr Set key has been set.

The arrow keys have autorepeat capability. Hold a key down and its
function is continuously executed until you release it.
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Display Contrast Keys

Display Contrast Keys
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pk761a

You can adjust the contrast of the display by pressing the decrease
contrast key or the increase contrast key [®1F].

Pressing the decrease contrast key and holding it down causes the
display background to gradually darken in comparison to the text on
the display. The minimum contrast setting is not a completely black
display. Some contrast between the background and the text will still be
visible.

Pressing the increase contrast key and holding it down causes the
display background to gradually brighten in comparison to the text on
the display. If the background does not appear to change, it is probably
set to the maximum contrast.

Display contrast is a persistent state; it is not affected by an instrument
preset or by a power cycle.
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FM

FM

Bus

Pressing the front panel Fm/oM key reveals a menu of softkeys. The
softkeys for FM are described in this section in alphabetical order. For a
description of the ®M softkeys, refer to the “Phase Modulation” section
in this chapter.

/S VMENUS I

Mode } AM } Utility } Freq }

FM/ Pulse } Sweep/} Ampl }

oM List
fLFou

pk729a

This softkey is one of the choices in the FM Sweep Trigger menu. With
Bus selected, you use the GPIB to trigger single sweeps of swept-sine
frequency modulation.

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Trigger >
Bus

DCFM/DC®M Cal

Dual-Sine

Pressing this softkey initiates a DCFM calibration. This calibration
eliminates the offset in DC FM so that the carrier frequency remains
the same with no modulation applied. External, DC-coupled FM must
be active when this calibration is executed.

Softkey Location: FM/®M > DCFM/DC®M Cal

Pressing this softkey reveals a menu of choices for setting the dual-sine
frequency modulation parameters. In this menu you can set the FM
rates for two separate tones. In addition, you can set the FM deviation
for FM Path 1 and FM Path 2 and also set a ratio of the tone 2 FM deviation
to the tone 1 FM deviation.

Softkey Location: FM/®M > FM Waveform > Dual-Sine
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Ext

This softkey is one of the choices in the FM Sweep Trigger menu.
Choosing Ext allows you to trigger swept-sine frequency modulation
using a signal applied to the TRIGGER IN rear panel connector. Set the
polarity of the trigger signal using the Trigger In Polarity Neg Pos softkey:.

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Trigger >
Ext

Ext 1 AC-Coupled

This softkey lets you input an external, AC-coupled, frequency
modulation signal to the EXT 1 INPUT connector. The modulation
signal is tested for voltage and a display annunciator will report a high
or low condition if the voltage is > +3% of 1 Vpk.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in an amplitude modulation configuration for AM Path 1, and then
you configured FM Path 2 to also use the external 1 input, the signal
generator would turn off AM Path 1 and assign the external 1 input to
your FM Path 2 configuration. For the purposes of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
source.

Softkey Location: FM/®M > FM Source > Ext 1 AC-Coupled

Ext 1 DC-Coupled

This softkey lets you input an external, DC-coupled, frequency
modulation signal to the EXT 1 INPUT connector.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in an amplitude modulation configuration for AM Path 1, and then
you configured FM Path 2 to also use the external 1 input, the signal
generator would turn off AM Path 1 and assign the external 1 input to
your FM Path 2 configuration. For the purposes of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
source.

Softkey Location: FM/®M > FM Source > Ext 1 DC-Coupled
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Ext 2 AC-Coupled

This softkey lets you input an external, AC-coupled, frequency
modulation signal to the EXT 2 INPUT connector. The modulation
signal is tested for voltage and a display annunciator will report a high
or low condition if the voltage is > £3% of 1 Vpk.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in an amplitude modulation configuration for AM Path 1, and then
you configured FM Path 2 to also use the external 2 input, the signal
generator would turn off AM Path 1 and assign the external 2 input to
your FM Path 2 configuration. For the purposes of this discussion, the
external 2 AC-coupled input is the same as the external 2 DC-coupled
source.

Softkey Location: FM/®M > FM Source > Ext 2 AC-Coupled

Ext 2 DC-Coupled

This softkey lets you input an external, DC-coupled, frequency
modulation signal to the EXT 2 INPUT connector.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in an amplitude modulation configuration for AM Path 1, and then
you configured FM Path 2 to also use the external 2 input, the signal
generator would turn off AM Path 1 and assign the external 2 input to
your FM Path 2 configuration. For the purposes of this discussion, the
external 2 AC-coupled input is the same as the external 2C-coupled
source.

Softkey Location: FM/®M > FM Source > Ext 2 DC-Coupled

FM oM

This softkey toggles between the menus for FM, normal ®M, and
wideband ®M. Refer to the “Phase Modulation” section for a discussion
of the differences between normal ®M, and wideband M.

Default Value: FM

Softkey Location: FMm/oM hardkey > FM oM softkey
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FM Dev

FM

Use this softkey to set the frequency modulation deviation for the

FM Path 1 and FM Path 2 configurations. To change the value of the FM
deviation, press the softkey once. The current value for FM deviation is
displayed in the active entry area. To enter a new value, rotate the front
panel knob until the desired value is displayed, use the up and down
arrow keys, or enter the value using the numeric keypad and press the
Hz, kHz, MHz, or GHz terminator softkey. The range of values allowed
depends on the carrier frequency. The maximum peak deviation for a
frequency is calculated by multiplying N times 10 MHz. (Table 4-1 lists
the values for N and the resulting maximum peak deviations.)

Table 4-1 Maximum Deviation Values for Frequency
Modulation

Carrier Frequency N Maximym_
Peak Deviation
250 kHz to < 249.999 MHz 1 10 MHz
> 249.999 MHz to <500 MHz | 0.5 5 MHz
>500 MHz to< 1 GHz 1 10 MHz
>1GHzto<2GHz 2 20 MHz
>2 GHz to 4 GHz 4 40 MHz

For example, if you choose a carrier frequency of 400 MHz, multiply 0.5
by 10 MHz resulting in a 5 MHz maximum peak deviation.

Notice that the new value of FM deviation applies only to whichever
FM path configuration you have currently selected. Also, whenever
FM Path 1 is used with FM Path 2, the deviation for FM Path 1 must be
greater than or equal to the deviation for FM Path 2.

Default Value: 1 kHz
Softkey Location: FM/®M > FM Dev

Or: FM/®M > FM Waveform > Dual-Sine > FM Dev

FM Dev Couple Off On

Toggles the FM deviation coupling on and off. Turning on FM deviation
coupling links the FM deviation values of FM Path 1 and FM Path 2. When
the values are coupled, any change you make to one FM deviation value
is applied to both FM deviation values.

Default Value: Off

Softkey Location: FM/®M > FM Dev Couple Off On
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FM

FM Off On

FM Path 1 2

Toggles the frequency modulation on or off for whichever FM path
configuration (FM Path 1 or FM Path 2) you have selected. Notice, however
that although you can turn on frequency modulation with this softkey,
the RF carrier is modulated by the enabled modulation only when you
have also set Mod On/Off to on. Whenever frequency modulation is
enabled, the FMannunciator is turned on in the display.

There are two paths for FM modulation which can be simultaneously
enabled as long as they use different sources (Int, Extl, or Ext2).

FM Path 2 is limited to a maximum rate of 1 MHz. FM Path 2 must be set to
a deviation less than or equal to FM Path 1. The modulation signals from
both paths are summed internally for composite modulation.

Default Value: Off

Softkey Location: FM/®M > FM Off On

Use FM Path 1 and FM Path 2 to define two unique frequency modulation
configurations. For example, select FM Path 1. (FM Path 1 is the default
after a normal preset. If FM Path 1 is not highlighted, press the softkey
until the selection toggles to FM Path 1.) Configure the modulation
characteristics (such as deviation, source, rate, and waveform) using
the remaining softkeys in the FM menu. Then enable FM by setting
FM Off On to On.

To configure a second frequency modulation configuration, toggle to
FM Path 2. Define the modulation characteristics for this second
configuration and enable FM by setting FM Off On to On.

The RF carrier is available at the RF OUTPUT connector when you set
RF On/Off to On. Set Mod On/Off to On to modulate the RF carrier with the
modulations that you have enabled.

FM Path 1 and FM Path 2 are summed internally for composite modulation.
Either path can be switched to any one of the modulation sources: Int,
Extl, or Ext2. All modulation types can be simultaneously enabled,
except FM with ®M, AM with external burst source, and wideband AM
with 1/Q. AM, FM, and ®M can sum simultaneous inputs from any two
sources (Int, Extl, and Ext2). Any given source (Int, Extl, or Ext2) can
only be routed to one activated modulation type.

Default Value: FM Path 1

Softkey Location: FM/®M > FM Path 1 2
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FM Rate

FM Source

FM

Use this softkey to change the internal modulation frequency for the
FM Path 1 and FM Path 2 configurations. To change the value, press the
softkey once. The current value for FM rate is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 10 kHz. (0.1 Hz to

50 kHz is the range allowed if sinewave is selected as the internal
waveform.) The minimum increment allowed is 0.1 Hz. Notice that the
new value of FM rate applies only to whichever FM path configuration
you have currently selected.

Default Value: 400 Hz

Softkey Location: FM/®M > FM Rate

Pressing this softkey reveals a menu of choices for frequency
modulation sources. You can choose internally-generated frequency
modulation or select an externally-applied signal from either the EXT
1 INPUT or EXT 2 INPUT connectors. The internal modulation is
always AC-coupled. For the externally-applied signals, you can choose
between AC- and DC-coupled modulation. A 1.0 Vpk input is required
for calibrated FM deviation settings. The EXT 1 LO H and

EXT 2 LO H display annunciators will turn on if the peak input voltage
differs from 1.0 Vpk by more than 3%. (The LO/HI annunciators only
function for AC-coupled external inputs.)

The internal and external 1 and 2 sources have multiple uses. You can
use them for amplitude, frequency, and phase modulation. For burst
modulation, you can only use the external 1 source. You must use the
external 2 source for pulse modulation. However, any given source can
only be routed to one enabled modulation at a time. If, for example, you
were using the external 1 source in a frequency modulation
configuration for FM Path 1, and then you configured AM Path 2 to also use
the external 1 source, the signal generator would turn off FM Path 1 and
assign the external 1 source to your AM Path 2 configuration. Notice that
for these purposes the external 1 AC-coupled source is the same as the
external 1 DC-coupled source and the external 2 AC-coupled source is
the same as the external 2 DC-coupled source.

Default Value: Internal

Softkey Location: FM/®M > FM Source

User’s Guide

4-27



Hardkey and Softkey Reference ESG Family Signal Generators

FM

FM Start Rate

Changes the starting internal modulation frequency for swept-sine
frequency modulation. To change the value, press the softkey once. The
current value for the FM start rate is displayed in the active entry area.
To enter a new value, rotate the front panel knob until the desired value
is displayed, use the up and down arrow keys, or enter the value using
the numeric keypad and press the Hz or kHz terminator softkey. The
range of values allowed is 0.1 Hz to 50 kHz. The minimum increment
allowed is 0.1 Hz.

This softkey is coupled to the FM Rate softkey in the initial FM Menu
and the FM Tone 1 Rate softkey in the FM Dual-Sine Menu. Any value set
for FM Start Rate is reflected in the FM Rate and FM Tone 1 Rate softkeys.
Conversely, if you change the value for either the FM Rate softkey or the
FM Tone 1 Rate softkey, the value for FM Start Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Start Rate

FM Stop Rate

Changes the ending internal modulation frequency for swept-sine
frequency modulation. The current value for the FM stop rate is
displayed in the active entry area. To enter a new value, rotate the front
panel knob until the desired value is displayed, use the up and down
arrow keys, or enter the value using the numeric keypad and press the
Hz or kHz terminator softkey. The range of values allowed is 0.1 Hz to
50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the FM Tone 2 Rate softkey in the FM Dual-Sine
Menu. Any value set for FM Stop Rate is reflected in the FM Tone 2 Rate
softkey. Conversely, if you change the value for the FM Tone 2 Rate softkey,
the value for FM Stop Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Stop Rate

FM Sweep Time

Sets the sweep time for swept-sine frequency modulation. The signal
generator will vary the FM rate from the specified start rate to the stop
rate in the time set with this softkey. Enter the desired sweep time
using the up and down arrow keys, the front panel knob, or enter a
value using the numeric keypad and press the sec or msec terminator
softkey. The range of values allowed is 1 ms through 65.535 s. The
minimum increment allowed is 1 ms.

Default Value: 100.0 msec

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Time
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FM

FM Sweep Trigger

Pressing this softkey reveals a menu of choices for triggering swept-sine
frequency modulation. You can choose triggering that occurs
immediately, triggering that is supplied via the GPIB bus, triggering on
either the positive or negative edge of a signal supplied to the
TRIGGER IN connector, external triggering, or triggering by the front
panel Trigger key.

Default Value: Immediate

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Trigger

FM Tone 1 Rate

Press this softkey to set the internal modulation frequency for the FM
tone 1. Enter the desired rate using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the kHz or Hz terminator softkey. The range of values allowed is 0.1 Hz
through 50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the FM Rate softkey in the initial FM Menu
and the FM start Rate softkey in the FM Swept-Sine Menu. Any value set
for FM Tone 1 Rate is reflected in the FM Rate and FM Start Rate softkeys.
Conversely, if you change the value for either the FM Rate softkey or the
FM Start Rate softkey, the value for FM Tone 1 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/®M > FM Waveform > Dual-Sine > FM Tone 1 Rate

FM Tone 2 Ampl Percent Of Peak

Press this softkey to set the amplitude of the alternate frequency/rate
as a percent of the peak LF analog modulation amplitude. The primary
frequency/rate will make up the remaining amplitude. This softkey is
for use with dual-sine modulation only.

For example, if the Tone 2 amplitude is 0%, then there would be no
amplitude for Tone 2; all of the signal strength would be present in Tone
1. If FM Tone 2 Ampl Percent Of Peak is set to 50%, then Tone 2 and Tone 1
would have equal amplitudes, or half of the amplitude of both tones
combined.

Default Value: 50.0%

Softkey Location: FM/®M > FM Waveform > Dual-Sine >
FM Tone 2 Ampl Percent Of Peak
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FM

FM Tone 2 Rate

Press this softkey to set the internal modulation frequency for the FM
tone 2. Enter the desired rate using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the kHz or Hz terminator softkey. The range of values allowed is 0.1 Hz
through 50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the FM Stop Rate softkey in the FM Swept-Sine
Menu. Any value set for FM Tone 2 Rate is reflected in the FM Stop Rate
softkey. Conversely, if you change the value for the FM Stop Rate softkey,
the value for FM Tone 2 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/®M > FM Waveform > Dual-Sine > FM Tone 2 Rate

FM Waveform

Immediate

Internal

Pressing this softkey reveals a menu of FM waveform choices for your
FM Path 1 and FM Path 2 configurations. Select from sine, triangle, square,
ramp, noise, dual-sine, and swept-sine waveforms. Notice that your
waveform selection applies only to whichever FM path configuration
you have currently selected.

Default Value: Sine

Softkey Location: FM/®M > FM Waveform

This softkey is one of the choices in the FM Sweep Trigger menu.
Choosing Immediate immediately triggers swept-sine frequency
modulation in a continuous mode. To stop the sweep, choose a different
trigger such as Ext, or set the waveform to something other than
Swept-Sine.

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Trigger >
Immediate

This softkey lets you internally generate an AC-coupled, frequency
modulation signal.

The internal source has multiple uses but can be used for only one
modulation at a time. If, for example you were using the internal source
in an amplitude modulation configuration for AM Path 1, and then you
configured FM Path 2 to also use the internal source, the signal generator
would turn off AM Path 1 and assign the internal source to your FM Path 2
configuration.

Softkey Location: FM/®M > FM Source > Internal
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Noise

Ramp

Sine

Square

Swept-Sine

FM

This softkey lets you specify noise as the frequency modulation
waveform for the FM Path 1 and FM Path 2 configurations. Notice that the
selected waveform applies only to whichever FM path configuration you
have currently selected.

Softkey Location: FM/®M > FM Waveform > Noise

This softkey lets you specify ramp as the frequency modulation
waveform for the FM Path 1 and FM Path 2 configurations. Notice that the
selected waveform applies only to whichever FM path configuration you
have currently selected.

Softkey Location: FM/®M > FM Waveform > Ramp

This softkey lets you specify sine as the frequency modulation
waveform for the FM Path 1 and FM Path 2 configurations. Notice that the
selected waveform applies only to whichever FM path configuration you
have currently selected.

Softkey Location: FM/®M > FM Waveform > Sine

This softkey lets you specify square as the frequency modulation
waveform for the FM Path 1 and FM Path 2 configurations. Notice that the
selected waveform applies only to whichever FM path configuration you
have currently selected.

Softkey Location: FM/®M > FM Waveform > Square

Pressing this softkey reveals a menu of choices for setting the
swept-sine frequency modulation parameters. In this menu you can set
the start and stop FM rate and the sweep time. You can set the signal
generator to a single, externally-triggered sweep on either a negative or
positive TTL level or you can choose continuous sweep, triggered
immediately. In this menu you can also select either a positive or
negative polarity for the TRIGGER OUT signal.

Softkey Location: FM/®M > FM Waveform > Swept-Sine
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Triangle

This softkey lets you specify triangle as the frequency modulation
waveform for the FM Path 1 and FM Path 2 configurations. Notice that the
selected waveform applies only to whichever FM path configuration you
have currently selected.

Softkey Location: FM/®M > FM Waveform > Triangle

Trigger In Polarity Neg Pos

Press this softkey to toggle between a negative TTL level trigger (0 V)
and a positive TTL level trigger (+5 V) for externally triggering
swept-sine frequency modulation.

This softkey is coupled to the Trigger In Polarity Neg Pos softkey for
swept-sine AM, ®M, and LF Out, and to the Ext Neg and Ext Pos sweep
trigger selections in the Sweep/List Menu. If you set the

Trigger In Polarity Neg Pos softkey in the FM Swept-Sine Menu to Neg, the
Trigger In Polarity Neg Pos softkey is also set to Neg for swept-sine AM, ®M,
and LF Out. And, in addition, if the step or list sweep trigger is set to
Ext Pos, the trigger selection will automatically be changed to Ext Pos.
The same softkeys will toggle to Pos or to Ext Pos if you select Pos in the
Swept-Sine FM Menu.

Conversely, if the Trigger In Slope Neg Pos softkey is toggled in the
swept-sine AM, ®M, or LF Out menus, it will cause the swept-sine FM
softkey to toggle also. This is also true for the Ext Neg and Ext Pos step or
list sweep trigger selections.

Default Value: Pos

Softkey Location: FM/®M > FM Waveform > Swept-Sine >
Trigger In Polarity Neg Pos

Trigger Key

This softkey is one of the choices in the FM Sweep Trigger menu. With
Trigger Key selected, when you press the Trigger front panel key you
immediately trigger a single sweep of swept-sine frequency modulation.

The Trigger key has autorepeat capability. Hold it down and you will
repeatedly trigger sweeps until you release the key.

Softkey Location: FM/®M > FM Waveform > Swept-Sine > FM Sweep Trigger >
Trigger Key
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FM

Trigger Out Polarity Neg Pos

This softkey toggles the polarity of the TTL signal that is output at the
rear panel TRIGGER OUT connector. When Trigger Out Polarity Neg Pos iS
set to Pos, the output signal is asserted high (+5 V) at the start of the
swept-sine frequency modulation sweep and low (0 V) when the sweep
is concluded. Setting Trigger Out Polarity Neg Pos t0 Neg reverses the
polarity, where a high is 0 V and a low is +5 V.

This softkey is coupled to the Trigger Out Polarity Neg Pos softkey in the
swept-sine AM, ®M, and LF Out menus and the sweep/list menu. When
the polarity is toggled for this softkey in any one of these menus, it
affects all locations of the softkey.

Default Value: Pos

Softkey Location: FM/®M > FM Waveform > Swept-Sine >
Trigger Out Polarity Neg Pos
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Freq

Freq

Adjust Phase

ESG Family Signal Generators

Pressing the front panel Freq key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

NS MENUS I

[M ode [AM

FM/ Pulse Sweep/
oM List

[Utility Freq

1Q

Use this softkey to change the phase of the RF OUTPUT signal. You can
change the phase relative to whatever phase the signal generator
locked to the last time it changed frequency. For this reason, the phase
adjustment does not survive changes in frequency and must be
readjusted. If you first press Phase Ref Set, the current output phase is
set as a zero reference and any subsequent phase adjustment is
displayed as relative to the zero reference. Phase adjustment cannot be
used with frequency or phase modulation.

To change the phase, press the softkey once. Phase adjustment becomes
the active function. To enter a new value, rotate the front panel knob
until the desired value is displayed, use the up and down arrow keys, or
enter the value using the numeric keypad and press the rad or deg
terminator softkey. The range of values allowed is £3.141 radians or
+180 degrees.

Default Value: O radians

Softkey Location: Freq > Adjust Phase
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Freq

Freq Multiplier

Freq Offset

You can multiply the frequency shown on the display without changing
the frequency output at the RF OUTPUT connector (simulating the
frequency at the output of a harmonic multiplier). Press this softkey
and enter a value from 1 through 50. Use the up and down arrow keys,
the front panel knob, or enter a value using the numeric keypad and
press the Enter terminator softkey. For example, set the output
frequency to 1 MHz. Then press Freq > Freq Multiplier > 3 > Enter. The
display will now show an output frequency of 3 MHz but the actual
output frequency will remain at 1 MHz. For any multiplier greater than
1, the MULT indicator is shown in the frequency area of the display.

Default Value: 1

Softkey Location: Freq > Freq Multiplier

Press this softkey to set a value for frequency offset. A frequency offset
changes the value shown in the frequency area of the display but does
not affect the output frequency. For example, if the current output
frequency is 1 MHz and you enter a frequency offset of 3 MHz, the
output frequency will remain at 1 MHz but the display will show a
frequency of 4 MHz. This feature lets you simulate the frequency at the
output of a frequency translating device.

A frequency offset can be entered at any time during normal operation
and also when you are operating in frequency reference mode. To enter
an offset, press Freq Offset and enter the desired frequency value using
the up and down arrow keys, the front panel knob, or enter a value
using the numeric keypad and press the Hz, kHz, MHz, or GHz terminator
softkey. When an offset has been entered, the OFFSET indicator is turned
on in the frequency area of the display.

Default Value: 0 Hz

Softkey Location: Freq > Freq Offset
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Freqg Ref Off On

This softkey toggles the frequency reference mode on and off. When
frequency reference mode is turned on, the frequency value displayed is
equal to the current hardware output frequency minus the reference
value set by the Freq Ref Set softkey. (The Freq Ref Set softkey sets the
reference value equal to the current output frequency. If you have not
yet set the reference value, the preset value for frequency reference is
0 Hz.) The REF indicator is turned on in the frequency area of the
display. All frequency parameters will now be set as relative to the
reference value.

Frequency offsets can be used with frequency reference mode. In this
situation, the display will show the frequency calculated as the current
hardware output frequency minus the reference value plus the
frequency offset.

Frequency reference mode only changes the display; it does not change
the RF output frequency. For example, if you set your RF output
frequency to 700 MHz, set your reference value, and then turn
frequency relative mode on, your display shows your frequency as 0 Hz
but your output frequency remains at 700 MHz.

Default Value: Off

Softkey Location: Freq > Freq Ref Off On

Freq Ref Set

This softkey sets the current output frequency as a frequency reference
value. It also causes the Freq Ref Off On softkey to toggle to the on
position, turning on frequency reference mode. All frequency
parameters are then set as relative to the reference value.

Default Value: Off

Softkey Location: Freq > Freq Ref Set

Mode 1 Optimize <10kHz Offset

Press this softkey to set the signal generator to mode 1 which optimizes
phase noise at offsets below 10 kHz.

Softkey Location: Freq > Optimize ® Noise > Mode 1 Optimize > 10k Offset

Mode 2 Optimize >10kHz Offset

Press this softkey to set the signal generator to mode 2 which optimizes
phase noise at offsets above 10 kHz.

Softkey Location: Freq > Optimize ® Noise > Mode 2 Optimize > 10k Offset
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Optimize ® Noise

Figure 4-1

Press this softkey for two choices in optimizing phase noise. You can
choose to set the phase-lock loop bandwidth to optimize phase noise for
offsets below or above 10 kHz offsets as shown in Figure 4-1. This
softkey is present on ESG-A and ESG-D series instruments only.

Phase Noise Performance Mode 1 Versus Mode 2
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Default Value: Mode 2

Softkey Location: Freq > Optimize ® Noise

Phase Ref Set

This softkey sets the current output phase as a zero reference. All phase
parameters are then set as relative to the zero reference.

Softkey Location: Freq > Phase Ref Set

Ref Oscillator Source Auto Off/On

This softkey switches off and on the signal generator’s capability of
automatically selecting between the internal reference oscillator and an
external reference oscillator. When this function is turned on, the signal
generator detects when a valid reference signal is present at the

10 MHz IN connector and automatically switches from internal to
external reference operation. Conversely, when this function is turned
off, the signal generator uses the internal reference only, even if an
external reference is connected.

Default Value: On

Softkey Location: Freq > Ref Oscillator Source Auto Off On
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Press this front panel hardkey to change the RF output frequency.
Frequency becomes the active function and the current value is also
shown in the active entry area of the display. To enter a new value for
frequency, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the GHz, MHz, kHz, or Hz terminator softkey.
The output frequency range allowed depends on your instrument
model. Refer to the technical specifications document.

The current RF output frequency is always shown in the frequency area
of the display (unless you have altered the display by turning on
frequency reference mode or entering an offset or a multiplier). The
frequency area of the display is blanked whenever a frequency sweep is
selected.

Default Value: Maximum specified output frequency
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Press this hardkey for a short description of the function of any front
panel hardkey or softkey. When you press the Help key, the following
message is displayed:

* Press a key for help on that key.

Press a front panel hardkey or a softkey and a short description of that
key’s function will be displayed. Press another key and you will be
returned to normal instrument operation.

The Help key can be set to either single or continuous mode. In single
mode, when you press the Help key, help text is provided only for the
next key that you press and then you are returned to normal operation.
In continuous mode, when you press the Help key, help text is provided
for the next key that you press and that key’s function is also executed
(except for the Preset key). This help mode remains active until you
press the Help key again.

Refer to the description of the Help Mode Single Cont softkey in the Utility
section for instructions on changing the help mode from single to
continuous.
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Press this front panel hardkey to de-activate the current active function
and blank the softkey menu. Once Hold is pressed, the front panel knob,
the arrow keys, and the numeric keypad have no effect.

To return to normal operation, press any front panel hardkey.
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Press this front panel hardkey to change the incremental value of the
up and down arrow keys for the current active function. For example,
press Frequency to make it the active function. The current frequency is
shown in the active entry area. The incremental value for frequency is
set to 1 MHz at the factory. Press Incr Set and the incremental value of
the up and down arrow keys for frequency becomes the active function.
You can change the value by using three different methods:

e Use the up and down arrow keys.The arrow keys will change the
incremental value in steps equal to the current incremental value (in
this example, these are 1 MHz steps.)

= Use the front panel knob.

« Use the numeric keypad and complete your entry with a terminator
softkey.

Press Incr Set again and the active function toggles, making frequency
the active function again.

Incremental values are persistent states; they are not affected by an
instrument preset or by a power cycle.
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1/Q

ALC Off On

This front panel hardkey and its menus are only available on ESG-D
and ESG-DP Series Signal Generators. The softkeys in the I/Q menus
are described in this section in alphabetical order.

M VENUS I
Mode J AM } Utility } Freq }

FM/ } Pulse } Sweep/} Ampl }
oM List

I fLFou

I/Q

pk733a

Press this softkey to Toggle the automatic leveling control (ALC) circuit
off and on.

The ALC is normally on. The RF output power of the signal generator is
constantly monitored and controlled by the ALC circuit. Its purpose is
to hold output power at its desired level in spite of drift due to
temperature and time.

There are some modulation conditions which the ALC circuit cannot
handle properly which lead to output level errors. In these conditions,
better power level accuracy can be obtained by turning the ALC off and
using power search. (Refer to the Power Search Manual Auto softkey
documented in this section for more information about power search.)
ALC off is useful with pulse modulation with a pulse width narrower
than 2 us and with certain external 1/Q modulation.

Pulse modulation is accomplished using a modulator which precedes
the ALC detector. The ALC must, therefore, measure a pulsed signal,
and it is able to do this if the pulse width exceeds 2 us. For narrower
pulses, set the ALC softkey to Off.

With external I/Q modulation, the ALC loop acts to hold the signal
generator’s average output power constant, in spite of variations in the
1/Q input power (12 + Q2). Rapid variations of (I + Q2) propagate to the
output, while slow variations are removed by the ALC loop, with a
high-pass corner of 1 kHz. If you do not want this high-pass filtering,
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set the ALC off on softkey to off. With ALC off, the 1/Q modulation will be
DC-coupled. Using power search, power level accuracy is preserved if
JP+Q%* =0.5 Vi

When ALC is off, the ALC OFF display annunciator will turn on.
Default Value: On

Softkey Location: 1/Q > ALC Off On

Burst Envelope Off On

Burst Source

Toggles on and off the burst envelope modulator. The burst envelope
modulator is used to burst the RF carrier. When the Burst Source softkey
is set to Ext1 DC, the shape of the burst output is the same as the shape
of the EXT 1 analog input. The Burst Envelope Off On softkey is toggled
automatically to on when any enabled digital modulation format also
has burst turned on (Option UN8). Whenever the burst envelope
modulator is on, the ENVLP annunciator is turned on in the display.

Default Value:; Off

Softkey Location: 1/Q > Burst Envelope Off On

Changes the source for burst modulation. If you do not have

Option UNS, your only choice is a DC-coupled, analog input using the
EXT 1 INPUT connector. Using this selection, the bursted output signal
will have the same shape as the analog input. If you have Option UNS,
this softkey will automatically toggle to Int Burst if you have turned on
burst for an enabled digital modulation format. In this mode, the
internal baseband generator bursts the RF carrier. You can override
this automatic selection by selecting Ext1 DC as the Burst Source. As long
as burst is turned on in an enabled digital modulation format, you can
toggle between the internal and external burst sources.

Default Value: Extl DC

Softkey Location: I/Q > Burst Source
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Calibration Type User Full

Toggles between an 1/Q calibration executed over the full frequency
range of the signal generator (Full) or an I/Q calibration over a frequency
range which you specify (User) using the Start Frequency and

Stop Frequency softkeys. Once you have chosen either Full or User, and
specified the frequency range, press Execute Cal to start the 1/Q
calibration.

The 1/Q calibration type is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: I/Q > I/Q Calibration > Calibration Type User Full

Do Power Search

Execute Cal

Extl DC

Press this softkey to execute the power search routine one time. Power
search is an internal calibration routine used to achieve calibrated
output power when the ALC is off. You can execute a power search at
any time by pressing this softkey. If you are using external 1/Q
modulation, the power search routine assumes that the 1/Q input level
is J17+Q° = 0.5 Vs Actual output amplitude will scale directly with

The ALcC off On softkey must be set to Off in order to execute the power
search routine.

Softkey Location: 1/Q > ALC Off On > Do Power Search

Press this softkey to begin the 1/Q calibration for the frequency range
that you have specified. The calibration can be aborted at any time
during the procedure by pressing the Abort Cal softkey. If you do abort
the calibration, the previous calibration is restored.

Softkey Location: I/Q > I/Q Calibration > Execute Cal

Press this softkey to change the burst source for modulation to a
DC-coupled, analog input using the EXT 1 INPUT connector. Using this
selection, the bursted output signal will have the same shape as the
analog input. If you do not have Option UNS, this is the only burst
source and it cannot be changed. If you have Option UNS, the burst
source can also be set to an internal source (refer to the Int Burst softkey).

Softkey Location: 1/Q > Burst Source > Extl1 DC
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Press this softkey to change the 1/Q source to externally supplied | and

Q signals. Apply the in-phase and quadrature-phase signals to the

I INPUT and Q INPUT connectors. The recommended signal level is
JIZ+Q? =0.5 Ve With equal levels at | and Q, as is usually the case,

this is equivalent to 0.35 V,s sSimultaneously at | and Q. For typical
W4DQPSK signals, a 0.35 V., waveform will be approximately

1.3 Vp-p, whereas for GMSK it will be 1.0 Vp-p. If you do not have
Option UNS, this is the only 1/Q source and it cannot be changed. If you
have Option UNS8, the I/Q source can also be set to an internal 1/Q
source (refer to the Int Burst softkey).

Softkey Location: 1/Q > 1/Q Source > Ext 1/Q

Ext 1/Q Phase Polarity Normal Invert

Press this softkey to toggle between the Normal and Invert settings for
external 1/Q phase polarity. In the inverted mode, the input applied to
the | INPUT connector is physically routed to the Q input port of the
internal 1/Q modulator. In addition, the input applied to the Q INPUT
connector is physically routed to the | input port of the internal 1/Q
modulator. This inverts the direction of phase rotation of the 1/Q
modulation. If you have enabled a digital modulation format

(Option UNB8 only), 1/Q phase polarity will be automatically set to
normal. You can override this setting with this key.

Default Value: Normal

Softkey Location: I/Q > Ext I/Q Phase Polarity Normal Invert

High Crest Mode Off On

Press this softkey to toggle high crest mode off and on. Turn high crest
mode on with externally-applied signals with high crest factors (such as
CDMA). High crest mode allows the signal generator to process these
signals with less distortion. With high crest factor signals, it is
recommended that the | and Q inputs seldom exceed 1.0 Vp-p. Some
output power and power level accuracy is sacrificed in this mode. This
softkey is active only if the 1/Q source is external and 1/Q is turned on.

Default Value: Off

Softkey Location: /Q > 1/Q Off On > High Crest Mode Off On
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| Offset

Press this softkey to enter an origin offset voltage for
internally-generated or externally-applied in-phase signals. Enter the
value as a percentage of full scale (500 mV). The range of values
allowed is —100% to +100%. Change the origin offset to adjust out
imperfections in the in-phase signal or to introduce calibrated
impairments. Set the origin offset as desired and then toggle the

I/Q Adjustments Off On softkey to on.

When using this key to minimize the LO feedthrough signal, optimum
performance is achieved when the adjustment is made after all other
1/Q path adjustments, such as those made with the [Int Phase Polarity
Normal Invert] or [Modulator Atten xx db Manual Auto] softkeys. If
other adjustments are made after minimization is performed, the LO
feedthrough signal may increase.

Default Value: 0.0%

Softkey Location: I/Q > I/Q Adjustments > | Offset

1/Q Adjustments

Pressing this softkey reveals a menu of 1/Q adjustment choices for
internally generated or externally applied | and Q signals. In this menu
you can change the | to Q gain ratio, change the | and Q offset voltages,
change quadrature skew, and turn on and off these I/Q adjustments.

Default Value: Off

Softkey Location: I/Q > I/Q Adjustments

1/Q Adjustments Off On

Press this softkey to toggle off and on the I to Q gain ratio and the I and
Q offset voltage adjustments. The values entered for the 1/Q Gain, | Offset,
and Q Offset are not applied to the | and Q signals until the

I/Q Adjustments Off On softkey is set to On.

Default Value: Off

Softkey Location: 1/Q > I/Q Adjustments > I/Q Adjustments Off On

1/Q Calibration

Pressing this softkey reveals a menu of choices for executing an 1/Q
calibration. An 1/Q calibration should be performed approximately
every 30 days, but it can be performed at any time to peak the
performance of the 1/Q modulator. You can set the start and stop
frequency for a user-defined 1/Q calibration, or choose an 1/Q calibration
over the signal generator’s entire frequency range. In this menu, you

4-46

User’s Guide



ESG Family Signal Generators Hardkey and Softkey Reference

1/Q Gain

1/Q Off On

1/Q Source

IQ

can also restore the values for the 1/Q calibration performed at the
factory (the instrument discards the latest calibration data and uses
the data installed by the factory).

Softkey Location: /Q > 1/Q Calibration

Press this softkey to change the | to Q gain ratio. For example, if you
enter in a value of +1 dB, the I signal will have 1 dB more amplitude
than the Q signal. The range of gain adjustment values allowed is

-4 dB to +4 dB. The gain ratio adjustment can be used with
externally-applied | and Q signals or with internally-generated | and Q
signals. Change the gain ratio to adjust out imperfections in | and Q or
to introduce calibrated impairments. Set the gain ratio as desired and
then toggle the 1/Q Adjustments Off On softkey to On.

Default Value: 0 dB

Softkey Location: I/Q > I/Q Adjustments > I/Q Gain

This softkey enables the 1/Q modulation. Notice, however, that although
you can enable 1/Q modulation with this softkey, the RF carrier is
modulated only when you have also set Mod On/Off to On. I/Q Off/On is also
toggled automatically to on when any of the digital modulation formats
are enabled (Option UN8). However, you can turn off the 1/Q
modulation with this softkey even though the digital modulation mode
is enabled. With this configuration, the RF output signal would not be
modulated but the 1/Q signals will be present at the rear panel 1/Q
outputs. Whenever 1/Q modulation is enabled, the | / Qannunciator is
turned on in the display.

Default Value: Off

Softkey Location: /Q > 1/Q Off On

Pressing this softkey reveals a menu of 1/Q source choices. If you have
enabled a digital modulation format (Option UNS8 only), the signal
generator is automatically set to internally generate | and Q signals
(int /1Q). You cannot use the internal source unless you have also enabled
a digital modulation format. You can externally supply the | and Q
signals via the | INPUT and Q INPUT connectors by pressing Ext I/Q.
Apply the in-phase and quadrature-phase signals to the | and Q inputs.
The signal level is /|2, o> = 0.5 V. (See the sections on Ext 1/Q and
High Crest Mode.)

Default Value: Ext 1/Q

Softkey Location: 1/Q > I/Q Source
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Int Burst

Int 1/Q

This softkey is automatically selected for the burst source when you
have enabled one of the digital modulation formats with burst on
(Option UN8 only). In this mode, the internal baseband generator
bursts the RF carrier. You can override this automatic selection by
selecting Ext1 DC as the Burst Source. As long as burst is turned on in an
enabled digital modulation format, you can toggle between the internal
and external burst sources.

Softkey Location: I/Q > Burst Source > Int Burst

This softkey is automatically selected for the 1/Q source when you have
enabled a digital modulation format (Option UN8 only). In this mode,
the signal generator is automatically set to internally generate | and Q
signals. You can override this selection by setting the 1/Q Source to

Ext1 1/Q. As long as digital modulation is enabled, you can toggle
between the internal and external 1/Q sources.

Softkey Location: 1/Q > 1/Q Source > Int I/Q

Power Search Manual Auto

This softkey toggles between the auto and manual modes of power
search mode. Power search is an internal calibration routine used to
achieve calibrated output power when the ALC is off. When you set
Power Search Manual Auto to Auto, power search will execute automatically
with each change to the RF frequency or power, and also with each
change to the AM, burst, pulse, or I/Q modulation state. If you are using
external 1/Q modulation, the power search routine assumes that the 1/Q
input level is 17+ Q? = 0.5 V,,s. Actual output amplitude will scale

directly with /2, ;2.

When you set Power Search Manual Auto to Manual, the power search
routine is not run until the Do Power Search softkey is pressed.

The ALcC off On softkey must be set to Off in order to engage either power
search mode.

Default Value: Manual

Softkey Location: 1/Q > ALC Off On > Power Search Manual Auto

4-48

User’s Guide



ESG Family Signal Generators Hardkey and Softkey Reference

Q Offset

IQ

Press this softkey to enter an origin offset voltage for
internally-generated or externally-applied quadrature-phase signals.
Enter the value as a percentage of full scale (500 mV). The range of
values allowed is —100% to +100%. Change the origin offset to adjust
out imperfections in the quadrature-phase signal or to introduce
calibrated impairments. Set the origin offset as desired and then toggle
the 1/Q Adjustments Off On softkey to oOn.

Default Value: 0.0%

Softkey Location: I/Q > I/Q Adjustments > Q Offset

Quadrature Skew

Press this softkey to adjust the phase angle between the | and Q
vectors. When the quadrature skew is zero, the phase angle is

90 degrees. Positive skew increases the angle from 90 degrees while
negative skew decreases the angle from 90 degrees. The range of values
allowed is +10 degrees with a minimum increment of 0.1 degrees.
However, if you're operating the signal generator in the 3.3 to 4 GHz
frequency range, quadrature skew settings greater than +5 degrees will
not be within specifications.

Default Value: 0.0 deg

Softkey Location: I/Q > I/Q Adjustments > Quadrature Skew

Revert to Default Cal Settings

Press this softkey to restore the original factory calibration data for the
internal 1/Q modulator. The latest calibration data from the user
calibration is discarded. Although the factory calibration data may not
be optimized for the signal generator’s present status, the data can be
used as a starting point if the current data is lost (if the 1/Q calibration
is unable to execute).

Softkey Location: I/Q > 1/Q Calibration > Revert to Default Cal Settings
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Start Frequency

Press this softkey in the I/Q Calibration menu to set the start frequency
for executing an I/Q calibration. You can select a portion of the
frequency range for an 1/Q calibration by selecting Calibration Type User
and setting new start and stop frequencies. Limiting the frequency
range of the calibration will decrease the time required for the
calibration to be executed. To enter a frequency, rotate the front panel
knob until the desired value is displayed, use the up and down arrow
keys, or enter the value using the numeric keypad and press the Hz, kHz,
MHz, or GHz terminator softkey. This softkey is automatically set to the
minimum specified frequency of the signal generator if you have set the
Calibration Type User Full softkey to Full (entire frequency range of the
signal generator). The User value for Start Frequency is not changed,
however. If you toggle back to user from the Full setting, notice that the
User value is unchanged.

Start Frequency IS a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: 1/Q > I/Q Calibration > Start Frequency

Stop Frequency

Press this softkey in the 1/Q Calibration menu to set the stop frequency
for executing an 1/Q calibration. You can select a portion of the
frequency range for an 1/Q calibration by selecting Calibration Type User
and setting new start and stop frequencies. Limiting the frequency
range of the calibration will decrease the time required for the
calibration to be executed. To enter a frequency, rotate the front panel
knob until the desired value is displayed, use the up and down arrow
keys, or enter the value using the numeric keypad and press the Hz, kHz,
MHz, or GHz terminator softkey. This softkey is automatically set to the
maximum specified frequency of the signal generator if you have set the
Calibration Type User Full softkey to Full (entire frequency range of the
signal generator). The User value for Stop Frequency is not changed,
however. If you toggle back to user from the Full setting, notice that the
User value is unchanged.

Stop Frequency iS a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: I/Q > I/Q Calibration > Stop Frequency
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Pressing the front panel LF out key reveals a menu of softkeys for
configuring the internal low frequency generator. These softkeys are
described in this section in alphabetical order.

N ENUS I,
[Mode [AM [Utility [Freq

[FM / [Pulse {Sweep/ {Ampl
oM List

Ia | LF Out

LF Out
pk734a

This softkey is one of the choices in the LF Out Sweep Trigger menu.
With Bus selected, you use the GPIB to trigger single sweeps of
swept-sine low frequency output.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger > Bus

This softkey lets you specify DC as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > DC
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Dual-Sine

Ext

Pressing this softkey reveals a menu of choices for setting the dual-sine
low frequency output parameters. In this menu you can set the
frequencies for two separate tones. In addition you can set a ratio of the
tone 2 LF amplitude to the tone 1 LF amplitude.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Dual-Sine

This softkey is one of the choices in the LF Output Sweep Trigger
menu. Choosing Ext allows you to trigger swept-sine low frequency
output using the signal applied to the TRIGGER IN rear panel
connector. Set the polarity of the trigger signal using the

Trigger In Polarity Neg Pos softkey.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger > Ext

Function Generator

Immediate

This softkey lets you set the LF out Source to be a function generator. You
can select a frequency and shape in addition to selecting the amplitude
for a signal that is output at the LF OUTPUT front panel connector.
When you use the internal source in this capacity, any modulation with
the internal source selected is turned off.

Softkey Location: LF Out > LF Out Source > Function Generator

This softkey is one of the choices in the LF Output Sweep Trigger
menu. Choosing Immediate immediately triggers swept-sine low
frequency output in a continuous mode. To stop the sweep, choose a
different trigger such as Ext, or set the waveform to something other
than Swept-Sine.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger > Immediate
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Internal Modulation

This softkey lets you output a signal at the LF OUTPUT connector
where the frequency and shape of the signal is set by the internal
source as it is being used by a modulation. For example, if the internal
source is currently assigned to an AM path configuration and AM is
turned on, the signal output at the LF OUTPUT connector will have the
frequency and shape of the amplitude modulating signal. You can scale
the amplitude of the output signal using the LF out Amplitude softkey.

For internal square pulse modulation, the internal source is a sinewave
which is later squared by the modulator to generate the pulse
squarewave. The LF OUTPUT signal for this internal source, therefore,
is a sinewave. For internal pulse modulation, a true variable-width
pulse will be seen on the LF OUTPUT.

Softkey Location: LF Out > LF Out Source > Internal Modulation

LF Out Amplitude

LF Out Freq

Use this softkey to scale the output of the signal at the LF OUTPUT
connector. To change the value, press the softkey once. The current
value for LF output amplitude is displayed in the active entry area. To
enter a new value, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the v, or mv terminator softkey. The range of
values allowed is 0 to 5 Vpk in increments from 1 mV to 5 V.

Default Value: OV

Softkey Location: LF Out > LF Out Amplitude

Use this softkey to set the modulating frequency for the LF output
signal when you have selected the internal source as a function
generator. To change the frequency, press the softkey once. The current
modulating frequency is displayed in the active entry area. To enter a
new frequency, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the Hz or kHz terminator softkey. The range of
frequencies allowed is 0.1 Hz to 10 kHz. (0.1 Hz to 50 kHz is the range
allowed if sinewave is selected as the internal waveform.)

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 400 Hz

Softkey Location: LF Out > LF Out Source > Function Generator > LF Out Freq
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LF Out Off On

This softkey toggles on and off the output of the selected source at the
LF OUTPUT front panel connector. You can choose either the
modulation signal generated by the internal source or you can use the
low frequency source as a function generator and select that signal to
output at the LF OUTPUT connector. Refer to the description of the

LF out Source softkey in this section for more information on choosing the
source.

Once you have toggled this state on, the signal is immediately available
at the LF OUTPUT connector. The Mod On/0Off and RF On/0Off keys do not
apply to this state.

Default Value: Off

Softkey Location: LF Out > LF Out Off On

LF Out Period

Changes the pulse period for the pulsed low frequency waveform. To
change the period, press the softkey once. The current value for pulse
period is displayed in the active entry area. To enter a new value, rotate
the front panel knob until the desired value is displayed, use the up and
down arrow keys, or enter the value using the numeric keypad and
press the psec or msec terminator softkey. The range of values allowed is
from 16 ps to 30 s. If you set the pulse period to a smaller value than the
pulse width, an error message will be generated and the pulse width
will be reduced to the value of the pulse period.

This softkey is only active when you have selected the internal source to
operate as a function generator and when the LF Out waveform is
specified as pulse.

Default Value: 80 us

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Pulse > LF Out Period
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LF Out

LF Out Source

Reveals a menu of choices for LF output sources. You can choose to
output the signal from the internal source as it is being used by a
modulation or you can use the internal source as a function generator
and select that signal to output at the LF OUTPUT connector.

If you choose the internal source, the frequency and shape of the signal
at the LF OUTPUT connector is set by the internal source as it is being
used by a modulation. For example, if the internal source is currently
assigned to an AM path configuration and AM is turned on, the signal
output at the LF OUTPUT connector will have the frequency and shape
of the amplitude modulating signal. You can scale the amplitude of the
output signal using the LF out Amplitude softkey.

If you choose to set the internal source as a function generator, you can
select a frequency and shape in addition to selecting the amplitude for
the LF output signal. When you use the internal source in this capacity,
any modulation with the internal source selected is turned off.

Default Value: Internal Modulation

Softkey Location: LF Out > LF Out Source

LF Out Start Freq

Use this softkey to change the starting frequency for swept-sine low
frequency output. To change the value, press the softkey once. The
current value for the LF Out start frequency is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 50 kHz. The minimum
increment allowed is 0.1 Hz.

This softkey is coupled to the LF Out Freq softkey in the initial LF Out
Menu and the LF Out Tone 1 Freq softkey in the LF Out Dual-Sine Menu.
Any value set for LF Out Start Freq is reflected in the LF Out Freq and

LF Out Tone 1 Freq softkeys. Conversely, if you change the value for either
the LF out Freq softkey or the LF Out Tone 1 Freq softkey, the value for

LF Out Start Freq is changed to match.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 400.0 Hz

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Start Freq
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LF Out Stop Freq

Use this softkey to change the ending frequency for swept-sine low
frequency output. To change the value, press the softkey once. The
current value for the LF Out stop frequency is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 50 kHz. The minimum
increment allowed is 0.1 Hz.

This softkey is coupled to the LF Out Tone 2 Freq softkey in the LF Out
Dual-Sine Menu. Any value set for LF Out Stop Freq is reflected in the
LF Out Tone 2 Freq softkey. Conversely, if you change the value for the
LF Out Tone 2 Freq softkey, the value for LF Out Stop Freq is changed to
match.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 400.0 Hz

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Stop Freq

LF Out Sweep Time

Press this softkey to set the sweep time for low frequency swept-sine
output. The signal generator will sweep from the specified start
frequency to the stop frequency in the time set with this softkey. Enter
the desired sweep time using the up and down arrow keys, the front
panel knob, or enter a value using the numeric keypad and press the sec
or msec terminator softkey. The range of values allowed is 1 ms through
65.535 s. The minimum increment allowed is 1 ms.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 100.0 msec

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Time
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LF Out

LF Out Sweep Trigger

Pressing this softkey reveals a menu of choices for triggering swept-sine
low frequency output. You can choose triggering that occurs
immediately, triggering that is supplied by the GPIB, triggering on
either a positive or negative level of a signal supplied to the

TRIGGER IN connector, or triggering by the front panel Trigger key.

Default Value: Immediate

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger

LF Out Tone 1 Freq

Press this softkey to set the frequency for the LF Out tone 1. Enter the
desired frequency using the up and down arrow keys, the front panel
knob, or enter a value using the numeric keypad and press the kHz or Hz
terminator softkey. The range of values allowed is 0.1 Hz through

50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the LF out Freq softkey in the initial LF Out
Menu and the LF Out Start Freq softkey in the LF Out Swept-Sine Menu.
Any value set for LF Out Tone 1 Freq is reflected in the LF out Freq and

LF Out Start Freq softkeys. Conversely, if you change the value for either
the LF out Freq softkey or the LF Out Start Freq softkey, the value for

LF Out Tone 1 Freq is changed to match.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 400.0 Hz

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Dual-Sine > LF Out Tone 1 Freq
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LF Out

LF Out Tone 2 Ampl % Of Peak

Press this softkey to set the ratio of the peak amplitude of LF Out
tone 2 to the peak amplitude of LF Out as a percent. The range of
values allowed is 0 to 100%. The minimum increment allowed is 0.1%.
The sum of the two LF Out amplitudes results in the total LF Out
amplitude (set by the LF out Amplitude softkey in the initial LF Out
Menu.

For example, if the total LF Out amplitude is 300 mVp and you set

LF Out Tone 2 Ampl % Of Peak to 33%, then the amplitude of LF Out tone 1
will be 200 mVp and the amplitude of LF Out tone 2 will be 100 mVp
(33% of 300 mVp) so that the amplitude of the two tones adds up to
300 mVp (200 mVp plus 100 mVp).

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 50.0%

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Dual-Sine > LF Out Tone 2 Ampl % Of Peak

LF Out Tone 2 Freq

Press this softkey to set the frequency for the LF Out tone 2. Enter the
desired frequency using the up and down arrow keys, the front panel
knob, or enter a value using the numeric keypad and press the kHz or Hz
terminator softkey. The range of values allowed is 0.1 Hz through

50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the LF out Freq softkey in the initial LF Out
Menu and the LF Out Stop Freq softkey in the LF Out Swept-Sine Menu.
Any value set for LF Out Tone 2 Freq is reflected in the LF out Freq and

LF Out Stop Freq softkeys. Conversely, if you change the value for either
the LF out Freq softkey or the LF Out Stop Freq softkey, the value for

LF Out Tone 2 Freq is changed to match.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: 400.0 Hz

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Dual-Sine > LF Out Tone 2 Freq
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LF Out

LF Out Waveform

Pressing this softkey reveals a menu of LF output waveform choices for
your LF function generator. Select from sine, dual-sine, swept-sine,
triangle, ramp, square, pulse, noise, and DC waveforms.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: Sine

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform

LF Out Width

Noise

Use this softkey to change the pulse width for the pulsed low frequency
waveform. To change the width, press the softkey once. The current
value for pulse width is displayed in the active entry area. To enter a
new value, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the psec or msec terminator softkey. The
range of values allowed is from 8 ps to a maximum of the value for the
pulse period.

This softkey is only active when you have selected the internal source to
operate as a function generator and when the LF Out waveform is
specified as pulse.

Default Value: 40 us

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Pulse > LF Out Width

This softkey lets you specify noise as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Noise
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LF Out

Pulse

Ramp

Sine

Square

This softkey lets you specify pulse as the waveform for the LF output
signal. The signal shape can only be specified when you have selected
the internal source to operate as a function generator. Use the
LF Out Period and LF out Width softkeys to define the pulse shape.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Pulse

This softkey lets you specify ramp as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Ramp

This softkey lets you specify sine as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Sine

This softkey lets you specify square as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Square
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Swept-Sine

Triangle

LF Out

Pressing this softkey reveals a menu of choices for setting the
swept-sine low frequency output. In this menu you can set the LF start
and stop frequency and the sweep time. You can also set the trigger for
the swept-sine output, and the polarity of the TRIGGER IN and
TRIGGER OUT signals.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine

This softkey lets you specify triangle as the waveform for the LF output
signal.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Triangle

Trigger In Polarity Neg Pos

Press this softkey to toggle between a negative TTL level trigger (0 V)
and a positive TTL level trigger (+5 V) for externally triggering
swept-sine low frequency output.

This softkey is coupled to the Trigger In Polarity Neg Pos softkey for
swept-sine AM, FM, and ®M, and to the Ext Neg and Ext Pos sweep
trigger selections in the Sweep/List Menu. If you set the

Trigger In Polarity Neg Pos softkey in the LF Out Swept-Sine Menu to Neg,
the Trigger In Polarity Neg Pos softkey is also set to Neg for swept-sine AM,
FM, and ®M. In addition, if the step or list sweep is set to externally
trigger, the selection will automatically be set to Ext Neg. The same
softkeys will toggle to Pos or to Ext Pos if you select Pos in the Swept-Sine
LF Out Menu.

Conversely, if the Trigger In Slope Neg Pos softkey is toggled in the
swept-sine AM, FM, or ®M menus, it will cause the swept-sine LF Out
softkey to toggle also. This is also true for the Ext Neg and Ext Pos step or
list sweep trigger selections.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: Pos

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger > Ext >
Trigger In Polarity Neg Pos
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LF Out

Trigger Key

This softkey is one of the choices in the LF Output Sweep Trigger
menu. With Trigger Key selected, when you press the Trigger front panel
key you immediately trigger a single sweep of swept-sine low frequency
output.

The Trigger key has autorepeat capability. Hold it down and you will
repeatedly trigger sweeps until you release the key.

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > LF Out Sweep Trigger > Trigger Key

Trigger Out Polarity Neg Pos

This softkey toggles the polarity of the TTL signal that is output at the
rear panel TRIGGER OUT connector. When Trigger Out Polarity Neg Pos is
set to Pos, the output signal is asserted high (+5 V) at the start of the
swept-sine low frequency sweep and low (0 V) when the sweep is
concluded. Setting Trigger Out Polarity Neg Pos t0o Neg reverses the polarity,
where a highis 0V and a low is +5 V.

This softkey is coupled to the Trigger Out Polarity Neg Pos softkey in the
swept-sine AM, FM, and ®M menus and the sweep/list menu. When the
polarity is toggled for this softkey in any one of these menus, it affects
all locations of the softkey.

This softkey is only active when you have selected the internal source to
operate as a function generator.

Default Value: Pos

Softkey Location: LF Out > LF Out Source > Function Generator >
LF Out Waveform > Swept-Sine > Trigger Out Polarity Neg Pos
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Press this key to return the signal generator to local (front panel)
control from remote operation or to restore the front panel menu and
status area display after RS-232 control. You can also press this key to
restore the display once the screen saver has started.

This key has autorepeat capability. Hold it down and its function is
continuously executed until you release it.

Default Value: Local (unless a LOCAL LOCKOUT command has been
sent).
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Mod On/Off
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Set this front panel hardkey to on to modulate the RF carrier with the
modulations that you have enabled. All modulation types can be
simultaneously enabled except FM with ®M, AM with external burst
source, and wideband AM with 1/Q. An annunciator is always turned on
in the display to indicate whether modulation is turned on or off.

Default Value: Mod Off
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Mode

Pressing the front panel Mode key reveals a menu of softkeys. These
softkeys let you access further menus for enabling options on digital

ESG-D and ESG-DP series signal generators. These options are

documented in separate user’'s and programming guides which are part
of the digital documentation set.

On analog ESG-A and ESG-AP series signal generators, this front panel
key is reserved for future use.

/S VENUS I

Mode

AM }

Utility }

Freq }

pk725a

Pulse }

Sweep/
List

Ampl }

fLFou
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Numeric Keypad

Numeric Keypad
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The numeric keypad consists of the digit keys (0 through 9), a decimal
point key, and a backspace key, The backspace key has dual
functions for both backspacing and for changing the sign of a value to
positive or negative. Use these keys at any time when the active
function requires a value input. The backspace key function changes
with the situation.

If you are modifying a previously entered value:

« |If the value is negative, pressing the backspace key deletes the
entire value and leaves the negative sign. Subsequent key presses
change the sign between positive and negative states.

= |If the value is positive, pressing the backspace key deletes the entire
value and also changes the sign to a negative state. Subsequent key
presses change the sign between positive and negative states.

If you are entering a new value:

= If the cursor is to the right of the digits, pressing the backspace key
deletes the digit immediately to the left. When no digits remain,
subsequent key presses change the sign between positive and
negative states.

= If the cursor is on a digit, pressing the backspace key deletes the
digit immediately to the left. When a single digit remains, pressing
the backspace key changes the negative sign (if present) to positive
and then subsequent key presses have no effect.

These keys have autorepeat capability (except for the decimal point
key). Hold a key down and its function is continuously executed until
you release it.
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Phase Modulation

Pressing the front panel phase modulation key (oM) reveals a menu of
softkeys. These softkeys are described in this section in alphabetical
order.

N VENUS
Mode } AM } Utility } Freq }

FM/ Pulse Sweep/ Ampl
oM List

fLFou

pk729a
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®M Dev

Use this softkey to set the phase modulation deviation for the ®M Path 1
and oM Path 2 configurations. To change the value of the ®M deviation,
press the softkey once. The current value for ®M deviation is displayed
in the active entry area. To enter a new value, rotate the front panel
knob until the desired value is displayed, use the up and down arrow
keys, or enter the value using the numeric keypad and press the pi rad,
rad, or deg terminator softkey. The range of values allowed depends on
the carrier frequency and the rate selected. Refer to Table 4-2.

Table 4-2 Maximum Deviation Values for Phase Modulation
. Maximum Rates (3 dB BW)
Maximum
Mode Deviation
®M Path 1 ®M Path 2
Normal Nl X 90 radians 100 kHZ 100 kHZ
High N x 2mt radians 1.5 MHz (typical) | 1 MHz (typical)
Bandwidth : 3 ;
N x 172 radians 6 MHz (typical) 1 MHz (typical)

1. For the value of N, refer to Table 4-3.

Table 4-3 Carrier Frequency Bands versus Value of N

Carrier Frequency N

250 kHz to < 249.999 MHz 1

> 249.999 MHz to <500 MHz | 0.5

>500 MHz to<1 GHz 1
>1GHzto<2 GHz 2
>2 GHz to 4 GHz 4

For example, if you set up ®M Path 1 for normal phase modulation with a
carrier frequency of 400 MHz, and a rate of 100 kHz, the maximum
peak deviation that you can set is 0.5 (value of N) times 90 radians
resulting in a maximum peak deviation of 45 radians.

Notice that the new value of ®M deviation applies only to whichever
®M path configuration you have currently selected. Also, ®M Path 2 is
limited to a maximum rate of 1 MHz. Also, whenever ®M Path 1 is used
with oM Path 2, the deviation for ®M Path 1 must be greater than or equal
to the deviation for oM Path 2.

Default Value: 0 radians

Softkey Location: FM/oM hardkey > FM ®M softkey > &M Path 1 2

4-68

User’s Guide



ESG Family Signal Generators Hardkey and Softkey Reference

Phase Modulation

®M Dev Couple Off On

d®M Off On

This softkey toggles the ®M deviation coupling on and off. Turning on
®M deviation coupling links the ®M deviation values of ®M Path 1 and
oM Path 2. When the values are coupled, any change you make to one
®M deviation value is applied to both ®M deviation values.

Default Value: Off

Softkey Location: FM/oM hardkey > FM ®M softkey om >
®M Dev Couple Off On

This softkey toggles the phase modulation on or off for whichever ®M
configuration (&M Path 1 or ®M Path 2) you have selected. Notice, however
that although you can turn on phase modulation with this softkey, the
RF carrier is modulated by the enabled modulation only when you have
also set Mod On/Off to on. Whenever phase modulation is enabled, the ®M
annunciator is turned on in the display.

There are two paths for ®M modulation which can be simultaneously
enabled as long as they use different sources (Int, Extl, or Ext2).

®M Path 2 is limited to a maximum rate of 1 MHz. ®M Path 2 must be set
to a deviation less than or equal to ®M Path 1. The modulation signals
from both paths are summed internally for composite modulation.

Default Value: Off

Softkey Location: FM/oM hardkey > FM ®M softkey ©M > ®M Off On
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Phase Modulation

®M Path 1 2

®M Rate

Use oM Path 1 and ®M Path 2 to define two unique phase modulation
configurations. For example, select ®M Path 1. (M Path 1 is the default
after a normal preset. If ®M Path 1 is not highlighted, press the softkey
once and the selection will toggle from ®M Path 2 to ®M Path 1.) Configure
the modulation characteristics (such as deviation, source, rate, and
waveform) using the remaining softkeys in the ®M menu. Then enable
®M by setting ®M Off On to On.

To configure a second phase modulation configuration, toggle to
®M Path 2. Define the modulation characteristics for this second
configuration and enable ®M by setting ®M Off On to On.

The RF carrier is available at the RF OUTPUT connector when you set
RF On/Off t0o On. Set Mod On/Off to On to modulate the RF carrier with the
modulations that you have enabled.

®M Path 1 and oM Path 2 are summed internally for composite modulation.
Either path can be switched to any one of the modulation sources: Int,
Extl, or Ext2. All modulation types can be simultaneously enabled,
except FM with ®M, AM with external burst source, and wideband AM
with 1/Q. AM, FM, and ®M can sum simultaneous inputs from any two
sources (Int, Extl, and Ext2). Any given source (Int, Extl, or Ext2) can
only be routed to one activated modulation type.

Default Value: ®M Path 1
Softkey Location: FM/oM hardkey > FM ®M softkey M > &M Path 1 2

Use this softkey to change the internal modulation frequency for the
®M Path 1 and ®M Path 2 configurations. To change the value, press the
softkey once. The current value for ®M rate is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 10 kHz. (0.1 Hz to

50 kHz is the range allowed if sinewave is selected as the internal
waveform.) The minimum increment allowed is 0.1 Hz. Notice that the
new value of ®M rate applies only to whichever ®M path configuration
you have currently selected.

Default Value: 400 Hz

Softkey Location: FM/oM hardkey > FM/®M softkey oM > oM Rate
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®M Source

Phase Modulation

Pressing this softkey reveals a menu of choices for phase modulation
sources. You can choose internally-generated phase modulation or
select an externally-applied signal from either the EXT 1 INPUT or
EXT 2 INPUT connectors. The internal modulation is always
AC-coupled. For the externally-applied signals, you can choose between
AC- and DC-coupled modulation. A 1.0 Vpk input is required for
calibrated ®M deviation settings. The EXT 1 LOH and EXT 2 LO HI
display annunciators will turn on if the peak input voltage differs from
1.0 Vpk by more than 3%. (The LO/HI annunciators only function for
AC-coupled external inputs.)

The internal and external 1 and 2 sources have multiple uses. You can
use them for amplitude, frequency, and phase modulation. For burst
modulation, you can only use the external 1 source and you must use
the external 2 source for pulse modulation. However, any given source
can only be routed to one enabled modulation at a time. If, for example,
you were using the external 1 source in a frequency modulation
configuration for FM Path 1, and then you configured AM Path 2 to also use
the external 1 source, the signal generator would turn off FM Path 1 and
assign the external 1 source to your AM Path 2 configuration. Notice that
for these purposes the external 1 AC-coupled source is the same as the
external 1 DC-coupled source and the external 2 AC-coupled source is
the same as the external 2 DC-coupled source.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > ®M Source

®M Start Rate

Use this softkey to change the starting internal modulation frequency
for swept-sine phase modulation. To change the value, press the softkey
once. The current value for the ®M start rate is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 50 kHz. The minimum
increment allowed is 0.1 Hz.

This softkey is coupled to the ®M Rate softkey in the initial ®M Menu
and the ®M Tone 1 Rate softkey in the ®M Dual-Sine Menu. Any value set
for oM Start Rate is reflected in the oM Rate and ®M Tone 1 Rate softkeys.
Conversely, if you change the value for either the ®M Rate softkey or the
®M Tone 1 Rate softkey, the value for oM Start Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/oM hardkey > FM ®M softkey oM > &M Waveform >
Swept-Sine > ®M Start Rate
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Phase Modulation

®M Stop Rate

Use this softkey to change the ending internal modulation frequency for
swept-sine phase modulation. To change the value, press the softkey
once. The current value for the ®M stop rate is displayed in the active
entry area. To enter a new value, rotate the front panel knob until the
desired value is displayed, use the up and down arrow keys, or enter the
value using the numeric keypad and press the Hz or kHz terminator
softkey. The range of values allowed is 0.1 Hz to 50 kHz. The minimum
increment allowed is 0.1 Hz.

This softkey is coupled to the ®M Tone 2 Rate softkey in the ®M Dual-Sine
Menu. Any value set for ®M Stop Rate is reflected in the ®M Tone 2 Rate
softkey. Conversely, if you change the value for the ®M Tone 2 Rate
softkey, the value for oM Stop Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Swept-Sine > ®M Stop Rate

®M Sweep Time

Press this softkey to set the sweep time for swept-sine phase
modulation. The signal generator will vary the ®M rate from the
specified start rate to the stop rate in the time set with this softkey.
Enter the desired sweep time using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the sec or msec terminator softkey. The range of values allowed is 1 ms
through 65.535 s. The minimum increment allowed is 1 ms.

Default Value: 100.0 msec

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Swept-Sine > ®M Sweep Time

®M Sweep Trigger

Pressing this softkey reveals a menu of choices for triggering swept-sine
phase modulation. You can choose triggering that occurs immediately,
triggering that is supplied by the GPIB, triggering on either the positive
or negative edge of a signal supplied to the TRIGGER IN connector, or
triggering by the front panel Trigger key.

Default Value: Immediate

Softkey Location: FM/oM hardkey > FM ®M softkey oM > oM Waveform >
Swept-Sine > ®M Sweep Trigger
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Phase Modulation

®M Tone 1 Rate

Press this softkey to set the internal modulation frequency for the ®M
tone 1. Enter the desired rate using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the kHz or Hz terminator softkey. The range of values allowed is 0.1 Hz
through 50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the ®M Rate softkey in the initial M Menu
and the oM start Rate softkey in the ®M Swept-Sine Menu. Any value set
for ®M Tone 1 Rate is reflected in the ®M Rate and ®M Start Rate softkeys.
Conversely, if you change the value for either the ®M Rate softkey or the
®M Start Rate softkey, the value for ®M Tone 1 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/oM hardkey > FM ®M softkey M > &M Waveform >
Dual-Sine > ®M Tone 1 Rate

®M Tone 2 Ampl Percent Of Peak

Press this softkey to set the amplitude of the alternate frequency/rate
as a percent of the peak LF analog modulation amplitude. The primary
frequency/rate will make up the remaining amplitude. This softkey is
for use with dual-sine modulation only.

For example, if the Tone 2 amplitude is 0%, then there would be no
amplitude for Tone 2; all of the signal strength would be present in Tone
1. If ®M Tone 2 Ampl Percent Of Peak is set to 50%, then Tone 2 and Tone 1
would have equal amplitudes, or half of the amplitude of both tones
combined.

Default Value: 50.0%

Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Waveform >
Dual-Sine > ®M Tone 2 Ampl Percent Of Peak

®M Tone 2 Rate

Press this softkey to set the internal modulation frequency for the ®M
tone 2. Enter the desired rate using the up and down arrow keys, the
front panel knob, or enter a value using the numeric keypad and press
the kHz or Hz terminator softkey. The range of values allowed is 0.1 Hz
through 50 kHz. The minimum increment allowed is 0.1 Hz.

This softkey is coupled to the oM Stop Rate softkey in the ®M Swept-Sine
Menu. Any value set for ®M Tone 2 Rate is reflected in the ©M Stop Rate
softkey. Conversely, if you change the value for the ®M Stop Rate softkey,
the value for ®M Tone 2 Rate is changed to match.

Default Value: 400.0 Hz

Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Waveform >
Dual-Sine > ®M Tone 2 Rate
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Phase Modulation

dM Waveform

Bus

Pressing this softkey reveals a menu of ®M waveform choices for your
®M Path 1 and ®M Path 2 configurations. Select from sine, triangle, square,
ramp, noise, dual-sine, and swept-sine waveforms. Notice that your
waveform selection applies only to whichever ®M path configuration
you have currently selected.

Default Value: Sine
Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Waveform

This softkey is one of the choices in the ®M Sweep Trigger menu. With
Bus selected, you use the GPIB to trigger single sweeps of swept-sine
phase modulation.

Softkey Location: FM/oM hardkey > FM oM softkey oM > ®M Waveform >
Swept-Sine > ®M Sweep Trigger > Bus

DCFM/DC®M Cal

Dual-Sine

Ext

Pressing this softkey initiates a DC®M calibration. This calibration
eliminates the offset in DC phase modulation so that the carrier phase
remains the same with no modulation applied. External, DC-coupled
®M must be active when this command is executed.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > DCFM/DC®M Cal

Pressing this softkey reveals a menu of choices for setting the dual-sine
phase modulation parameters. In this menu you can set the ®M rates
for two separate tones. In addition you can set a ratio of the tone 2 ®M
deviation to the tone 1 ®M deviation.

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Dual-Sine

This softkey is one of the choices in the ®M Sweep Trigger menu.
Choosing Ext allows you to trigger swept-sine phase modulation using a
signal applied to the TRIGGER IN rear panel connector. Set the
polarity of the trigger signal using the Trigger In Polarity Neg Pos softkey.

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Swept-Sine > ®M Sweep Trigger > Ext
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Ext 1 AC-Coupled

This softkey lets you input an external, AC-coupled, phase modulation
signal to the EXT 1 INPUT connector. The modulation signal is tested

for voltage and a display annunciator will report a high or low condition
if the voltage is > +3% of 1 Vpk.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in an amplitude modulation configuration for AM Path 1, and then
you configured oM Path 2 to also use the external 1 input, the signal
generator would turn off AM Path 1 and assign the external 1 input to
your ®M Path 2 configuration. For the purposes of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
source.

Softkey Location: FMm/oM hardkey > FM oM softkey ®M > &M Source >
Ext 1 AC-Coupled

Ext 1 DC-Coupled

This softkey lets you input an external, DC-coupled, phase modulation
signal to the EXT 1 INPUT connector.

The external 1 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 1
input in an amplitude modulation configuration for AM Path 1, and then
you configured ®M Path 2 to also use the external 1 input, the signal
generator would turn off AM Path 1 and assign the external 1 input to
your ®M Path 2 configuration. For the purposes of this discussion, the
external 1 AC-coupled input is the same as the external 1 DC-coupled
source.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Source >
Ext 1 DC-Coupled
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Phase Modulation

Ext 2 AC-Coupled

This softkey lets you input an external, AC-coupled, phase modulation
signal to the EXT 2 INPUT connector. The modulation signal is tested

for voltage and a display annunciator will report a high or low condition
if the voltage is > +3% of 1 Vpk.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in an amplitude modulation configuration for AM Path 1, and then
you configured @M Path 2 to also use the external 2 input, the signal
generator would turn off AM Path 1 and assign the external 2 input to
your ®M Path 2 configuration. For the purposes of this discussion, the
external 2 AC-coupled input is the same as the external 2 DC-coupled
source.

Softkey Location: FM/oM hardkey > FM ®M softkey oM > &M Source >
Ext 2 AC-Coupled

Ext 2 DC-Coupled

This softkey lets you input an external, DC-coupled, phase modulation
signal to the EXT 2 INPUT connector.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the external 2
input in an amplitude modulation configuration for AM Path 1, and then
you configured oM Path 2 to also use the external 2 input, the signal
generator would turn off AM Path 1 and assign the external 2 input to
your oM Path 2 configuration. For the purposes of this discussion, the
external 2 AC-coupled input is the same as the external 2 DC-coupled
source.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > ®M Source >
Ext 2 DC-Coupled

FM ®M Normal High BW

This softkey toggles between the menus for FM, normal ®M, and
wideband ®M. Normal ®M lets you set the phase deviation as highas N
X 90 radians with a 3 dB bandwidth of 100 kHz. Wideband ®M provides
increased bandwidth while restricting the maximum deviation to
deviation settings up to 172 radians (90°). The modulation bandwidth is
typically 6 MHz. For deviation settings between 172 and 2mt radians
(360°), the modulation bandwidth is typically 1.5 MHz. (These
increased bandwidths are only available using ®M Path 1. ®M Path 2 is
limited to 1 MHz.)

Default Value: FM

Softkey Location: FM/&M hardkey > FM oM softkey once for normal
bandwidth or twice for high bandwidth
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Immediate

Internal

Noise

Sine

Phase Modulation

This softkey is one of the choices in the ®M Sweep Trigger menu.
Choosing Immediate immediately triggers swept-sine phase modulation
in a continuous mode. To stop the sweep, choose a different trigger such
as Ext, or set the waveform to something other than Swept-Sine.

Softkey Location: FM/oM hardkey > FM ®M softkey ®M > &M Waveform >
Swept-Sine > ®M Sweep Trigger > Immediate

This softkey lets you internally generate an AC-coupled, phase
modulation signal.

The internal source has multiple uses but can be used for only one
modulation at a time. If, for example, you were using the internal
source in an amplitude modulation configuration for AM Path 1, and then
you configured oM Path 2 to also use the internal source, the signal
generator would turn off AM Path 1 and assign the internal source to your
®M Path 2 configuration.

Softkey Location: FM/oM hardkey > FM ®M softkey oM > oM Source >
Internal

This softkey lets you specify noise as the phase modulation waveform
for the oM Path 1 and oM Path 2 configurations. Notice that the selected
waveform applies only to whichever ®M path configuration you have
currently selected.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > oM Waveform >
Noise

This softkey lets you specify sine as the phase modulation waveform for
the ®M Path 1 and oM Path 2 configurations. Notice that the selected
waveform applies only to whichever ®M path configuration you have
currently selected.

Softkey Location: FM/oM hardkey > FM oM softkey ©M > ®M Waveform >
Sine
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Phase Modulation

Square

Swept-Sine

Triangle

This softkey lets you to specify square as the phase modulation
waveform for the oM Path 1 and &M Path 2 configurations. Notice that the
selected waveform applies only to whichever ®M path configuration you
have currently selected.

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Square

Pressing this softkey reveals a menu of choices for setting the
swept-sine phase modulation parameters. In this menu you can set the
start and stop ®M rate and the sweep time. You can set the signal
generator to a single, externally-triggered sweep on either a negative or
positive TTL level or you can choose continuous sweep, triggered
immediately. In this menu you can also select either a positive or
negative polarity for the TRIGGER OUT signal.

Softkey Location: FM/oM hardkey > FM oM softkey oM > &M Waveform >
Swept-Sine

Specifies triangle as the frequency modulation waveform for the

®M Path 1 and oM Path 2 configurations. Notice that the selected
waveform applies only to whichever ®M path configuration you have
currently selected.

Softkey Location: FM/oM hardkey > FM ®M softkey oM > oM Waveform >
Triangle

Trigger In Polarity Neg Pos

Toggles between a negative TTL level trigger (0 V) and a positive TTL
level trigger (+5 V) for externally triggering swept-sine phase
modulation.

This softkey is coupled to the Trigger In Polarity Neg Pos softkey for
swept-sine AM, FM, and LF Out, and to the Ext Neg and Ext Pos sweep
trigger selections in the Sweep/List Menu. If you set the

Trigger In Polarity Neg Pos softkey in the ®M Swept-Sine Menu to Neg, the
Trigger In Polarity Neg Pos softkey is also set to Neg for swept-sine AM, FM,
and LF Out. And, in addition, if the step or list sweep trigger is set to
Ext Pos, the trigger selection will automatically be changed to Ext Neg.
The same softkeys will toggle to Pos or to Ext Pos if you select Pos in the
Swept-Sine ®M Menu.
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Trigger Key

Phase Modulation

Conversely, if the Trigger In Slope Neg Pos softkey is toggled in the
swept-sine AM, FM, or LF Out menus, it will cause the swept-sine ®M
softkey to toggle also. This is also true for the Ext Neg and Ext Pos step or
list sweep trigger selections.

Default Value: Pos

Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Waveform >
Swept-Sine > ®M Sweep Trigger > Ext > Trigger In Polarity Neg Pos

This softkey is one of the choices in the ®M Sweep Trigger menu. With
Trigger Key selected, when you press the Trigger front panel key you
immediately trigger a single sweep of swept-sine phase modulation.

The Trigger key has autorepeat capability. Hold it down and you will
repeatedly trigger sweeps until you release the key.

Softkey Location: FM/oM hardkey > FM oM softkey ®M > &M Waveform >
Swept-Sine > ®M Sweep Trigger > Trigger Key

Trigger Out Polarity Neg Pos

This softkey toggles the polarity of the TTL signal that is output at the
rear panel TRIGGER OUT connector. When Trigger Out Polarity Neg Pos is
set to Pos, the output signal is asserted high (+5 V) at the start of the
swept-sine phase modulation sweep and low (0 V) when the sweep is
concluded. Setting Trigger Out Polarity Neg Pos t0 Neg reverses the polarity,
where a highis 0V and a low is +5 V.

This softkey is coupled to the Trigger Out Polarity Neg Pos softkey in the
swept-sine AM, FM, and LF Out menus and the sweep/list menu. When
the polarity is toggled for this softkey in any one of these menus, it
affects all locations of the softkey.

Default Value: Pos

Softkey Location: FM/oM hardkey > FM oM softkey ©M > ®M Waveform >
Swept-Sine > Trigger Out Polarity Neg Pos
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Power Switch
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Pressing this front panel key toggles power to the signal generator
either on (green LED on) or to standby (yellow LED on). In standby
mode, the power switch is off but the instrument is still connected to the
mains circuit by way of the power cord. The detachable power cord is
the instrument disconnecting device. The front panel power switch,
therefore, is not, and should not be used as, a line switch.

CAUTION Avoid turning off power to the signal generator unless it is quiescent
(not currently changing state as a result of front panel operation or
remote control).
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This key sets the signal generator to a known state (either the
factory-defined state or a user-defined state).

Use the Preset Normal User softkey to set your signal generator to the
desired preset conditions (Normal = factory, User = a user-defined state).

For details, refer to the Preset Normal User softkey description on page
4-129.
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Pulse

Pulse

Pressing the front panel Pulse key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

N VENUS I

Mode J AM } Utility } Freq }

FM/ } Pulse Sweep/} Ampl }

oM List
fLFout

pk730a

Ext2 DC-Coupled

This softkey lets you input an external, DC-coupled, pulse modulation
signal to the EXT 2 INPUT connector.

The external 2 input has multiple uses but can be used for only one
modulation at a time. If, for example you were using the external 2
input in a frequency modulation configuration for FM Path 1, and then
you configured the pulse modulation source to also use the external 2
input, the signal generator would turn off FM Path 1 and assign the
external 2 input to your pulse configuration.

Softkey Location: Pulse > Pulse Source > Ext2 DC-Coupled

Fast Pulse Off On

This softkey enables fast pulse modulation from an external,
TTL-compatible pulse source via the PULSE IN BNC connector. Notice,
however, that although you can enable the fast pulse modulation state
with this softkey, the RF carrier is modulated by the pulse signal only
when you have also set Mod On/Off to On. Whenever fast pulse
modulation is enabled, the PULSE annunciator is turned on in the
display.

Default Value: Off

Softkey Location: Pulse > Fast Pulse Off On
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Internal Pulse

This softkey lets you internally generate rectangular pulse modulation.
Configure the pulse modulation using the Pulse Period and Pulse Width
softkeys. For additional specifications, refer to the technical
specifications document.

The internal source has multiple uses but can be used for only one
modulation at a time. If, for example you were using the internal source
in a frequency modulation configuration for FM Path 1, and then you
configured the pulse modulation source to also use the internal source,
the signal generator would turn off FM Path 1 and assign the internal
source to your pulse configuration.

Softkey Location: Pulse > Pulse Source > Internal Pulse

Internal Square

This softkey lets you internally generate squarewave pulse modulation.
The duty cycle is set at 50% and you can set the pulse rate from 0.1 Hz
to 50 kHz. For additional specifications, refer to the technical
specifications document.

The internal source has multiple uses but can be used for only one
modulation at a time. If, for example you were using the internal source
in a frequency modulation configuration for FM Path 1, and then you
configured the pulse modulation source to also use the internal source,
the signal generator would turn off FM Path 1 and assign the internal
source to your pulse configuration.

Softkey Location: Pulse > Pulse Source > Internal Square

Pulse Off On

This softkey enables the pulse modulation for whichever pulse source
you have selected. Notice, however, that although you can enable the
pulse modulation state with this softkey, the RF carrier is modulated by
the enabled modulation only when you have also set Mod On/Off to On.
Whenever pulse modulation is enabled, the PULSE annunciator is
turned on in the display.

Default Value: Off

Softkey Location: Pulse > Pulse Off On
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Pulse

Pulse Period

Pulse Rate

Pulse Source

Use this softkey to change the pulse period for internal pulse
modulation. To change the period, press the softkey once. The current
value for pulse period is displayed in the active entry area. To enter a
new value, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the msec or psec terminator softkey. The
range of values allowed is 16 ps to 30 s. If the value for pulse period is
less than the value for pulse width, pulse width is changed to the same
value as pulse period. Notice that pulse period applies only to internal
pulse modulation; when external pulse modulation or internal square
pulse modulation is selected, this softkey is disabled.

Default Value: 80 us

Softkey Location: Pulse > Pulse Period

Use this softkey to change the pulse rate for internal square pulse
modulation. To change the rate, press the softkey once. The current
value for pulse rate is displayed in the active entry area. To enter a new
value, rotate the front panel knob until the desired value is displayed,
use the up and down arrow keys, or enter the value using the numeric
keypad and press the Hz or kHz terminator softkey. The range of values
allowed is 0.1 Hz to 50 kHz. Notice that the new value of pulse rate
applies only to internal square pulse modulation; when external pulse
modulation or internal pulse modulation is selected, this softkey is
disabled.

Default Value: 400 Hz

Softkey Location: Pulse > Pulse Rate

Pressing this softkey reveals a menu of choices for pulse modulation
sources. You can choose internally-generated pulse modulation,
internally-generated square pulse modulation, or select an
externally-applied, DC-coupled signal from the EXT 2 INPUT connector.

The internal and external 2 sources have multiple uses. However, you
can use each source for only one modulation type at a time. If, for
example, you were using the external 2 source in a frequency
modulation configuration for FM Path 1, and then you configured the
pulse modulation source to also use the external 2 source, the signal
generator would turn off FM Path 1 and assign the external 2 source to
your pulse configuration.

Default Value: Internal Pulse

Softkey Location: Pulse > Pulse Source
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Pulse Width

Pulse

Use this softkey to change the pulse width for internal pulse
modulation. To change the pulse width, press the softkey once. The
current value for pulse width is displayed in the active entry area. To
enter a new value, rotate the front panel knob until the desired value is
displayed, use the up and down arrow keys, or enter the value using the
numeric keypad and press the psec or msec terminator softkey. The
range of values allowed is 8 ps to 30 s. Notice that the new value of
pulse width applies only to internal pulse modulation; when external
pulse modulation or internal square pulse modulation is selected, this
softkey is disabled.

Default Value: 40 ps

Softkey Location: Pulse > Pulse Source > Internal Square > Pulse Width
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Recall

Recall

Pressing the front panel Recall key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

w
pk752a

Delete All Regs in Seq [n]

NOTE

Press this softkey to delete the data saved in all of the registers of the
selected sequence. Do not press this softkey until you have selected the
correct sequence using the softkey. For example, if you want to delete
the data in all of the registers that are saved in sequence 4, press
Select Seq. The currently selected sequence is displayed in the active
entry area. Change the number to 4 using the up and down arrow keys,
the front panel knob, or enter a 4 using the numeric keypad and press
the Enter terminator softkey. Sequence 4 is now displayed in all softkeys
which specify a sequence in this menu. Now press Delete All Regs in Seq [4]
and the data in all of the registers stored in sequence 4 will be deleted.
Be certain that you want to delete this data; you cannot recover it once
deleted.

This softkey has exactly the same function as the softkey with the
identical name in the front panel save key menu.

Softkey Location: Recall > Delete All Regs in Seq[n]

Delete All Sequences

NOTE

Press this softkey to delete all of the data in all saved registers of all
sequences. Be certain that you want to delete the data; you cannot
recover it once deleted.

This softkey has exactly the same function as the softkey with the
identical name in the front panel save key menu.

Softkey Location: Recall > Delete All Sequences
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Recall

Delete Seq[n] Reg[nn]

NOTE

Recall Reg

Press this softkey to delete the contents of a specified register in a
specified sequence. Do not press this softkey until you have selected the
correct sequence and register using the Select Seq and Recall Reg
softkeys. For example, if you want to delete the contents of register 5 in
sequence 4, press Select Seq. The currently selected sequence is
displayed in the active entry area. Change the number to 4 using the up
and down arrow keys, the front panel knob, or enter a 4 using the
numeric keypad and press the Enter terminator softkey. Sequence 4 is
now displayed in all softkeys which specify a sequence in this menu.
Now select register 5. (Remember, you must first have saved an
instrument state to this register in sequence 4.) Press Recall Reg. The
recall register number becomes the active function. Enter the number 5
using the numeric keypad and press the Enter terminator softkey. The
instrument state is restored from this register and register 5 is now
displayed in all softkeys which specify a register number in this menu.
Now press Delete Seq [4] Reg[05] and register 5, stored in sequence 4, will
be deleted. The instrument state that you had recalled from this
register remains, however, until you change it. If you deleted this
register in error, you can immediately resave it using the

Save Seq[n] Reg[n] softkey in the Save menu.

This softkey has exactly the same function as the softkey with the
identical name in the front panel save key menu.

Softkey Location: Recall > Delete Seq[n] Reg[nn]

Press this softkey to recall an instrument state from a saved register.
Recalling a register also selects that register number for all softkeys
which specify a register number in this menu. For example, if you want
to select register 5, press Recall Reg. (Remember, you must first have
saved an instrument state to this register in the current sequence
identified by the Select Seq softkey. If there is nothing saved, you cannot
recall it.) The recall register number becomes the active function. Enter
the number 5 using the numeric keypad and press the Enter terminator
softkey. The instrument state is restored from this register and register
5 is now displayed in all softkeys which specify a register in this menu.
You can also use the front panel knob and the up and down arrow keys
to scroll through all saved registers for the selected sequence, recalling
each instrument state.

Softkey Location: Recall > Recall Reg
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Recall

Select Seq

NOTE

Press this softkey to choose a sequence for all softkeys which specify a
sequence in this menu. For example, if you want to select sequence 4,
press Select Seq. The currently selected sequence is displayed in the
active entry area. Change the number to 4 using the up and down
arrow keys, the front panel knob, or enter a 4 using the numeric keypad
and press the Enter terminator softkey. Sequence 4 is now displayed in
all softkeys which specify a sequence in this menu. There are 100
registers available (0 through 99) in each of 10 (0 through 9) sequences.
You can use these registers in any combination so long as the total
number of registers used does not exceed 50.

The actual number of states that can be saved may be less if the user
file system has non-instrument state files stored such as sweep/list
sequences or binary files.

Softkey Location: Recall > Select Seq
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Return

Return
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This front panel hardkey moves you from your current softkey menu to
the softkey menu that precedes it. For example, press the LF out front
panel hardkey. The LF Out menu is displayed. Now press the LF Out
Source softkey. (The arrow indicates that pressing this softkey will
display another menu.) You should now see the LF Out Source menu.
Press Return, and you are moved back to the LF Out menu.

When you are at the top level of the menus the Return key has no
function.

The Return key has autorepeat capability. Hold it down and you are
moved repeatedly back through the menus until you either release the
key or you reach the top level of the menus.

While you are entering data with the numeric keypad, pressing the
Return key cancels the data input and leaves the original value
unchanged.
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RF On/Off
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This front panel hardkey toggles the RF signal on and off at the

RF OUTPUT connector. Although you can configure and engage various
modulations, no signal is available at the RF OUTPUT connector until
RF On/Off is set to on. An annunciator is always turned on in the display
to indicate whether RF is turned on or off.

Default Value: RF Off
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Save

Save

Pressing the front panel save key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

'iﬁiﬁii 'iiﬁill
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When you press the save key, the text area of the display shows the
registers in use and any comments associated with the registers for the
last sequence accessed. The display is updated whenever you make any
changes to the registers or to the comments.

Add Comment To Seq[n] Reg[nn]

Press this softkey to add a comment that is associated with a register in
use. The register number is listed in the text area of the display and the
comment is shown immediately following the register. You can use the
comment line, for example, to identify the instrument state saved in a
register.

The comment line can consist of up to 55 alpha-numeric characters and
special characters. To add or change a comment, the following editing
capabilities are provided:

= The Editing Mode Insert Replace softkey in the Editing Keys menu
toggles the editing mode from inserting text to replacing text.
Insertion mode causes text to be entered in the position directly to
the right of the cursor. Replacement mode causes the text to be
entered in the position held by the cursor (replacing any existing
text in that position).

= The Clear Text softkey in the Editing Keys menu deletes all of the
existing text in the active entry area.

= Use the left and right arrow keys to position the cursor. Use the front
panel knob, up and down arrow keys, or the direct editing softkeys,
to enter an alphabetic character, numeral, or special character.

When you have entered the comment text, press the Enter terminator
softkey. If you have changed your mind, press the Return hardkey. Once
you press Enter, the new comment is saved to your selected register and
displayed immediately.

Softkey Location: Save > Add Comment To Seq[n] Reg[nn]
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Clear Text

Press this softkey to delete the comment text in the active entry area. If
you want to change the comment text saved with a register, use this
softkey to quickly delete the existing text, then use the remaining
editing features to enter a new comment.

Softkey Location: Save > Add Comment To Seq[n] Reg[nn] > Editing Keys >
Clear Text

Delete All Regs in Seq [n]

Press this softkey to delete the data saved in all of the registers of the
selected sequence. Do not press this softkey until you have selected the
correct sequence using the select Seq softkey. For example, if you want to
delete all of the registers that are saved in sequence 4, press Select Seq.
The currently selected sequence is displayed in the active entry area.
Change the number to 4 using the up and down arrow keys, the front
panel knob, or enter a 4 using the numeric keypad and press the Enter
terminator softkey. Sequence 4 is now displayed in all softkeys which
specify a sequence in this menu. Now press Delete All Regs in Seq [4] and
the data in all of the registers stored in sequence 4 will be deleted. Be
certain that you want to delete the data; you cannot recover it once
deleted.

NOTE This softkey has exactly the same function as the softkey with the
identical name in the front panel Recall key menu.

Softkey Location: Save > Delete All Regs in Seq [n]

Delete All Sequences

Press this softkey to delete all of the data in all saved registers of all
sequences. Be certain that you want to delete the data; you cannot
recover it once deleted.

NOTE This softkey has exactly the same function as the softkey with the
identical name in the front panel Recall key menu.

Softkey Location: Save > Delete All Sequences
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Save

Delete Seq[n] Reg[nn]

NOTE

Editing Keys

Press this softkey to delete the contents of a specified register in a
specified sequence. Do not press this softkey until you have selected the
correct sequence and register using the Select Seq and Select Reg
softkeys. For example, if you want to delete register 5 in sequence 4,
press Select Seq. The currently selected sequence is displayed in the
active entry area. Change the number to 4 using the up and down
arrow keys, the front panel knob, or enter a 4 using the numeric keypad
and press the Enter terminator softkey. Sequence 4 is now displayed in
all softkeys which specify a sequence number in this menu. Now, to
select register 5, press Select Reg. The currently selected register is
displayed in the active entry area. Change the number to 5 in the same
way that you changed the sequence number. Register 5 is now displayed
in all softkeys which specify a register number in this menu. Now press
Delete Seq [4] Reg[05] and register 5, stored in sequence 4, will be deleted.
Be certain that you want to delete the data; you cannot recover the data
once deleted.

This softkey has exactly the same function as the softkey with the
identical name in the front panel Recall key menu.

Softkey Location: Save > Delete Seq[n] Reg[nn]

Pressing this softkey reveals a menu of choices for creating and editing
the comment text for the selected register. In this menu you can delete
the existing text in the active entry area (either the existing comment,
or comment text that you have subsequently entered), and you can
toggle the editing mode from inserting text to replacing text.

Softkey Location: Save > Add Comment To Seq[n] Reg[nn] > Editing Keys

Editing Mode Insert Replace

Press this softkey to toggle the editing mode from inserting text to
replacing text. Insertion mode causes text to be entered in the position
directly to the right of the cursor. Replacement mode causes the text to
be entered in the position held by the cursor (replacing any existing text
in that position).

Softkey Location: Save > Add Comment To Seq[n] Reg[nn] > Editing Keys >
Editing Mode Insert Replace
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Save

Save Seq[n] Reg[nn]

Select Reg

Press this softkey to save the current instrument state in the specified
register and sequence. The instrument state includes all of your setup
selections except list and step sweep data and functions which are
identified in this manual as persistent states. Do not press this softkey
until you have specified the correct sequence and register using the
Select Seq and Select Reg softkeys. For example, if you want to save to
register 5 in sequence 4, press Select Seq. The currently selected
sequence is displayed in the active entry area. Change the number to 4
using the up and down arrow keys, the front panel knob, or enter a 4
using the numeric keypad and press the Enter terminator softkey.
Sequence 4 is now displayed in all softkeys which specify a sequence in
this menu. Now, to select register 5, press Select Reg. The currently
selected register is displayed in the active entry area. Change the
number to 5 in the same way that you changed the sequence number.
Register 5 is now displayed in all softkeys which specify a register in
this menu. Now press Save Seq [4] Reg[05] and the current instrument
state will be stored in register 5 of sequence 4. There are 100 registers
available (0 through 99) in each of 10 (0 through 9) sequences. You can
use these registers in any combination so long as the total number of
registers used does not exceed 100.

Softkey Location: Save > Save Seq[n] Reg[nn]

Press this softkey to choose a register for all softkeys which specify a
register in this menu. For example, if you want to select register 5,
press Select Reg. The currently selected register is displayed in the
active entry area. Change the number to 5 using the up and down
arrow keys, the front panel knob, or enter a 5 using the numeric keypad
and press the Select Reg terminator softkey. Register 5 is now displayed
in all softkeys which specify a register in this menu.

You can also use this softkey to select a register and save the current
instrument state to that register. For example, if you want to select and
save to register 6, press Select Reg. The currently selected register is
displayed in the active entry area. Change the number to 6 using the
numeric keypad and press the save Reg terminator softkey. Register 6 is
now displayed in all softkeys which specify a register in this menu and
the current instrument state has been saved to register 6.

There are 100 registers available (0 through 99) in each of 10 (0 through
9) sequences. You can use these registers in any combination so long as
the total number of registers used does not exceed 100.

Softkey Location: Save > Select Reg
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Select Seq

NOTE

Save

Press this softkey to choose a sequence for all softkeys which specify a
sequence in this menu. For example, if you want to select sequence 4,
press Select Seq. The currently selected sequence is displayed in the
active entry area. Change the number to 4 using the up and down
arrow keys, the front panel knob, or enter a 4 using the numeric keypad
and press the Enter terminator softkey. Sequence 4 is now displayed in
all softkeys which specify a sequence in this menu.

There are 100 registers available (0 through 99) in each of 10 (0 through
9) sequences. You can use these registers in any combination so long as
the total number of registers used does not exceed 100.

The actual number of states that can be saved may be less if the user
file system has non-instrument state files stored such as sweep/list
sequences or binary files.

Softkey Location: Save > Select Seq
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SweeplList

Sweep/List

# Points

Ampl

ESG Family Signal Generators

Pressing the front panel sweep/List key reveals a menu of softkeys.
Using these softkeys you can define a series of points containing
frequency, amplitude, and dwell time information for the signal
generator to sweep. The softkeys are described in this section in
alphabetical order.

NN VENUS I

[Mode

[AM

[Utility

[Freq

[FM/
oM

{Pulse

Sweep/
List

{Ampl

IQ ‘ LF Out

pk731a

Press this softkey to define the number of points in a step sweep. To
enter the number of points in the sweep, press # Points. The number of
step sweep points becomes the active function and the current value is
shown in the active entry area. To enter a new value, rotate the front
panel knob until the desired value is displayed, use the up and down
arrow keys, or enter the value using the numeric keypad and press the
Enter terminator softkey. A step sweep must always have a minimum of
2 points and can be configured to have as many as 401 points.

Default Value: 2

Softkey Location: Sweep/List > Configure Step Sweep > # Points

Press this softkey to set the signal generator to sweep amplitude data
only. The frequency is set at a constant value determined by the
Frequency front panel key. You can define a sweep containing both
amplitude and frequency information and still choose to sweep
amplitude only.

Softkey Location: Sweep/List > Sweep > Ampl
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Ampl Start

Ampl Stop

Bus

Sweepl/List

Sets the amplitude of the first point in the sweep. You can set the value
anywhere in the range of the signal generator’s specified output power.
Press Ampl start and amplitude becomes the active function for the first
point in the sweep. To enter the value, rotate the front panel knob until
the desired value is displayed, use the up and down arrow keys, or enter
the value using the numeric keypad and press the dBm, dBuV, dBuVemf,
mV, uV, mVemf, or uVemf terminator softkey.

Default Value: —-135 dBm

Softkey Location: Sweep/List > Configure Step Sweep > Ampl Start

Sets the amplitude of the last point in the sweep. You can set the value
anywhere in the range of the signal generator’s specified output power.
Press Ampl Stop and amplitude becomes the active function for the last
point in the sweep. To enter the value, rotate the front panel knob until
the desired value is displayed, use the up and down arrow keys, or enter
the value using the numeric keypad and press the dBm, dBuV, dBuVemf,
mV, uV, mVemf, or uVemf terminator softkey.

Default Value: =135 dBm

Softkey Location: Sweep/List > Configure Step Sweep > Ampl Stop

This softkey is one of the choices in both the Sweep Trigger menu and
the Point Trigger menu. Press either the Sweep Trigger softkey or the
Point Trigger softkey to view these menus. Choosing Bus in the Sweep
Trigger menu allows you to trigger a list or step sweep using the GPIB.
Choosing Bus in the Point Trigger menu allows you to trigger a sweep
point-by-point using the GPIB via *TRG or the GET line (Group
Execute Trigger).

Softkey Location: Sweep/List > Sweep Trigger > Bus

Or: Sweep/List > Point Trigger > Bus

Configure List Sweep

Reveals a menu of softkeys for defining a list sweep. In this menu you
can insert and delete points in a sweep. Each point can contain
frequency, amplitude, and dwell time information. The list point
information is stored in three binary files: FREQ_FILE, POW_FILE,
and DWEL_FILE. These files will survive a preset but not a power
cycle. If they are deleted, the signal generator will recreate these files
as needed. In this menu you can also edit existing points in the sweep.

Softkey Location: Sweep/List > Configure List Sweep
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SweeplList

Configure Step Sweep

Delete File

Delete Item

Delete Row

Pressing this softkey reveals a menu of softkeys for defining a step
sweep. In this menu you can set the start and stop frequencies for a
sweep, set the start and stop power levels, and you can set the number
of points in the sweep with the dwell time at each point.

Softkey Location: Sweep/List > Configure Step Sweep

Press this softkey to delete a file in the catalog listing. Use the up and
down arrow keys until the file you wish to delete is highlighted. Press
Delete File and then press the Confirm Delete softkey. Be certain that you
want to delete the file; you cannot recover this sweep data once you
press Confirm Delete. If you do not want to delete the file, press Return
instead of Confirm Delete.

Softkey Location: Sweep/List > Configure List Sweep > Load/Store > Delete File

Press this softkey to delete an item in the displayed list of sweep points.
Use the arrow keys until the desired item is highlighted. Then press
Delete Item to eliminate this item from the sweep list. Be certain that you
want to delete this item; you cannot recover it once you have deleted it.
If the last item in a list is deleted, it is replaced by the default value.

Softkey Location: Sweep/List > Configure List Sweep > Delete Item

Press this softkey to delete a selected row in the sweep list. Use the up
and down arrow keys until any item is selected in the row you wish to
delete. Press Delete Row and the entire row is deleted. Be certain that
you want to delete the row; you cannot recover this sweep data once you
press Delete Row. If the last row in a list is deleted, it is replaced by the
default value.

Softkey Location: Sweep/List > Configure List Sweep > Delete Row
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Sweepl/List

Dwell Type List Step

Edit Item

Ext

Freq

Press this softkey to toggle the dwell time for the list sweep points
between the values defined in the list sweep and the value set for step
sweep. Choose List to sweep with dwell times that you have defined in
the list sweep. Choose step and you will sweep each point in the list
with a dwell time set by the step Dwell softkey in the Configure Step
Sweep menu. When you are sweeping using the step sweep dwell time,
the list sweep dwell time values are grayed out to indicate that they are
not being used.

Default Value: List

Softkey Location: Sweep/List > Configure List Sweep > Dwell Type List Step

Press this softkey to change an item in the displayed list of sweep points.
Use the arrow keys or the front panel knob until the correct item is
highlighted. Press Edit item and the item is displayed in the active entry
area. Change the value using the up and down arrow keys, or the front
panel knob and press the Enter terminator softkey. Or enter a new value
using the numeric keypad and then press a units terminator softkey.

A short cut for editing, Auto Edit, is also available. Highlight the item
you want to edit. Enter a new value using the numeric keys; editing
immediately starts for the highlighted item. Press the Enter terminator
softkey. The new value is stored and the next item is highlighted.

Softkey Location: Sweep/List > Configure List Sweep > Edit Item

This softkey is one of the choices in both the Sweep Trigger menu and
the Point Trigger menu. Press either the Sweep Trigger softkey or the
Point Trigger softkey to view this key. Choosing Ext allows you to trigger a
sweep point-by-point on either the negative or positive edge of a signal
applied to the TRIGGER IN rear panel connector. Set the polarity of the
trigger signal using the Trigger In Polarity Neg Pos softkey.

Softkey Location: Sweep/List > Sweep Trigger > Ext

Or: Sweep/List > Point Trigger > Ext

Press this softkey to set the signal generator to sweep frequency data
only. The amplitude is set at a constant level determined by the
Amplitude front panel key. You can define a sweep containing both
amplitude and frequency information and still choose to sweep
frequency only.

Softkey Location: Sweep/List > Sweep > Freq
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SweeplList

Freg&Ampl

Freq Start

Freq Stop

Goto Bottom

Press this softkey to set the signal generator to sweep both frequency
and amplitude data. Both the frequency and the amplitude lists must
have the same number of points or they must have only one point. If a
list has only one point, then that point is used for each of the other list's
points.

Softkey Location: Sweep/List > Sweep > Freq&Ampl

Press this softkey to set the frequency of the first point in the sweep.
You can set the value anywhere in the range of the signal generator’s
specified output frequency. Press Freq Start and frequency becomes the
active function for the first point in the sweep. To enter the value, rotate
the front panel knob until the desired value is displayed, use the up and
down arrow keys, or enter the value using the numeric keypad and
press the GHz, MHz, kHz, or Hz terminator softkey.

Default Value: Maximum specified frequency

Softkey Location: Sweep/List > Configure Step Sweep > Freq Start

Press this softkey to set the frequency of the last point in the sweep.
You can set the value anywhere in the range of the signal generator’s
specified output frequency. Press Freq Stop and frequency becomes the
active function for the last point in the sweep. To enter the value, rotate
the front panel knob until the desired value is displayed, use the up and
down arrow keys, or enter the value using the numeric keypad and
press the GHz, MHz, kHz, or Hz terminator softkey.

Default Value: Maximum specified frequency

Softkey Location: Sweep/List > Configure Step Sweep > Freq Stop

Row

Press this softkey to move the selection bar to the bottom row of list
sweep points when you are in the Goto Row menu that is accessed from
the Configure List Sweep menu. If you are in the Goto Row menu that
is accessed from the Load/Store menu, the selection bar moves to the
bottom row of the catalog of list files.

Softkey Location: Sweep/List > Configure List Sweep > Goto Row >
Goto Bottom Row

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row >
Goto Bottom Row
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Sweepl/List

Goto Middle Row

Goto Row

Press this softkey to move the selection bar to the middle row of list
sweep points when you are in the Goto Row menu that is accessed from
the Configure List Sweep menu. If you are in the Goto Row menu that
is accessed from the Load/Store menu, the selection bar moves to the
middle row of the catalog of list files.

Softkey Location: Sweep/List >Configure List Sweep > Goto Row >
Goto Middle Row

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row >
Goto Middle Row

Pressing this softkey reveals a menu of softkeys that help you move the
selection bar through the rows of list sweep points when you are in the
Configure List Sweep menu. If you are in the Load/Store menu, the
softkeys help you move the selection bar through the catalog of list files.
You can also go to a specific row by rotating the front panel knob, using
the up and down arrow keys, or entering the row number with the
numeric keypad. Once the desired row number is displayed, press the
Enter terminator softkey.

Softkey Location: Sweep/List > Configure List Sweep > Goto Row

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row

Goto Top Row

Press this softkey to move the selection bar to the top row of list sweep
points when you are in the Goto Row menu that is accessed from the
Configure List Sweep menu. If you are in the Goto Row menu that is
accessed from the Load/Store menu, the selection bar moves to the top
row of the catalog of list files.

Softkey Location: Sweep/List > Configure List Sweep > Goto Row >
Goto Top Row

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row > Goto Top Row
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SweeplList

Immediate

Insert Item

Insert Row

This softkey is one of the choices in both the Sweep Trigger menu and
the Point Trigger menu. Press either the sweep Trigger softkey or the
Point Trigger softkey to view these menus. Choosing Immediate in the
Sweep Trigger menu immediately triggers the current sweep when you
press the Single Sweep softkey. When sweep repeat is continuous and
Immediate is chosen for the sweep trigger, then sweeps are triggered
consecutively (a new sweep is triggered as soon as the current sweep
ends). Choosing Immediate in the Point Trigger menu causes the sweep to
pause for the dwell time at each point after the hardware has been set
up for that point’s frequency and amplitude.

Softkey Location: Sweep/List > Sweep Trigger > Immediate

Or: Sweep/List > Point Trigger > Immediate

Press this softkey to place a copy of the selected item directly below that
item in the sweep list. First use the up and down arrow keys until the
item you wish to copy is selected. Press Insert Item and an identical copy
of the selected item is placed below it.

Softkey Location: Sweep/List > Configure List Sweep > Insert Item

Press this softkey to place a copy of the selected row directly below that
row in the sweep list. First use the up and down arrow keys until any
item is selected in the row you wish to copy. Press Insert Row and an
identical copy of the selected row is placed below it.

Softkey Location: Sweep/List > Configure List Sweep > Insert Row

Load From Selected File

Press this softkey to load the list sweep data from a file into the current
sweep list. Use the arrow keys to highlight the desired sweep list file.
Press Load From Selected File and the list sweep data from the selected file
is loaded into the current list sweep. You can only have one list sweep at
a time so the existing list sweep data will be lost unless it is first stored
to a file. This softkey is inactive unless at least one list sweep data file
has been stored to memory.

Softkey Location: Sweep/List > Configure List Sweep > Load/Store >
Load From Selected File
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Sweepl/List

Load List From Step Sweep

Load/Store

Press this softkey to eliminate the existing sweep list data and replace
it with the step sweep data points. You can only have one sweep list at a
time so be certain that you wish to delete the existing list. You cannot
recover the sweep list data once you press Load List From Step Sweep.

Softkey Location: Sweep/List > Configure List Sweep >
Load List From Step Sweep

Pressing this softkey reveals a menu of choices for storing list sweep
data to a file or loading list sweep data from a file into the current
sweep list. In this menu you can also delete existing list sweep files.

Softkey Location: Sweep/List > Configure List Sweep > Load/Store

Manual Mode Off On

This softkey toggles manual selection of the current sweep point on and
off. When Manual Mode is On, the selected sweep/list point controls the
frequency and amplitude according to the sweep type. The current point
in the sweep is displayed in the active entry area and also below the
Manual Point softkey. This softkey is disabled when sSweep is set to Off.

Default Value: Off

Softkey Location: Sweep/List > Manual Mode Off On

Manual Point

Press this softkey to choose a point in the sweep list. When Manual Mode
is on, the selected sweep/list point controls the frequency and amplitude
according to the sweep type. The current point number is shown in the
active entry area when you press Manual Point. The frequency of the point
is shown in the frequency area of the display. The amplitude of the
point is shown in the amplitude area of the display. You can choose
which point to sweep using the up and down arrow keys, the front panel
knob, or by entering the point number desired using the numeric
keypad and pressing the Enter terminator softkey. This softkey is
disabled when Manual Mode Off On is set to Off.

Default Value: 1

Softkey Location: Sweep/List > Manual Point
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SweeplList

Off

Page Down

Page Up

This softkey turns off all sweep functions. The output signal is then set
according to the current frequency and amplitude settings defined by
the front panel Frequency and Amplitude keys.

Softkey Location: Sweep/List > Sweep > Off

Press this softkey to view the next page of list sweep points when you
are in the Goto Row menu that is accessed from the Configure List
Sweep menu. If you are in the Load/Store menu or the Goto Row menu
that is accessed from the Load/Store menu, you will view the next page
of the catalog of list files.

Softkey Location: Sweep/List > Configure List Sweep > Goto Row >Page Down
Or: Sweep/List > Configure List Sweep > Load/Store > Page Down

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row > Page Down

Press this softkey to view the previous page of list sweep points when
you are in the Goto Row menu that is accessed from the Configure List
Sweep menu. If you are in the Load/Store menu or the Goto Row menu
that is accessed from the Load/Store menu, you will view the previous
page of the catalog of list files.

Softkey Location: Sweep/List > Configure List Sweep > Goto Row > Page Up
Or: Sweep/List > Configure List Sweep > Load/Store > Page Up

Or: Sweep/List > Configure List Sweep > Load/Store > Goto Row > Page Up

Point Trigger

Pressing this softkey reveals a menu of choices for triggering a sweep
point-by-point. You can choose triggering that occurs after the dwell
time for the previous point has passed, triggering that is supplied by
the GPIB, triggering on either the positive or negative edge of a signal
supplied to the TRIGGER IN connector, or triggering by the front panel
Trigger key.

Default Value: Immediate

Softkey Location: Sweep/List > Point Trigger
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Preset List

Sweepl/List

Press this softkey to eliminate the current sweep list and replace it with
a new list consisting of the following: one point at the maximum
specified frequency, with an amplitude of -135 dBm, and a dwell time of
2 ms. Be certain that you want to delete the current sweep list; you
cannot recover the information once you press Preset List.

Softkey Location: Sweep/List > Configure List Sweep > Preset List

Single Sweep

Step Dwell

Store to File

NOTE

Press this softkey to arm the sweep. The ARMED annunciator will turn on
in the display. The signal generator will begin the sweep as soon as the
sweep trigger is received. If you have set the sweep trigger to Immediate,
a sweep is initiated as soon as you arm the sweep. The sweep sets the
power and the frequency to the first point of the sweep while it is not
initiated or is waiting for the sweep trigger. This softkey is disabled
when Sweep is set to Off.

Softkey Location: Sweep/List > Single Sweep

Press this softkey to set the dwell time for each point of a step sweep. To
set the dwell time, press Step Dwell. The current dwell time is displayed
in the active entry area. Enter the desired dwell time using the up and
down arrow keys, the front panel knob, or enter a value using the
numeric keypad and press the sec or msec terminator softkey. The range
of values allowed is 1 ms through 60 s in 1 ms increments. Dwell time is
used when the point trigger is Immediate. The dwell time is the amount
of time the sweep is guaranteed to pause after setting the frequency
and power for the current sweepl/list point.

Softkey Location: Sweep/List > Configure Step Sweep > Step Dwell

Press this softkey to store the current list sweep data to a file in
internal non-volatile memory. Press Store To File and you will
automatically enter the editing mode to create a file name.

The file name can consist of up to 23 alpha-numeric and special
characters. The following steps show you how to create the following
example file name, FREQ 1453 TO 1465 MHZ:

The following example uses softkeys to enter the file name. You can also
use a combination of the front panel knob and the arrow keys to
accomplish the same function.

1. Press the softkey labeled ABCDEFG. A menu is revealed containing a
softkey for each alphabetic character from A through G.
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SweeplList

Sweep

2. Press the softkey labeled F. An F is entered as the first character in
your file name. Notice that the active entry area now shows St or e
to: F.

3. Enter an R in the file name by pressing the OPQRSTU softkey and
then pressing the R softkey. Enter an E and a Q.

4. Next enter a space by pressing the & # + - [] softkey and then
pressing [] .

Enter the value 1453 using the numeric keypad.
Enter another space and the letters TO.
Enter another space and the value 1465.

Enter another space and the letters MHZ.

© ® N o O

Now press the Enter terminator softkey and the list sweep data is
saved with the file name, FREQ 1453 TO 1465 MHZ. The characters
@l ST are automatically appended to the file name as file type
identification.

Softkey Location: Sweep/List > Configure List Sweep > Load/Store >
Store To File

Pressing this softkey reveals a menu of choices for determining the
sweep parameters. In this menu you can choose to sweep frequency
only, amplitude only, or both frequency and amplitude. You can also
choose to turn off all sweep functions.

Default Value: Off

Softkey Location: Sweep/List > Sweep

Sweep Direction Down Up

This softkey changes the direction of the sweep. Choose Up to sweep
from the first point in the list to the last point, or from the step sweep
start frequency and amplitude to the stop frequency and amplitude.
Choose Down to reverse the direction of the sweep.

Default Value: Up

Softkey Location: Sweep/List > Sweep Direction Down Up

Sweep Repeat Single Cont

Toggles the sweep repetition between single sweep or continuous sweep
types. The sweep and point triggers will then trigger the sweep.

Default Value: Single

Softkey Location: Sweep/List > Sweep Repeat Single Cont
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Sweep Trigger

Reveals a menu of choices for triggering a full sweep. You can choose
triggering that occurs immediately once a sweep is armed, triggering
that is supplied by the GPIB, triggering on either the positive or
negative edge of a signal supplied to the TRIGGER IN connector, or
triggering by the front panel Trigger Key.

Default Value: Immediate

Softkey Location: Sweep/List > Sweep Trigger

Sweep Type List Step

Toggles the sweep type from list sweep to step sweep. You create a list
sweep by supplying the frequency, amplitude, and dwell time for each
point in the sweep. You create a step sweep by supplying the start and
stop frequency and amplitude, the number of points, and a dwell time.
The signal generator then calculates the points between the first and
last point in a linear manner.

Default Value: List

Softkey Location: Sweep/List > Sweep Type List Step

Trigger Key

This softkey is one of the choices in both the Sweep Trigger menu and
the Point Trigger menu. Press either the Sweep Trigger softkey or the
Point Trigger softkey to view these menus. Choosing Trigger Key in the
Sweep Trigger menu immediately triggers an armed sweep when you
press the Trigger front panel key. Choosing Trigger Key in the Point
Trigger menu immediately triggers the next point in a running sweep.

Softkey Location: Sweep/List > Sweep Trigger > Trigger Key

Or: Sweepl/List > Point Trigger > Trigger Key
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Trigger Out Polarity Neg Pos

This softkey toggles the polarity of the TTL signal that is output at the
rear panel TRIGGER OUT connector. When Trigger Out Polarity Neg Pos is
set to Pos the output signal is asserted high (+5 V) at the start of a dwell
sequence, or at the start of waiting for the point trigger, and low (0 V)
when the dwell is over, or when the point trigger is received. Setting
Trigger Out Polarity Neg Pos to Neg reverses the polarity where a highis0 V
and a low is +5 V.

This softkey is coupled to the Trigger Out Polarity Neg Pos softkey in the
swept-sine AM, FM, ®M, and LF Out menus. When the polarity is
toggled for this softkey in any one of these menus, it affects all locations
of the softkey.

Default Value: Pos

Softkey Location: Sweep/List > Trigger Out Polarity Neg Pos
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Trigger
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Press this front panel hardkey to trigger a specified event or series of
events.

= The Trigger key can start a step or list sweep under the following
conditions:

= Sweep mode is configured and turned on.
< Insingle sweep mode, the sweep is armed.

= The sweep Trigger softkey, in the Sweep/List menu, is set to
Trigger Key.

= The Trigger Key can cause the sweep to step point by point in a step or
list sweep under the following conditions:

= Sweep mode is configured and turned on.
= In single sweep mode, the sweep is armed.

= The pPoint Trigger softkey, in the Sweep/List menu, is set to
Trigger Key.

= The sweep must be triggered if Sweep Trigger is not set to Immediate.

Also, under these conditions, the Trigger key has autorepeat
capability. Hold it down and it will repeatedly trigger the consecutive
points in the sweep.

= The Trigger key can start a single sweep of swept-sine amplitude,
frequency, or phase modulation under the following conditions:

* Trigger Key is selected in the AM, FM, or ®M Sweep Trigger menu.
= Swept-sine AM, FM, or ®M is enabled.
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Trigger
Also, under these conditions, the Trigger key has autorepeat
capability. Hold it down and it will repeatedly trigger the sweep.
This has the effect of stopping the current sweep before it finishes,
when the key repeat is detected.
The Trigger Key can start an LF swept-sine output under the following
conditions:
e Function Generator is selected as the LF Out Source.
e The LF Out Sweep Trigger is set to Trigger Key.
< Swept-sine LF out is selected.
Also, under these conditions, the Trigger key has autorepeat
capability. Hold it down and it will repeatedly trigger the sweep.
This has the effect of stopping the current sweep before it finishes,
when the key repeat is detected.
With any of the digital modulation formats configured and turned
on, the Trigger Key can initiate a burst to output a frame or a data
sequence under the following conditions:
< The digital modulation format is configured and turned on.
= The Pattern Trigger Or Frame Trigger softkey in the digital modulation

menu is set to Trigger Key.
= With a bit error rate test configured and turned on, the Trigger key
can initiate a bit error rate test under the following conditions:
< The bit error rate test is configured and turned on.
« The BERT Trigger softkey in the bit error rate test menu is set to
Trigger Key.
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Utility

ARB

Utility

Pressing the front panel utility key reveals a menu of softkeys. These
softkeys are described in this section in alphabetical order.

/S VENUS I

{Mode {AM {Freq
FM/ Pulse Ampl ]
oM

Q LFout |

Press this softkey to set the current catalog type to ARB and display the
catalog of ARB files.

pk727a

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > ARB

ARB Catalog Types

Binary

Bit

Press this softkey to reveal a menu of ARB catalog type choices for
displaying files.

Softkey Location: Utility > Memory Catalog > Catalog Type > ARB Catalog Types

Press this softkey to set the current catalog type to Binary and display
the catalog of binary files.

Softkey Location: Utility > Memory Catalog > Catalog Type > Binary

Press this softkey to set the current catalog type to Bit and display the
catalog of bit files.

Softkey Location: Utility > Memory Catalog > Catalog Type > Bit
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Black Pixels Screen Test

This softkey is provided for factory use in testing the display. Pressing
this softkey sets all the pixels on the display to black. Pressing the Local
front panel key returns the display to normal signal generator operation.

Softkey Location: Utility > Display > Black Pixels Screen Test

Brightness

Use this softkey to adjust the display brightness (intensity). The display
is set to maximum brightness at the factory. To change the brightness,
press Utility > Display > Brightness. The current value shown in the active
entry area is a relative value for brightness. Increasing the number
increases the brightness; decreasing the number decreases the
brightness. You can adjust the brightness value to any number from 1
through 50. (To adjust the brightness via remote operation, set the
value from 0.02 to 1.0.) Use the front panel knob, the up and down
arrow keys, or enter a value using the numeric keypad and press the
Enter terminator softkey.

Brightness is a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: Utility > Display > Brightness

Burst Gate In Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the BURST GATE IN connector. Pos refers
to normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Burst Gate In Polarity Neg Pos

Calibrate Selected Items

Press this softkey to perform a download of calibration data from the
optional hardware into non-volatile memory. To confirm that you want
to start the calibration, press the Start Calibration and Store Results softkey.
The calibration takes several minutes. During the calibration, a
message is displayed indicating the calibration is in progress and
showing the percent complete. When the calibration is finished, the
Hardware Options menu is returned.
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Perform this calibration if you have just installed optional hardware in
your signal generator. This calibration is not intended for repeated
execution. Any further calibrations that may be required should be
performed through the 1/Q Calibration menu located in the 1/Q key
menus.

Softkey Location: Utility > Instrument Adjustments > Hardware Options >
Calibrate Selected Items

Catalog Type

Pressing this softkey reveals a menu of choices for displaying files. You
can choose to display all files or specific catalog types. When you have
made your selection, the display is updated and your choice appears
below the catalog Type softkey. For information on file and memory
management, refer to the remote data transfer guide, Chapter 4,
“Understanding Signal Generator Memory Structure.” For information
on storing and recalling files, refer to the “Using Functions,” chapter in
the user’s and programming guide of the option you are using.

Catalog type is a persistent state; it is not changed by an instrument
preset or by a power cycle.

Softkey Location: Utility > Memory Catalog > Catalog Type

CDMA

Press this softkey to set the current catalog type to CDMA and display
the catalog of CDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > CDMA

Clear Error Queue(s)

Press this softkey to delete any messages that are stored in the error
message queues. (There are separate error queues for front panel
operation and for SCPI. Pressing this softkey clears both.) You cannot
recover from this action; once the messages are deleted, they are
permanently gone. When the error message queue is empty, the ERR
annunciator is turned off.

Softkey Location: Utility > Error Info > Clear Error Queue(s)
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Clear Text

Copy File

Press this softkey to delete the existing file name in the active entry
area. When you copy from one file to another, the same file name is
given to the new file unless you change it. Press Clear Text to delete the
existing file name and then enter in a new file name using the editing
keys provided.

Softkey Location: Utility > Memory Catalog > Copy File > Editing Keys >
Clear Text

Press this softkey to copy and rename a file in the displayed catalog of
files. To copy a file, first select the file from the displayed list by
scrolling through the list using the front panel knob or the up and down
arrow keys. When the desired file is highlighted, press Copy File. The
message Copy to: "<file_name>" is displayed in the active entry area
where "<file_name>" is the name of the currently selected file. Your
copied file will have the same name as the original file, so you must
rename it. To rename the copied file, the following editing capabilities
are provided:

< The Editing Mode Insert Replace softkey in the Editing Keys menu
toggles the editing mode from inserting text to replacing text.
Insertion mode causes text to be entered in the position directly to
the right of the cursor. Replacement mode causes the text to be
entered in the position held by the cursor (replacing any existing
text in that position).

= The Clear Text softkey in the Editing Keys menu deletes all of the
existing text in the active entry area.

= Use the left and right arrow keys to position the cursor. Use the front
panel knob, or the direct editing softkeys, to enter an alphabetic
character, numeral, or special character.

When you have entered the new file name, press the Enter terminator
softkey. If you have changed your mind, press the Return hardkey. Once
you press Enter, the new file is stored and displayed immediately in the
catalog list.

Softkey Location: Utility > Memory Catalog > Copy File
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DATA/CLK/SYNC Rear Outputs Off On (Option UNS8)

This softkey in the Instrument Adjustments menu is used to disconnect
the output signals from the rear panel DATA OUT, DATA CLK OUT,
and SYMBOL SYNC OUT connectors. Normally, these output signals
should be connected (softkey set to On position). However,
disconnecting these outputs will decrease the spurs that are sometimes
present when you are operating at high symbol rates.

Default Value: On

Softkey Location: Utility > Instrument Adjustments >
DATA/CLK/SYNC Rear Outputs Off On

Data Clock Out Polarity Neg Pos (Option UNB8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the DATA CLOCK OUT connector. Pos
refers to the rising edge, while Neg refers to the falling edge.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Data Clock Out Polarity Neg Pos

Data Clock Polarity Neg Pos (Option UNB8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the DATA CLOCK connector. Pos refers to
the rising edge, while Neg refers to the falling edge.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Data Clock Polarity Neg Pos

Data Out Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the DATA OUT connector. Pos refers to
normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Data Out Polarity Neg Pos
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Data Polarity Neg Pos (Option UNBS)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the DATA connector. Pos refers to normal
logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustment > Signal Polarity Setup >
Data Polarity Neg Pos

Delete All Files

CAUTION

Press this softkey to delete all of the files in the displayed catalog of
files. You will then confirm that you want to delete all of the files in
memory. Press the Confirm Delete Of All Files terminator softkey and all of
the files are deleted.

You cannot recover files after this step. If you change your mind and do
not wish to delete the files, press the Return front panel hardkey instead.

This softkey does not affect the persistent state or calibration
information. If power on mode is set to last, a new last state file will be
created when the instrument idles.

Softkey Location: Utility > Memory Catalog > Catalog Type > All >
Delete All Files

Delete All <catalog type> Files

CAUTION

Delete File

Press this softkey to delete all of the files in the displayed catalog of
files of a selected catalog type. You must confirm that you want to delete
all of the files. Press the Confirm Delete Of <catalog type> Files terminator
softkey to delete all the files of the selected type.

You cannot recover files after this step. If you change your mind and do
not wish to delete the files, press the Return front panel hardkey instead.

Softkey Location: Utility > Memory Catalog > Catalog Type > <catalog type> >
Delete All <catalog type> Files

Press this softkey to delete a file in the displayed catalog of files. To
delete a file, first select the file from the displayed list by scrolling
through the list using the front panel knob or up and down arrow keys.
When the desired file is highlighted, press Delete File. Then press the
Confirm Delete terminator softkey and the file is deleted. You cannot
recover the file after this step. If you have changed your mind and do
not wish to delete the file, press the Return front panel hardkey instead.

Softkey Location: Utility > Memory Catalog > Delete File
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Deselect All Items

Press this softkey to deselect all options in the list of hardware options.
Selected options show an X in the column to the left of the option
number. Deselected options have no X. Only those options that are
selected can be enabled or calibrated.

Softkey Location: Utility > Instrument Adjustments > Hardware Options >
Deselect All Items

Deselect Item

Press this softkey to deselect the highlighted option in the list of
hardware options. Selected options show an X in the column to the left
of the option number. Deselected options have no X. Only those options
that are selected can be enabled or calibrated.

Softkey Location: Utility > Instrument Adjustments > Hardware Options >
Deselect Item

Diagnostic Info

Display

Press this softkey for a display of diagnostic information about the
signal generator. The following information is included in the display:

instrument model

= instrument options

= instrument serial number

= current firmware revision

= current firmware date

< number of hours the signal generator has been powered on
< number of hours the display has been lit

< number of power cycles

< number of attenuator cycles

< number of reverse power protection trips

Softkey Location: Utility > Instrument Info/Help Mode > Diagnostic Info

Pressing this softkey reveals a menu of choices for adjusting and testing
the display. In this menu you are able to set up the screen saver, change
the display brightness, and perform black and white pixel screen tests.

Softkey Location: Utility > Display
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DMOD
Press this softkey to set the current catalog type to DMOD and display
the catalog of DMOD files.
Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > DMOD
DWCDMA

Press this softkey to set the current catalog type to DWCDMA and
display the catalog of DWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > DWCMDA

Editing Keys

Pressing this softkey reveals a menu of choices for editing the name of a
file you have just copied. When you copy a file, its name is copied also.
As you cannot have two identical file names, use this menu to edit the
file name of the copied file. In this menu you can delete the existing text
in the active entry area (either the copied file name, or a file name that
you have subsequently entered), and you can toggle the editing mode
from inserting text to replacing text.

Softkey Location: Utility > Memory Catalog > Copy File > Editing Keys

Editing Mode Insert Replace

Press this softkey to toggle the editing mode from inserting text to
replacing text. Insertion mode causes text to be entered in the position
directly to the right of the cursor. Replacement mode causes the text to
be entered in the position held by the cursor (replacing any existing text
in that position).

Softkey Location: Utility > Memory Catalog > Copy File > Editing Keys >
Editing Mode Insert Replace

EFC Lock Off On (ESG-AP and ESG-DP Models)

This softkey enables an Electronic Frequency Control mode that is for
use with phase noise systems. It is provided for use by service personnel
only.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment > EFC Lock Off On
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Utility

Pressing this softkey reveals a menu of choices for viewing error
messages. In this menu you can view any of the error messages in the
gueue, and you can clear all of the error messages in the queue.

Softkey Location: Utility > Error Info

Event 1 Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal out at the EVENT 1 connector. Pos refers to
normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Event 1 Polarity Neg Pos

Event 2 Polarity Neg Pos (Option UNS8)

FCDMA

FIR

FSK

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal out at the EVENT 2 connector. Pos refers to
normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Event 2 Polarity Neg Pos

Press this softkey to set the current catalog type to FCDMA and display
the catalog of FCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > FCDMA

Press this softkey to set the current catalog type to FIR and display the
catalog of FIR files.

Softkey Location: Utility > Memory Catalog > Catalog Type > FIR

Press this softkey to set the current catalog type to FSK and display the
catalog of FSK files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
Modulation Catalog Types > FSK
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FWCDMA

Press this softkey to set the current catalog type to FWCDMA and
display the catalog of FWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > FWCDMA

Hardware Options

This softkey accesses a menu where you can configure your signal
generator to enable or to disable any hardware option that you have
purchased. Refer to Chapter 2, “Using Functions,” for an example of
using this function. This menu also provides the capability of
performing a download of calibration data from the optional hardware
into non-volatile memory.

CAUTION If you enable an option that does not have the required hardware
installed, the menus for that option will be activated but the option
cannot operate, despite what the menus may seem to indicate.

This menu also provides the capability of performing a download of
calibration data from the optional hardware into non-volatile memory.

Softkey Location: Utility > Instrument Adjustments > Hardware Options

Help Mode Single Cont

This softkey toggles the help mode between single and continuous. In
single mode, when you press the Help key, help text is provided for the
next front panel hardkey or softkey that you press. Your next key press
returns you to normal operation. In continuous mode, when you press
the Help key, help text is provided for the next front panel hardkey or
softkey that you press and that key's function is also executed. You will
stay in this help mode until you press the Help key again.

Help mode is a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: Utility > Instrument Info/Help Mode > Help Mode Single Cont
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Utility

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. The 8648A/B/C/D softkey is a language
choice for the signal generator that is compatible with the remote
language commands used by the 8648A/B/C/D. Choosing 8648A/B/C/D in
the Preset Language menu allows you to select this remote language as
the default after a normal preset. Choosing 8648A/B/C/D in the Remote
Language menu allows you to immediately change the signal generator
to use this remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > 8648A/B/C/D

Or: Utility > GPIB/RS-232 > Remote Language > 8648A/B/C/D

8656B,8657A/B

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. The 8656B,8657A/B softkey is a language
choice for the signal generator that is compatible with the remote
language commands used by the 8656B and the 8657A/B. See the
8656/57 Compatibility table in the Softkey/Command Cross-Reference
chapter of the programming guide. Choosing 8656B,8657A/B in the Preset
Language menu allows you to select this remote language as the default
after a normal preset. Choosing 8656B,8657A/B in the Remote Language
menu allows you to immediately change the signal generator to use this
remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > 8656B,8657A/B

Or: Utility > GPIB/RS-232 > Remote Language > 8656B,8657A/B

8657D NADC (Option UNS)

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. The 8657D NADC softkey is a language
choice for the signal generator that is compatible with the remote
language commands used by the 8657D with NADC digital modulation
capabilities. Choosing 8656D NADC in the Preset Language menu allows
you to select this remote language as the default after a normal preset.
Choosing 8656D NADC in the Remote Language menu allows you to
immediately change the sighal generator to use this remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > 8657D NADC

Or: Utility > GPIB/RS-232 > Remote Language > 8657D NADC
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8657D PDC (Option UNS8)

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. The 8657D PDC softkey is a language choice
for the signal generator that is compatible with the remote language
commands used by the 8656D with PDC digital modulation capabilities.
Choosing 8657D PDC in the Preset Language menu allows you to select
this remote language as the default after a normal preset. Choosing
8657D PDC in the Remote Language menu allows you to immediately
change the signal generator to use this remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > 8657D PDC

Or: Utility > GPIB/RS-232 > Remote Language > 8657D PDC

8657J PHS (Option UNS)

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. The 8657J PHS softkey is a language choice
for the signal generator that is compatible with the remote language
commands used by the 8657J with PHS digital modulation capabilities.
Choosing 8657J PHS in the Preset Language menu allows you to select
this remote language as the default after a normal preset. Choosing
8657J PHS in the Remote Language menu allows you to immediately
change the signal generator to use this remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > 8657J PHS

Or: Utility > GPIB/RS-232 > Remote Language > 8657J PHS

GPIB Address

Press this softkey to change the signal generator's GPIB address. The
GPIB address is set to 19 at the factory. You can change the address to
any number between 0 and 30. To enter a new value, press Utility >
GPIB/RS-232 > GPIB Address and rotate the front panel knob, use the up
and down arrow keys, or enter the value using the numeric keypad and
press the Enter terminator softkey.

The GPIB address setting is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > GPIB Address
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GPIB/RS-232

Utility

Pressing this softkey reveals a menu of choices for GPIB and RS-232
configuration. In this menu, you have the following options:

= change the GPIB address of the signal generator
= change the remote language of the signal generator

< set the baud rate for the RS-232 serial port
(AUXILIARY INTERFACE connector)

= reset the RS-232 serial 1/0

= turn the RS-232 echo on or off

= set the RS-232 handshake protocol

= control RS-232 RTS and CTS behavior

Softkey Location: Utility > GPIB/RS-232

Installed Board Info

Pressing this softkey displays information regarding the board
assemblies installed in the signal generator, including:

< board assembly name

e part number

= board assembly serial number
= version

Depending on the options present, these board assemblies may include
the motherboard, the dual arbitrary waveform generator, the baseband
generator, the data generator, RF output, the reference output, or the
signal generator.

Softkey Location: Utility > Instrument Info/Help Mode > Installed Board Info

Instrument Adjustments

Pressing this softkey reveals a menu of front panel adjustments for the
signal generator. The softkeys in this menu provide the following
capabilities:

= adjust the ratio between the front panel knob and the step size for
the arrow keys

< adjust the internal reference oscillator (for use by service personnel
only)

< install and remove hardware and software options

Softkey Location: Utility > Instrument Adjustments

User’s Guide

4-123



Hardkey and Softkey Reference ESG Family Signal Generators

Utility

Instrument Info/Help Mode

Pressing this softkey reveals a menu of softkeys for the following
functions:

= display diagnostic information about your signal generator

= turn on and off the display of information about the status of the
modulation modes

= toggle the help mode between single and continuous

Softkey Location: Utility > Instrument Info/Help Mode

Inverse Video Off On

1/Q

List

MCDMA

The normal display mode for the signal generator is dark text on a light
background. Press this softkey to toggle inverse video on (light text on a
dark background).

Inverse video is a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: Utility > Display > Inverse Video Off On

Press this softkey to set the current catalog type to I/Q and display the
catalog of 1/Q files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
Modulation Catalog Types > 1/Q

Press this softkey to set the current catalog type to List and display the
catalog of list files.

Softkey Location: Utility > Memory Catalog > Catalog Type > List

Press this softkey to set the current catalog type to MCDMA and
display the catalog of MCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MCDMA

Memory Catalog

Displays the catalog of user files, and softkeys for choosing the type of
files displayed. See Chapter 5, “Memory Structure,” for details.

Softkey Location: Utility > Memory Catalog
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MDMOD

MDWCDMA

MFCDMA

MFWCDMA

Utility

Press this softkey to set the current catalog type to MDMOD and
display the catalog of MDMOD files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MDMOD

Press this softkey to set the current catalog type to MDWCDMA and
display the catalog of MDWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MDWCDMA

Press this softkey to set the current catalog type to MFCDMA and
display the catalog of MFCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MFCDMA

Press this softkey to set the current catalog type to MFWCDMA and
display the catalog of MFWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MFWCDMA

Modify License Key

CAUTION

Press this softkey to enter the license key for the highlighted software
option. Software options are linked to specific optional hardware that
must first be installed before the software option can be operational.
Adding new software options requires the use of a license key that is
provided by Agilent Technologies at the time of purchase. Once the
license key is entered, the software option will be enabled when you
press the Proceed with Reconfiguration softkey. Refer to Chapter 2, “Using
Functions,” for an example of using this function.

If you enable an option that does not have the required hardware
installed, the menus for that option will be activated but the option
cannot operate, despite what the menus may seem to indicate.

Softkey Location: Utility > Instrument Adjustments > Software Options >
Modify License Key

User’s Guide

4-125



Hardkey and Softkey Reference ESG Family Signal Generators

Utility

Mod Status Info Off On

Press this softkey to toggle on and off the modulation status display.
When the modulation status is set to on, information about the status of
all of the modulations available is shown at any time that you have
accessed one of the modulation menus. When the modulation status is
set to off, the information about the status of all the modulations is
never displayed.

Default Value: On

Softkey Location: Utility > Instrument Info/Help Mode > Mod Status Info Off On

Modulation Catalog Types

MTONE

NVARB

Off

Press this softkey to reveal a menu of Modulation catalog type choices
for displaying files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
Modulation Catalog Types

Press this softkey to set the current catalog type to MTONE and display
the catalog of MTONE files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > MTONE

Press this softkey to set the current catalog type to NVARB and display
the catalog of NVARB files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > NVARB

Press this softkey to turn the RTS line off. In this mode, the instrument
will ignore the state of the CTS line (3-wire connection). This setting is
not compatible with the 83300A Remote Interface.

RTS is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 >RS-232 Pace > RTS/CTS > Off
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Options Info

Page Down

Page Up

Utility

Press this softkey to retrieve information regarding the options
installed in the instrument. This information may include any of the
following information:

e Option number: the alpha or numeric designation of the installed
option, for instance: option UN8, UNB or 300.

< Hardware version: the letter designation of the installed hardware
for the listed option number, for instance: UN8 or UN9 - version C,
or UN7 - version A.

< DSP version: the name of the DSP (digital signal processor)
firmware version for the installed option card.

Softkey Location: Utility > Instrument Info/Help Mode > Options Info

Press this softkey to move down in the displayed catalog of files one
page at a time.

Softkey Location: Utility > Memory Catalog > Page Down Or Utility >
Memory Catalog > Goto Row > Page Down

Press this softkey to move up in the displayed catalog of files one page
at a time.

Softkey Location: Utility > Memory Catalog > Page Up Or Utility >
Memory Catalog > Goto Row > Page Up

Pattern Trigger In Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the PATTERN TRIG IN connector that
triggers an event. Pos refers to the rising edge, while Neg refers to the
falling edge.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Trigger In Polarity Neg Pos

PN9 Mode Preset Normal Quick (Option UNBS8)

This softkey sets the preset value for the PN9 mode. The choices are
Normal and Quick. PN9 mode only applies to personalities that require
software PRBS.

Default Value: Normal

Softkey Location: Utility > Power On/Preset > PN9 Mode Preset Normal Quick
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Power On Last Preset

This softkey toggles the power-on state of the signal generator between
Last and Preset.

If you choose Last, each time you cycle power to the signal generator
it will turn on in the same condition as when you turned power off.
The signal generator must not receive commands for a second before
the power is turned off to guarantee that the most recent state is
saved.

If you choose Preset, each time you cycle power to the signal
generator it will turn on in either the factory-defined preset
condition or in a user-defined preset condition. You make the choice
between factory- and user-defined preset with the Preset Normal User
softkey.

The power-on state is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Power On/Preset > Power On Last Preset

Power On/Preset

Pressing this softkey reveals a menu of choices for preset conditions. In
this menu, you have the following options:

Set the signal generator to power on in the same state as it was
when you powered off, or to power on in the instrument preset state.
(Refer to the Power On Last Preset softkey description, in this section.)

Set the signal generator to preset to a factory-defined state or to a
user-defined state. (Refer to the Preset Normal User softkey description,
in this section.)

Set up your own user-defined preset state. (Refer to the
Save User Preset softkey description, in this section.)

Set the signal generator to preset to the SCPI programming
language or to an 8648 or 8656/57-compatible language. (Refer to the
Preset Language softkey description, in this section.)

Set the signal generator’s reverse power protection to the
factory-defined state or to an 8648-equivalent state. (Refer to the
Reverse Power Protection Normal 8648 softkey description.)

Softkey Location: Utility > Power On/Preset
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Preset Language

Pressing this softkey reveals a menu of choices for selecting the
programming language that is implemented after the Preset key is
pressed. You can choose between SCPI, which is the language chosen
for the signal generator for remote implementation of all features,
8648-compatible, and four versions of 8656/57-compatible languages.
The 8648- and 8656/67-compatible languages are provided for remote
implementation of some features so that this signal generator can be
compatible with systems that use those instruments. Refer to the
programming guide for specifics on which commands are implemented.

The preset language is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Power On/Preset > Preset Language

Preset Normal User

This softkey toggles the preset state between the factory-defined and
the user-defined states. You choose the instrument state conditions for
the user-defined preset state. Refer to the Save User Preset softkey
description in this section.

The preset state is a persistent state; it is not changed by an
instrument preset or by a power cycle.

Softkey Location: Utility > Power On/Preset > Preset Normal User

Proceed With Reconfiguration

CAUTION

Press this softkey to enable the selected hardware or software options.
In the Hardware Options menu, selected options are indicated by an X
in the column to the left of the option number. In the Software Options
menu, selected options include any options that have a license key
entered. After pressing this softkey, press the Confirm Change softkey to
verify that you do want to reconfigure the signal generator with the
options that you have selected. If you do not want to continue, press the
Return key. Refer to Chapter 2, “Using Functions,” for an example of
using this function.

If you enable an option that does not have the required hardware
installed, the menus for that option will be activated but the option
cannot operate, despite what the menus may seem to indicate.

Softkey Location: Utility > Instrument Adjustments > Hardware Options >
Proceed With Reconfiguration

Or: Utility > Instrument Adjustments > Software Options >
Proceed With Reconfiguration
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RCDMA

Press this softkey to set the current catalog type to RCDMA and display
the catalog of RCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > RCDMA

Recall Ref Osc Setting

This softkey is provided for adjusting the internal reference oscillator.
This adjustment is for use by service personnel only. Refer to the
calibration guide for more information.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment > Recall Ref Osc Setting

Receive Pace None Xon

This softkey in the RS-232 Pace menu determines whether any pacing
is acknowledged by the RS-232 receive channel. If Xon pacing is used,
the system will send an Xoff character to suspend the transmitting of
data when its buffer is nearly full. When the system is ready to receive
further input, an Xon character is sent to the transmitting device. Xon
pacing is not recommended if binary data will be queried from the
signal generator via RS-232. Toggle Receive Pace None Xon t0 None to turn
off Xon pacing.

Pace is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace >
Receive Pace None Xon

Reference Oscillator Adjustment

Pressing this softkey reveals a menu of softkeys for adjusting the
internal reference oscillator. This adjustment is for use by service
personnel only.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment

Ref Osc Coarse

This softkey is provided for adjusting the internal reference oscillator.
This adjustment is for use by service personnel only. Refer to the
calibration guide for more information.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment > Ref Osc Coarse
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Ref Osc Fine

Utility

This softkey is provided for adjusting the internal reference oscillator.
This adjustment is for use by service personnel only. Refer to the
calibration guide for information.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment > Ref Osc Fine

Remote Language

Rename File

Pressing this softkey reveals a menu of choices for immediately
changing the signal generator’s remote language. You can choose
between SCPI, which is the language chosen for the signal generator for
remote implementation of all features, 8648-compatible, and four
versions of 8656/57-compatible languages. The 8648- and
8656/67-compatible languages are provided for remote implementation
of some features so that this signal generator can be compatible with
systems that use those instruments. Refer to the programming guide
for specifics on which commands are implemented.

Default Value: Depends on the value of the Preset Language.

Softkey Location: Utility > GPIB/RS-232 > Remote Language

Press this softkey to rename a file in the displayed catalog of files. The
following text explains how to use the file name editor:

= The Editing Mode Insert Replace softkey in the Editing Keys menu
toggles the editing mode from inserting text to replacing text.
Insertion mode causes text to be entered in the position directly to
the right of the cursor. Replacement mode causes the text to be
entered in the position held by the cursor (replacing any existing
text in that position).

= The Clear Text softkey in the Editing Keys menu deletes all of the
existing text in the active entry area.

= Use the left and right arrow keys to position the cursor. Use the front
panel knob, or the direct editing softkeys, to enter an alphabetic
character, numeral, or special character.

When you have entered the new file name, press the Enter terminator
softkey. If you have changed your mind, press the Return hardkey. Once
you press Enter, the new file is stored and displayed immediately in the
catalog list.

Softkey Location: Utility > Memory Catalog > Rename File
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Reset RS-232

Press this softkey to perform a clean-up on the RS-232 buffer which will
discard any unprocessed SCPI input received over RS-232 and places
the RS-232 connection in a mode which can detect the optional remote
interface. All other RS-232 communication parameters (such as baud
rate) are unaffected.

Softkey Location: Utility > GPIB/RS-232 > Reset RS-232

Restore Default Signal Polarities (Option UN8)

This softkey in the Signal Polarity Setup menu is used to restore the
instrument’s default signal polarities

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Restore Default Signal Polarities

Reverse Power Protection Normal 8648

Toggles the reverse power protection mode between the normal mode
for the signal generator and the 8648-compatible mode.

When you have selected Normal and you trip the reverse power
protection circuit, a caution message is displayed and the front panel is
locked. Eliminate the source of the excess reverse power detected at the
RF OUTPUT connector. Then press the Reset RPP softkey to continue
normal signal generator operation.

When you have selected 8648 and you trip the reverse power protection
circuit, a caution message is displayed and the front panel is locked.
However, any command sent over GPIB will reset the RPP circuit and
return you to normal signal generator operation. This mode is provided
for compatibility with systems that use the 8648. It is only available
when you have selected 8648A/B/C/D remote language. At all other
times reverse power protection is set to Normal. Operate in this mode
with caution. Repeatedly tripping the RPP can cause damage to the
signal generator. It is still best to eliminate the source of the excess
reverse power and then reset the reverse power protection circuit by
pressing the Reset RPP softkey.

The RPP reset mode is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Power On/Preset >
Reverse Power Protection Normal 8648
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Utility

RS-232 Baud Rate

Press this softkey to set the baud rate in bits per second for the rear
panel RS-232 connector (this connector is labeled AUXILIARY
INTERFACE). To change the baud rate press the softkey. A menu is
displayed of baud rates that are allowed. Press the softkey for the
desired value. The baud rate is now set to the new value and the value
is displayed below the RS-232 Baud Rate softkey.

Baud rate is a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Baud Rate

RS-232 Echo Off On

RS-232 Pace

This softkey toggles the echo function on and off for the RS-232 serial
port (AUXILIARY INTERFACE connector). When echo is set to on,
every character sent to the signal generator is immediately sent back.
No editing capability is available.

Echo is not affected by an instrument preset or by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Echo Off On

Pressing this softkey reveals a menu of choices for setting the RS-232
handshake protocol. In this menu you can choose transmit pacing,
receive pacing, and RTS/CTS control.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace

RS-232 Timeout

Pressing this softkey allows changes to the value for the RS-232 serial
port timeout. If further input is not received within the assigned
timeout period while a SCPI command is being processed, then the
command is aborted and the input buffer is cleared.

Timeout is a persistent sate; it is not affected by an instrument preset
or by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Timeout
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Utility

RTS/ICTS

Pressing this softkey reveals a menu of choices for controlling the
RTS/CTS behavior. This feature is used with RS-232 connections,
including the 83300A Remote Interface.

RTS is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace > RTS/CTS

RTS/CTS Pacing

RTS On

RWCDMA

Press this softkey to turn the RTS line on and instruct the signal
generator to monitor the state of the CTS line (hardware handshaking).
The signal generator monitors CTS and suspends transmission if this
line transitions to its logically low state. Up to 16 characters may still
be transmitted after the low transition. The signal generator will drop
RTS if its receive buffer is nearly full. RTS will be raised again when
there is sufficient room in the buffer. This setting is not compatible with
an 83300A Remote Interface. Do not attempt to use this setting with a
3-wire connection.

RTS is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace > RTS/CTS >
RTS/CTS Pacing

Press this softkey to turn the RTS line on. In this mode, the instrument
will ignore the state of the CTS line (3-wire connection). This setting is
intended for use with an 83300A Remote Interface, but it will also work
with a 3-wire connection. RTS On is the default setting for the signal
generator.

RTS is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace > RTS/CTS > ON

Press this softkey to set the current catalog type to RWCDMA and
display the catalog of RWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > RWCDMA
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Utility

Save User Preset

SCPI

Use this softkey to establish your user-defined preset state. Set up all of
the instrument state conditions that you want for your unique preset
state. When you have defined the instrument state to suit your needs,
press Save User Preset. Only one user-defined preset state is allowed, so
when you save the instrument state you will save over any
previously-saved state. Your instrument state will be recalled by the
signal generator any time you press Preset as long as you have set the
Preset Normal User softkey to User. For additional information about the
Preset Normal User softkey, refer to its description in this section.

The user’s state definition is a state file; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Power On/Preset > Save User Preset

This softkey is one of the choices in both the Preset Language menu and
the Remote Language menu. Press either the Preset Language softkey or
the Remote Language softkey to view these menus. SCPI (Standard
Commands for Programmable Instruments) is the language chosen for
remote implementation of all supported instrument features. Choosing
SCPI in the Preset Language menu allows you to select this remote
language as the default after a normal preset. Choosing scpi in the
Remote Language menu allows you to immediately change the signal
generator to use this remote language.

Softkey Location: Utility > Power On/Preset > Preset Language > SCPI

Or: Utility > GPIB/RS-232 > Remote Language > SCPI

Screen Saver Delay

This softkey sets the period of time before the screen saver is activated.
The screen saver delay is set to 1 hour at the factory. You can change
the delay by pressing Utility > Display > Screen Saver Delay. The current
value for delay is displayed in the active entry area. To enter a new
value, rotate the front panel knob, use the up and down arrow keys, or
enter the value using the numeric keypad and press the Enter
terminator softkey. The range of values allowed is 1 through 12 hours in
1 hour increments.

Screen saver delay is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Display > Screen Saver Delay
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Screen Saver Mode

This softkey toggles between Light Only and Light & Text mode for the
screen saver. When you set the screen saver to Light Only, only the
display light is turned on and off. When you set the screen saver to
Light & Text, the display light and the text are turned on and off.

Screen saver mode is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Display > Screen Saver Mode

Screen Saver Off On

Select Item

This softkey toggles the signal generator’s screen saver on and off, With
the screen saver on, the display is turned off after a period of time with
no input from the front panel. The display turns back on when any front
panel key is pressed. The screen saver is set to oOff at the factory. You
can turn it on by pressing Utility > Display Screen Saver. Each time you
press Screen Saver Off On the selection toggles between off and On.

You can adjust the screen saver mode to turn the light on and off or to
turn both the light and text on and off. Refer to the Screen Saver Mode
softkey description in this section.

The screen saver delay is set to 1 hour at the factory. You can change
the delay time. Refer to the Screen Saver Mode softkey description in this
section.

Screen saver is a persistent state; it is not affected by an instrument
preset or by a power cycle.

Softkey Location: Utility > Display > Screen Saver Off On

Press this softkey to select the highlighted option from the list of
hardware options. Selected options show an X in the column to the left
of the option number. Two operations can be performed upon the
selected options. The signal generator can be configured with these
options enabled (by pressing the Proceed With Reconfiguration softkey), or
the selected options can be calibrated (by pressing the Calibrate Selected
ltems softkey). For more information, refer to the descriptions of the
softkeys mentioned, or refer to Chapter 2, “Using Functions,” for an
example of enabling options.

Softkey Location: Utility > Instrument Adjustments > Hardware Options >
Select Item

4-136

User’s Guide



ESG Family Signal Generators Hardkey and Softkey Reference

Utility
Seq
Press this softkey to set the current catalog type to Seq and display the
catalog of sequence files.
Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > Seq
Shape

Press this softkey to set the current catalog type to Shape and display
the catalog of shape files.

Softkey Location: Utility > Memory Catalog > Catalog Type > Shape

Software Options

This softkey accesses a menu where you can configure your signal
generator to enable any software option that you have purchased.
Software options are linked to specific optional hardware that must
first be installed before the software option can be operational. Adding
new software options requires the use of a license key that is provided
by Agilent Technologies at the time of purchase.

NOTE If a previously installed software option is disabled, verify that the
optional hardware is installed, the hardware option is enabled, and the
software option is enabled with the correct license key. Refer to your
License Key Certificate for the correct license key or, if the option was
installed by Agilent Technologies, contact your local service office and
tell them the instrument’s model number, the host ID number, and the
software option that should be enabled.

CAUTION Don’t modify the license key for enabled software options. You will
disable the option.

Refer to Chapter 2, “Using Functions,” for an example of enabling
software options.

Softkey Location: Utility > Instrument Adjustments > Software Options

State

Press this softkey to set the current catalog type to State and display
the catalog of state files.

Softkey Location: Utility > Memory Catalog > Catalog Type > State
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Utility

Step/Knob Ratio

This softkey sets the ratio between the increment value of the step keys
and the front panel knob. For example, if you set the increment value
for frequency to 1 MHz and set the step/knob ratio to 10/1, when
frequency is the active function the up and down arrow keys will
change the frequency in 1 MHz steps and the front panel knob will
change the frequency in 1/10th of 1 MHz steps. This ratio only applies
when you have a function active that has an associated increment
value.

When you press Step/Knob Ratio the number displayed in the active entry
area represents the arrow keys step size in the ratio. To enter a new
value, rotate the front panel knob until the desired value is displayed,
use the up and down arrow keys, or enter the value using the numeric
keypad and press the Enter terminator softkey.

The step/knob ratio is a persistent state; it is not affected by an
instrument preset or by a power cycle.

Softkey Location: Utility > Instrument Adjustments > Step/Knob Ratio

Store Ref Osc Setting

This softkey is provided for adjusting the internal reference oscillator.
This adjustment is for use by service personnel only. Refer to the
calibration guide for more information.

Softkey Location: Utility > Instrument Adjustments >
Reference Oscillator Adjustment > Store Ref Osc Setting

Symbol Sync Out Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the SYMBOL SYNC OUT connector. Pos
refers to normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Symbol Sync Out Polarity Neg Pos

Symbol Sync Polarity Neg Pos (Option UNS8)

This softkey in the Signal Polarity Setup menu is used to configure the
polarity of the TTL signal at the SYMBOL SYNC connector. Pos refers
to normal logic, while Neg refers to inverted logic.

Default Value: Pos

Softkey Location: Utility > Instrument Adjustments > Signal Polarity Setup >
Symbol Sync Polarity Neg Pos
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Utility

Transmit Pace None Xon

This softkey in the RS-232 Pace menu determines whether any pacing
is acknowledged by the RS-232 transmit channel. If Xon pacing is used,
the system will suspend transmitting data upon receiving an Xoff
character until an Xon character is received. The signal generator may
not be responsive to other channels, or to the front panel, while
transmission is suspended. Xon pacing is not recommended if binary
data will be sent to the signal generator via RS-232. Toggle

Transmit Pace None Xon t0 None to turn off Xon pacing.

Pace is a persistent state; it is not affected by an instrument preset or
by a power cycle.

Softkey Location: Utility > GPIB/RS-232 > RS-232 Pace >
Transmit Pace None Xon

Update in Remote Off On

UWCDMA

This softkey toggles between the display updating off or on, when the
remote control bus is in remote.

This is a persistent state in the preset mode. However, it resets to off,
the default value, when the power is cycled.

Softkey Location: Utility > Display > Update in Remote

Press this softkey to set the current catalog type to UWCDMA and
display the catalog of UWCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > UWCDMA

View Next Error Message

If the ERR annunciator is turned on in the display, you have at least one
error message stored in the error message queue. Use this softkey to
display the first error message in the queue. (The first error message is
the oldest error.) There may be more than one error message in the
gueue; the number of error messages is displayed along with the first
message. If there is more than one message, continue pressing this
softkey to view the rest of the error messages. If you wish to back up
and view a message you have already seen, press

View Previous Error Message. Press any front panel key to remove the error
message from the display and return to normal signal generator
operation.
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The error queue can contain up to 30 error messages. When the front
panel error queue overflows, error messages are deleted beginning with
the oldest ones first. When the SCPI error queue overflows, newer error
messages are not recorded.

You can scroll through the error messages in reverse order. Refer to the
View Previous Error Message softkey description.

Softkey Location: Utility > Error Info > View Next Error Message

View Previous Error Message

If the ERR annunciator is turned on in the display, you have at least one
error message stored in the error message queue. Use this softkey to
display the newest error message first. Continue pressing this softkey
to view additional error messages in order of newest to oldest. Press any
front panel key to remove the error message from the display and
return to normal signal generator operation.

Softkey Location: Utility > Error Info > View Previous Error Message

WCDMA

Press this softkey to set the current catalog type to WCDMA and
display the catalog of WCDMA files.

Softkey Location: Utility > Memory Catalog > Catalog Type >
ARB Catalog Types > WCDMA

White Pixels Screen Test

This softkey is provided for factory use in testing the display. Pressing
this softkey sets all of the pixels on the display to white. Pressing the
front panel Local key returns the display to normal operation.

Softkey Location: Utility > Display > White Pixels Screen Test
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5 Memory Structure

This chapter describes the structure of the signal generator’s internal memory, and
front-panel memory catalog navigation. For information on manipulating files within the
internal memory from a remote system, refer to the Programming Guide.
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Memory Types

Memory Types

Default Memory I Firmware Memory I Motherboard RAM

ARB Memory | NVARB Memory | Sequencer Memory
| |
| |
4 VB SRAM I 4vBFRLASH |
| _ __ _ DataGenerator L I_ Bgse_barlj G_engrat_or_
PRAM: 1 MB (Opt. UN8) or Burst Shape Memory
8 MB (Opt. UN9)

The signal generator's memory, depending on the options present, comprises:

Default Memory

stores FIR filter coefficient data, modulation data, user file bit editor data,
and instrument state data.

Firmware Memory

stores the code used by the signal generator to manipulate internal data
and the internal hardware.

Motherboard RAM

stores data such as persistent state information, initialized and uninitial-
ized variables, boot ROM, default directories, and default buffer.

Arbitrary Waveform Generator (Option UND) contains:

< ARB memory (RAM-based, volatile) holds the current data for playback
using the arbitrary waveform generator.

< NVARB memory (FLASH RAM-based, nonvolatile) stores arbitrary
waveform data for subsequent transfer to ARB memory for playback.

= Sequencer memory, which contains data related to waveform segments,
waveform sequences, repetition, and marker settings.

Data Generator (Option UN8/9)

contains pattern RAM memory. Data loaded into PRAM is read by the
real-time 1/Q baseband generator to produce the desired output. PRAM
data includes the modulating data bits plus control information such as
burst state, EVENT 1 output, and pattern reset.

Baseband Generator (Option UN8/9) contains the burst shape memory.
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Memory Structure
File Storage — the Memory Catalog

File Storage - the Memory Catalog

The signal generator’s interface
for stored files is the memory
catalog. You can view, copy,
rename and delete files from the
memory catalog either from the
instrument’s front panel or
remotely (for information on
performing these tasks remotely,
see the programming guide).

The Default catalog subcatalogs
contain the following information:

Default Catalog
Subcatalogs

Binary

Bit

FIR

List

Shape

State

ARB Catalog
Subcatalogs

Used by
dual arbitrary waveform generator options

Modulation Catalog
Subcatalogs

Used by both
dual arbitrary waveform generator and
baseband generator options

Binary User files, and any
other binary files
downloaded to the signal generator.

Bit User file data created/modified using the bit editor or downloaded to the signal generator.
Bit files contain a 10-byte header.

FIR Finite impulse response filter files that contain coefficient values.

List Data associated with frequency and amplitude sweeps, such as frequency start/stop, dwell
time, sweep type/repeat/trigger, point trigger, mode, direction, and trigger out polarity.

Shape Data associated with specifying burst shape.

State Data controlling instrument operating state parameters, such as frequency, power level,
and mode.

NOTE ARB catalog files and Modulation catalog files are documented in the

applicable option user’s and programming guide.

Viewing Stored Files

1. Press the utility hardkey.

. Press the softkey Memory Catalog.

2
3. Press catalog Type. The default catalog type is All (files are listed in alphabetical order).
4

. To view a specific catalog type, choose that catalog's softkey.

NOTE

Catalogs may display an additional menu of softkeys where you choose the
specific subcatalog that you wish to view.
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File Storage — the Memory Catalog

Copying Stored Files
1. Highlight the desired file.

2. Press Copy File to open a text editor.
3. Press Editing Keys > Clear Text.
4

. Input the new file name and press Enter to terminate the entry.

Renaming Stored Files
Highlight the desired file.

1

2. Press More (1 of 2) > Rename File to open a text editor.
3. Press Editing Keys > Clear Text.
4

. Input the new file name and press Enter to terminate the entry.

Deleting Stored Files
1. Highlight the desired file.

2. Press Delete File. The Confirm Delete softkey appears.

3. Press Confirm Delete.
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ESG Family Signal Generators

6 Safety and Regulatory

This chapter provides regulatory declarations, and explanations of caution and warning
statements marked on the instrument.
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Safety and Regulatory ESG Family Signal Generators
Safety Notes

Safety Notes

The following safety notes are used throughout this manual. Familiarize yourself with
each of the notes and its meaning before operating this instrument.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not
correctly performed or adhered to, would result in damage to or destruction of
the product. Do not proceed beyond a caution sign until the indicated
conditions are fully understood and met.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if
not correctly performed or adhered to, could result in injury or loss
of life. Do not proceed beyond a warning note until the indicated
conditions are fully understood and met.
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Safety and Regulatory
Instrument Markings

Instrument Markings

The following markings and caution and warning labels are used on the instrument. Be
sure to observe all cautions and warnings.

WARNING

No user serviceable parts inside. Refer servicing to qualified

personnel.

A

Ce

@

LR 57496C

0N10149

ISM 1-A

ICES/NMB-001

The instruction manual symbol. The product is
marked with this symbol when it is necessary for the
user to refer to the instructions in the manual.

The CE mark is a registered trademark of the
European Community (if accompanied by a year, it is
the year when the design was proven).

The CSA mark is the Canadian Standards Association
safety mark.

The C-Tick Mark is a trademark registered to the
Australian Communications Authority and indicates
compliance with the Standard which limits
electromagnetic radiation from computing hardware.

This symbol is used to mark the on position of the
power line switch.

This symbol is used to mark the standby position of
the power line switch.

This symbol indicates that the input power required is
AC.

This is a symbol of an Industrial Scientific and
Medical Group 1 Class A product. (CISPER 11,
Clause 4)

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB-001
du Canada.
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Safety and Regulatory ESG Family Signal Generators
General Safety Considerations

General Safety Considerations

WARNING No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure
to ensure adequate earth grounding by not using this cord may cause product

damage.
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ESG Family Signal Generators Safety and Regulatory
Statement of Compliance

Statement of Compliance

This product has been designed and tested in accordance with IEC Publication 1010,
Safety Requirements for Electronic Measuring Apparatus, and has been supplied in a safe
condition. The instruction documentation contains information and warnings which must
be followed by the user to ensure safe operation and to maintain the product in a safe
condition.
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Safety and Regulatory ESG Family Signal Generators
Assistance

Assistance

Product maintenance agreements and other customer assistance agreements are available
for Agilent Technologies products. For any assistance, contact your nearest Agilent
Technologies sales or service office. (Refer to “Agilent Technologies Sales and Service
Offices” on page 2-21.)
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Certification

Certification

Agilent Technologies certifies that this product met its published specifications at the time
of shipment from the factory. Agilent Technologies further certifies that its calibration
measurements are traceable to the United States National Institute of Standards and
Technology, to the extent allowed by the Institute’s calibration facility, and to the
calibration facilities of other International Standards Organization members.
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Declaration of Conformity

Declaration of Conformity

- DECLARATION OF CONFORMITY

Ascording to SOAEC Guide 22 and CEN/GENELEC EN 45014

‘Manufacturer's Name: . .
Agilent Technologies, inc. Agilent Technologies UK Lid.

Manufacturer's Address:
1400 Fountaingrove Parkway South Glueensferry
Santa Rosa, CA 95403-1798 West Lothian, EH30 9TG
USA. Scotland, United Kingdam

Declares that the products
Product Name: Signal Generator _
M.od'el Number: E4400B, E4420B, E4421B, E44228, E4430B,
. _ E4431B, E4432B, E4433B, E4423B, E4424B,
E4425B, E4426B, E4434B, E4436B, E4436B,
E4437B

Product Options: . This declaration covers all options of the above
' preducts, '

Conform to the following product specifications:

EMC: IEC 61326-1:1997+A1:1908 / EN 61326-1:1997+A1:1998

Standard - : Lirnit

CISPR 11:1990 / EN 55011-1821 Group 1, Class A

IEC 61000-4-2:1985+A1998 / EN 61000-4-2:15885 4 kv CD, 8 kV AD

IEC 81000-4-3:1985 / EN 61000-4-3:1995 "~ 3V/m, 80 - 1000 MHz

IEC 61000-4-4:1995 / EN 61000-4-4:1995 0.5 kV sig., 1 kV power
.- |IEC 61000-4-5:1995 / EN 61000-4-5:1996 05 kVLL, 1kVL-G

{EC 61000-4-6:1996 / EN 61000-4-6:1998 3V, 0.15-80 MHz

|IEC 64000-4-11:1994 / EN 61000-4-11:1998 1 cycle, 100%

Safety: IEC 61010-1:1990 + A1:1992 + A2:1995 / EN 61010-1:1893 +A2:1995
CAN/CSA-C22.2 Ne. 1010.1-82

Supplementary Information:
The products herewith comply with the reguirements of the Low Veltage Directive 73/23/EEC and
the EMC Directive 88/336/EEC and carry the CE-marking accordingly.

);%@ZA R fua

Greg Pfeiffer/Quality Engineering Manager R. M. Evans/Quality Manager
Santa Rosa, 22 Mar. 2000 South Queensferry, 28 Mar. 2000

For further information, please contact your local Agilent Technologies sales office, agent or distributor.
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Compliance with German Noise Requirements

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation on
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung
-3.GSGV Deutschland).

Acoustic Noise Emission/Geraeuschemission
LpA<70dB LpA<70dB
Operator position am Arbeitsplatz
Normal position normaler Betrieb
per 1SO 7779 nach DIN 45635 t.19
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Symbols

# Points softkey, 4-96
®M annunciator, 3-9
®M hardkey, 4-67
®M softkeys
®M Dev, 4-68
®M Dev Couple Off On, 4-69
®M Off On, 4-69
®M Path 1 2, 4-70
M Rate, 4-70
®M Source, 4-71
®M Start Rate, 4-71
®M Stop Rate, 4-72
®M Sweep Time, 4-72
®M Sweep Trigger, 4-72
®M Tone 1 Rate, 4-73
®M Tone 2 Ampl Percent Of Peak, 4-73
®M Tone 2 Rate, 4-73
®M Waveform, 4-74

Numerics
10 MHz
IN connector, 3-14
OUT connector, 3-14
321.4 MHz IN connector, 3-19

A

AC power receptacle, 3-13
AC symbol, 6-3
active entry area, 3-9
Add Comment To Seq[n] Reg[nn] softkey, 4-91
Adjust Phase softkey, 4-34
air flow, 1-4
ALC

annunciator, OFF, 3-9, 4-14, 4-43

softkeys

BW Normal Narrow, 4-13
Off On, 4-14, 4-42

Alt Ampl Delta softkey, 4-15
Alt Ampl Off On softkey, 4-15
Alt Ampl Trigger softkey, 4-15
ALT PWR IN connector, 3-15
Alternate Amplitude

softkey, 4-14
altitude requirements, 1-4
AM, 4-2
AM annunciator, 3-9
AM depth

setting, 2-5
AM Depth Couple Off On softkey, 4-2

AM Depth softkey, 4-2
AM hardkey, 4-2
AM Off On softkey, 4-3
AM Path 1 2 softkey, 4-3
AM Path 1 2 WB softkey, 4-3
AM rate
setting, 2-6
AM Rate softkey, 4-4
AM Source softkey, 4-4
AM Start Rate softkey, 4-5
AM Stop Rate softkey, 4-5
AM Sweep Time softkey, 4-6
AM sweep trigger
bus, 4-7
external, 4-8
immediate, 4-9
trigger key, 4-12
AM Sweep Trigger softkey, 4-6
AM Tone 1 Rate softkey, 4-6
AM Tone 2 Ampl Ratio Percent Of Peak softkey, 4-7
AM Tone 2 Rate softkey, 4-7
AM Waveform softkey, 4-7
Ampl hardkey, 4-13
Ampl Offset softkey, 4-16
Ampl Ref Off On softkey, 4-16
Ampl Ref Set softkey, 4-16
Ampl softkey, 4-96
Ampl Start softkey, 4-97
Ampl Stop softkey, 4-97
amplitude display area, 3-8
Amplitude hardkey, 3-6, 4-19
amplitude modulation, 4-2
setting up, 2-5, 4-3
turning on, 2-6
amplitude offset, 4-16
setting, 2-4
amplitude offset, setting, 2-4
amplitude reference, 4-16
setting, 2-4
amplitude sweep, 4-96
annunciators, 3-9, 4-4
oM, 3-9
ALC OFF, 3-9, 4-14, 4-43
AM, 3-9
ARMED, 3-9
ATTEN HOLD, 3-9
BERT, 3-9
digital modulation, 3-9
ENVLP, 3-9
ERR, 3-10
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EXT REF, 3-10

EXT1 HI, 3-10

EXT1LO, 3-10, 4-4

EXT2 HI, 3-10

EXT2 LO, 3-10, 4-4

FM, 3-10

1/Q, 3-10

L, 3-10

MOD OFF, 3-10

MOD ON, 3-10

OVEN COLD, 3-10

PULSE, 3-10

R, 3-10

RF OFF, 3-10

S, 3-10

SWEEP, 3-10

T, 3-11

UNLEVEL, 3-11

UNLOCK, 3-11
ARB Catalog Types softkey, 4-111
ARB memory, 5-2
ARB softkey, 4-111
ARMED annunciator, 3-9
arrow keys, 3-4, 4-20
assistance, 6-6
ATTEN HOLD annunciator, 3-9
Atten Hold Off On softkey, 4-17
attenuator

hold, 4-17

number of cycles, 4-117
automatic leveling control, 4-14
AUXILIARY INTERFACE connector, 3-13

B

backspace key, 4-66

BASEBAND GEN REF IN connector, 3-17
baud rate, 4-133

BER CLK IN connector, 3-19

BER DATA IN, 3-19

BER DATA IN connector, 3-19

BER ERR OUT connector, 3-18

BER GATE IN connector, 3-19

BER MEAS END connector, 3-18

BER NO DATA connector, 3-18

BER SYNC LOSS connector, 3-19

BER TEST OUT connector, 3-18
BERT annunciator, 3-9

Binary softkey, 4-111

Bit softkey, 4-111

Black Pixels Screen Test softkey, 4-112

Brightness softkey, 4-112
Burst Envelope Off On softkey, 4-43
BURST GATE IN connector, 3-15
Burst Gate In Polarity Neg Pos softkey, 4-112
burst shape memory, 5-2
burst source
internal, 4-48
Burst Source softkey, 4-43
Bus softkey, 4-7, 4-22, 4-51, 4-74, 4-97

C

Calibrate Selected Items softkey, 4-112
Calibration Type User Full softkey, 4-44
Canadian Standards Association, 6-3
carrier frequency (amplitude modulation)
setting, 2-5
carrier frequency (frequency modulation)
setting, 2-7
Catalog Type softkey, 4-113
catalogs
copying files, 5-4
deleting files, 5-4
renaming files, 5-4
viewing files, 5-3
caution sign, 6-2
CDMA softkey, 4-113
CE mark, 6-3
certificate
license key, 2-15
certification, 6-7
specifications, 6-7
changing signs, 4-66
cleaning, 1-4
Clear Error Queue(s) softkey, 4-113
Clear Text softkey, 4-92, 4-114
COHERENT CARRIER OUT connector, 3-15
compliance
statement of, 6-5
compliance with German noise requirements, 6-9
Configure List Sweep softkey, 4-97
Configure Step Sweep softkey, 4-98
configuring a list sweep using step sweep data, 2-10
connectors, 3-13—3-19
10 MHz IN, 3-14
10 MHz OUT, 3-14
321.4 MHz IN, 3-19
ALT PWR IN, 3-15
AUXILIARY INTERFACE, 3-13
BASEBAND GEN REF IN, 3-17
BER CLK IN, 3-19

-2
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BER DATA IN, 3-19 DC softkey, 4-51

BER ERR OUT, 3-18 DC®M calibration, 4-74

BER GATE IN, 3-19 DCFM/DC®M Cal softkey, 4-22, 4-74
BER MEAS END, 3-18 Declaration of Conformity, 6-8

BER NO DATA, 3-18
BER SYNC LOSS, 3-19
BER TEST OUT, 3-18
BURST GATE IN, 3-15

default memory, 5-2
Delete All List Files softkey, 4-116
Delete All Regs in Seq [n], 4-86, 4-92

COHERENT CARRIER OUT. 3-15 Delete All Sequences softkey, 4-86, 4-92
DATA, 3-6 Delete File softkey, 4-98, 4-116
DATA CLK OUT, 3-14 Delete Item softkey, 4-98
DATA CLOCK, 3-7 Delete Row softkey, 4-98
DATA OUT, 3-14 Delete Seq[n] Reg[nn], 4-87, 4-93
EVENT 1, 3-16 Diagnostic Info softkey, 4-117
EVENT 2, 3-16 digit keys, 4-66
EXT 1 INPUT, 3-3 digital modulation annunciators, 3-9
EXT 2 INPUT, 3-3 :

display
HP-1B, 3-13

active entry area, 3-9

I INPUT, 3-5 amplitude area, 3-8

I OUT, 3-17 annunciators, 3-9

LF OUTPUT, 3-3 brightness, 4-112
PATTERN TRIG IN, 3-15 error message area, 3-8
PULSE IN, 3-7 frequency area, 3-8

Q INPUT, 3-5 location, 3-5

Q OUT, 3-18 modulation status, 4-126
RF OUTPUT, 3-4 number of hours lit, 4-117
RS-232, 3-13

text area, 3-9
display annotation, 3-8
display contrast, 1-5

SWEEP OUT, 3-14
SYMBOL SYNC, 3-7
SYMBOL SYNC OUT, 3-13

TRIGGER IN., 3-14 display contrast decrease hardkey, 3-4, 4-21
TRIGGER OL,’IT, 3-14 display contrast increase, 3-4
contrast decrease hardkey, 3-4 display contrast increase hardkey, 3-4, 4-21
contrast increase hardkey, 3-4 display light, 1-5
cooling holes, 1-4 Display softkey, 4-117
Copy File softkey, 4-114 DMOD softkey, 4-118
coupling Do Power Search softkey, 4-17, 4-44
FM deviation, 4-25 down arrow key, 4-20
creating a step sweep and a list sweep, 2-9 Dual Sine softkey, 4-8, 4-22, 4-52, 4-74
CSA mark, 6-3 DWCDMA softkey, 4-118
dwell time
D incorrect, 2-18

dwell time, step sweep, 4-105

DATA CLK OUT connector, 3-14 Dwell Type List Step softkey, 4-99

DATA CLOCK input connector, 3-7
Data Clock Out Polarity Neg Pos softkey, 4-115

Data Clock Polarity Neg Pos softkey, 4-115 E

DATA input connector, 3-6 echo off/on, 4-133

DATA OUT connector, 3-14 Edit Item softkey, 4-99

Data Out Polarity Neg Pos softkey, 4-115 Editing Keys softkey, 4-93, 4-118

Data Polarity Neg Pos softkey, 4-116 Editing Mode Insert Replace softkey, 4-93, 4-118
DATA/CLK/SYNC Rear Outputs Off On softkey, electrical requirements, 1-3

4-115 enabling options, 2-13
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environmental requirements, 1-3
ENVLP annunciator, 3-9
ERR annunciator, 3-10
Error Info softkey, 4-119
error message area, 3-8
error messages

where displayed, 3-8
European Community trademark, 6-3
EVENT 1 connector, 3-16
Event 1 Polarity Neg Pos softkey, 4-119
EVENT 2 connector, 3-16
Event 2 Polarity Neg Pos softkey, 4-119
examples

enabling options, 2-13
Execute Cal softkey, 4-44
Ext 1 AC-Coupled softkey, 4-8, 4-23, 4-75
Ext 1 DC-Coupled softkey, 4-8, 4-23, 4-75
EXT 1 INPUT connector, 3-3
Ext 2 AC-Coupled softkey, 4-9, 4-24, 4-76
Ext 2 DC-Coupled softkey, 4-9, 4-24, 4-76
EXT 2 INPUT connector, 3-3
Ext 1/Q Phase Polarity Normal Invert softkey, 4-45
Ext 1/Q softkey, 4-45
Ext Pos softkey, 4-99
EXT REF annunciator, 3-10
Ext softkey, 4-8, 4-23, 4-52, 4-74
Extl DC softkey, 4-44
EXT1 HI annunciator, 3-10, 4-4
EXT1 LO annunciator, 3-10, 4-4
Ext2 DC-Coupled softkey, 4-82
EXT2 HI annunciator, 3-10, 4-4
EXT2 LO annunciator, 3-10, 4-4

F

Fast Pulse Off On softkey, 4-82
FCDMA softkey, 4-119
files
copying, 5-4
deleting, 5-4
renaming, 5-4
viewing, 5-3
FIR softkey, 4-119
firmware memory, 5-2
firmware revision, 4-117
FLASH RAM-based memory, 5-2
FM, 4-22
FM annunciator, 3-10
FM Dev Couple Off On softkey, 4-25

FM Dev softkey, 4-25
FM deviation, 4-25

setting, 2-7
FM deviation coupling, 4-25
FM ®M Normal High BW softkey, 4-76
FM ©M softkey, 4-24
FM hardkey, 4-22
FM Off On softkey, 4-26
FM Path 1 2 softkey, 4-26
FM rate, 4-27

setting, 2-8
FM Rate softkey, 4-27
FM Source softkey, 4-27
FM Start Rate softkey, 4-28
FM Stop Rate softkey, 4-28
FM Sweep Time softkey, 4-28
FM sweep trigger

bus, 4-22

external, 4-23

immediate, 4-30

trigger key, 4-32
FM Sweep Trigger softkey, 4-29
FM Tone 1 Rate softkey, 4-29
FM Tone 2 Ampl Percent Of Peak softkey, 4-29
FM Tone 2 Rate softkey, 4-30
FM Waveform softkey, 4-30
Freq hardkey, 4-34
Freq Multiplier softkey, 4-35
Freq Offset softkey, 4-35
Freq Ref Off On softkey, 4-36
Freq Ref Set softkey, 4-36
Freq softkey, 4-99
Freq Start softkey, 4-100
Freq Stop softkey, 4-100
Freq&Ampl softkey, 4-100
frequency

multiplying, 4-35

offset, 4-35

reference, 4-36

setting, 2-2
frequency and amplitude sweep, 4-100
frequency display area, 3-8
Frequency hardkey, 3-6, 4-38
frequency modulation, 4-22

setting up, 2-7

turning on, 2-8
frequency multiplier, 4-35
frequency offset

setting, 2-3
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frequency offset, setting, 2-3
frequency output, 4-38
frequency reference

setting, 2-3
frequency sweep, 4-99
front handles

installation, 1-2
front panel knob, 3-5
front panel overview, 3-2
FSK softkey, 4-119
Function Generator softkey, 4-52
FWCDMA softkey, 4-120

G

German Regulation on Noise Declaration for
Machines, 6-9

Goto Bottom Row softkey, 4-100

Goto Middle Row softkey, 4-101

Goto Row softkey, 4-101

Goto Top Row softkey, 4-101

H

handles, front, 1-2
hardkey descriptions, 4-1
hardkeys, 3-4, 4-20

dM, 4-67

AM, 4-2

Ampl, 4-13

Amplitude, 3-6, 4-19

arrow, 3-4

contrast decrease, 3-4

contrast increase, 3-4

display contrast decrease, 3-4, 4-21

display contrast increase, 4-21

FM, 4-22

Freq, 4-34

Frequency, 3-6, 4-38

Help, 3-3, 4-39

Hold, 3-5, 4-40

1/Q, 4-42

Incr Set, 3-6, 4-41

LF Out, 4-51

Local, 4-63

menus, 3-6

Mod On/Off, 3-3, 4-64

Mode, 4-65

numeric, 3-4

Preset, 3-4, 4-81

Pulse, 4-82

Recall, 3-6, 4-86

Return, 4-89

RF On/Off, 3-4, 4-90

Save, 3-6, 4-91

Sweep/List, 4-96

Trigger, 3-3, 4-109

up arrow, 4-20

Utility, 4-111
hardware option

enabling, 2-13
Hardware Options softkey, 4-120
Help hardkey, 3-3, 4-39
help mode

changing, 4-120

turning off, 2-18
Help Mode Single Cont softkey, 4-120
High Crest Mode Off On softkey, 4-45
Hold hardkey, 3-5, 4-40
HP sales and service offices, 2-21
HP8648A/B/C/D softkey, 4-121
HP8656B,8657A/B softkey, 4-121
HP8657D NADC softkey, 4-121
HP8657D PDC softkey, 4-122
HP8657J PHS softkey, 4-122
HP-IB address, 1-6
HP-IB Address softkey, 4-122
HP-1B connector, 3-13
HP-IB/RS-232 softkey, 4-123
humidity requirements, 1-4

I INPUT connector, 3-5
| Offset softkey, 4-46
I OUT connector, 3-17
1/Q
external source, 4-45
internal source, 4-48
1/Q Adjustments Off On softkey, 4-46
1/Q Adjustments softkey, 4-46
1/Q annunciator, 3-10
1/Q calibration, 4-44
start frequency, 4-50
1/Q Calibration softkey, 4-46
1/Q Gain softkey, 4-47
1/Q hardkey, 4-42
1/Q modulation, 4-47
1/Q Off On softkey, 4-47
1/Q softkey, 4-124
1/Q Source softkey, 4-47
IEC Publication 1010, 6-5
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Immediate softkey, 4-9, 4-30, 4-52, 4-77, 4-102
Incr Set hardkey, 3-6, 4-41
increment setting, 4-41
indoor use, 1-4
input connectors, 3-19
10 MHz IN, 3-14
321.4 MHz IN, 3-19
AUXILIARY INTERFACE, 3-13
BASEBAND GEN REF IN, 3-17
BER CLK IN, 3-19
BER GATE IN, 3-19
BURST GATE IN, 3-15
DATA, 3-6
DATA CLOCK, 3-7
EXT 1 INPUT, 3-3
EXT 2 INPUT, 3-3
HP-1B, 3-13
I INPUT, 3-5
line power, 3-13
PATTERN TRIG IN, 3-15
PULSE IN, 3-7
Q INPUT, 3-5
RS-232, 3-13
SYMBOL SYNC, 3-7
TRIGGER IN, 3-14
Insert Item softkey, 4-102
Insert Row softkey, 4-102
installation, 1-2
Installed Board Info softkey, 4-123
instruction manual symbol, 6-3
Instrument Adjustments softkey, 4-123
Instrument Info/Help Mode softkey, 4-124
instrument markings, 6-3
instrument state
saving and recalling, 2-12
Int Burst softkey, 4-48
Int 1/Q softkey, 4-48
Internal Modulation softkey, 4-53
Internal Pulse softkey, 4-83
internal reference oscillator adjustment, 4-130
Internal softkey, 4-10, 4-30, 4-77
Internal Square softkey, 4-83
internally-generated amplitude modulation
setting, 2-5
internally-generated frequency modulation
setting up, 2-7
inverse video, 1-5
Inverse Video Off On softkey, 4-124
1Q calibration
stop frequency, 4-50
ISM 1-A symbol, 6-3

K

key

license, 2-15
key descriptions, 4-1
keypad, numeric, 3-4
kits, 1-2

front handles, 1-2
knob, 3-5

L

L annunciator, 3-10
language, 1-6
LED, 4-80

green, 4-80
LEDs

line power, 3-5

standby, 3-5
left arrow key, 4-20
LF Out Amplitude softkey, 4-53
LF Out Freq softkey, 4-53
LF Out hardkey, 4-51
LF Out Off On softkey, 4-54
LF Out Period softkey, 4-54
LF Out Source softkey, 4-55
LF Out Start Freq softkey, 4-55
LF Out Stop Freq softkey, 4-56
LF Out Sweep Time softkey, 4-56
LF Out Sweep Trigger softkey, 4-57
LF Out Tone 1 Freq softkey, 4-57
LF Out Tone 2 Ampl % Of Peak softkey, 4-58
LF Out Tone 2 Freq softkey, 4-58
LF Out Waveform softkey, 4-59
LF Out Width softkey, 4-59
LF output

DC waveform, 4-51

incorrect signal, 2-18
LF OUTPUT connector, 3-3
LF output source

internal, 4-53
LF output sweep trigger

bus, 4-51

external, 4-52

immediate, 4-52

trigger key, 4-62
license key, 2-15
light bulb, 1-5
line power LED, 3-5
line settings, 1-3
List softkey, 4-124
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list sweep
configuring using step sweep data, 2-10
creating, 2-9
turning on for a single sweep, 2-11
list sweep points
editing, 2-10
list sweep, creating, 2-9
listen mode annunciator, 3-10
Load From Selected File softkey, 4-102
Load List From Step Sweep softkey, 4-103
Load/Store softkey, 4-103
Local, 3-4
Local hardkey, 3-4, 4-63
locked up, 2-19
low frequency generator, 4-51

M

maintenance agreements, 6-6
Manual Mode Off On softkey, 4-103
Manual Point softkey, 4-103
MCDMA softkey, 4-124
MDMOD softkey, 4-125
MDWCDMA softkey, 4-125
memory

ARB, 5-2

burst shape, 5-2

default, 5-2

firmware, 5-2

FLASH RAM-based, 5-2

motherboard RAM, 5-2

nonvolatile, 5-2

NVARB, 5-2

pattern RAM, 5-2

RAM-based, 5-2

volatile, 5-2
memory catalog

copying files, 5-4

deleting files, 5-4

renaming files, 5-4

viewing files, 5-3
Memory Catalog softkey, 4-124
menu hardkeys, 3-6
MFCDMA softkey, 4-125
MFWCDMA softkey, 4-125
MOD OFF annunciator, 3-10
MOD ON annunciator, 3-10
Mod On/Off hardkey, 3-3, 4-64
Mod Status Info Off On softkey, 4-126
Mode 1 Optimize <10kHz Offset softkey, 4-36

Mode 2 Optimize >10kHz Offset softkey, 4-36
Mode hardkey, 4-65
model number, 4-117
Modify License Key softkey, 4-125
modulation

annunciators, 3-9, 3-10

none, 2-17

turning on/off, 4-64
Modulation Catalog Types softkey, 4-126
modulation status display, 4-126
motherboard RAM, 5-2
MTONE softkey, 4-126
multiplying frequency, 4-35

N

Noise softkey, 4-10, 4-31, 4-59, 4-77
nonvolatile memory, 5-2

numeric keypad, 3-4, 4-66

NVARB memory, 5-2

NVARB softkey, 4-126

@)

Off softkey, 4-104, 4-126
offset, 4-35
operation verification, 1-7
operational problems, 2-16
operator’s check, 1-7
Optimize ® Noise softkey, 4-37
options
enabling, 2-13
not working, 2-16
output
frequency, 4-38
power, 4-19
output connectors
10 MHz OUT, 3-14
AUXILIARY INTERFACE, 3-13
BER ERR OUT, 3-18
BER MEAS END, 3-18
BER NO DATA, 3-18
BER SYNC LOSS, 3-19
BER TEST OUT, 3-18
COHERENT CARRIER OUT, 3-15
DATA CLK OUT, 3-14
DATA OUT, 3-14
EVENT 1, 3-16
EVENT 2, 3-16
HP-1B, 3-13
| OUT, 3-17
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LF OUTPUT, 3-3
Q OuUT, 3-18
RF OUTPUT, 3-4
RS-232, 3-13
SWEEP OUT, 3-14
SYMBOL SYNC OUT, 3-13
TRIGGER OUT, 3-14
OVEN COLD annunciator, 3-10

P
pace, 4-133
Page Down softkey, 4-104, 4-127
Page Up softkey, 4-104, 4-127
pattern RAM, 5-2
PATTERN TRIG IN connector, 3-15
Pattern Trigger In Polarity Neg Pos softkey, 4-127
phase modulation, 4-67
source, 4-71
start rate, 4-71
stop rate, 4-72
sweep time, 4-72
sweep trigger, 4-72
tone 1 rate, 4-73
tone 2 amplitude percent of peak, 4-73
tone 2 rate, 4-73
turning off/on, 4-69
waveform, 4-74
phase modulation deviation, 4-68
phase modulation deviation coupling, 4-69
phase modulation rate, 4-70
phase modulation sweep trigger
bus, 4-74
external, 4-74
immediate, 4-77
trigger key, 4-79
Phase Ref Set softkey, 4-37
phase, changing, 4-34
PN9 Mode Preset Normal Quick softkey, 4-127
point trigger, 4-97, 4-99, 4-102, 4-107
Point Trigger softkey, 4-104
power cord, 1-3
power cycles, number of, 4-117
power level (amplitude modulation)
setting, 2-5
power level (frequency modulation)
setting, 2-7
power levels
setting, 2-2
Power On Last Preset softkey, 4-128

power on symbol, 6-3
Power On/Preset softkey, 4-128
power output, 4-19
power receptacle, 3-13
power search, 4-17, 4-44
Power Search Manual Auto softkey, 4-18, 4-48
Power Search Reference Fixed Modulated softkey,
4-18
Power Search softkey, 4-18
power supply
shut down, 2-17
power switch, 3-5, 4-80
power, setting, 2-2
PRAM, 5-2
preparing for use, 1-1
Preset hardkey, 3-4, 4-81
Preset Language softkey, 4-129
Preset List softkey, 4-105
Preset Normal User softkey, 4-129
problems with operation, 2-16
Proceed With Reconfiguration softkey, 4-129
programming language, 1-6
PULSE annunciator, 3-10
Pulse hardkey, 4-82
PULSE IN connector, 3-7
pulse modulation, 4-82
internal rectangular, 4-83
internal squarewave, 4-83
Pulse Off On softkey, 4-83
Pulse Rate softkey, 4-84
Pulse softkey, 4-60
Pulse Source softkey, 4-84
Pulse Width softkey, 4-85
pulsed LF output, 4-60

Q

Q INPUT connector, 3-5

Q Offset softkey, 4-49

Q OUT connector, 3-18
Quadrature Skew softkey, 4-49

R

R annunciator, 3-10

rack mount flanges, installation, 1-2
RAM-based memory, 5-2

Ramp softkey, 4-10, 4-31, 4-60
RCDMA softkey, 4-130

rear panel overview, 3-12
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Recall hardkey, 3-6, 4-86
Recall Ref Osc Setting softkey, 4-130
Recall Reg softkey, 4-87
recalling instrument states, 2-12
Receive Pace None Xon softkey, 4-130
Ref Osc Coarse softkey, 4-118, 4-130
Ref Osc Fine softkey, 4-131
Ref Oscillator Source Auto Off On softkey, 4-37
Reference Oscillator Adjustment softkey, 4-130
registers
contents incorrect, 2-17
empty, 2-17
Remote Language softkey, 4-131
remote operation
annunciator, 3-10
Rename File softkey, 4-131
repair, returning your instrument, 2-20
Reset RS-232 softkey, 4-132
Restore Default Signal Polarities softkey, 4-132
Return, 3-4
Return hardkey, 3-4, 4-89
returning your instrument, 2-20

Reverse Power Protection Normal HP8648 softkey,

4-132

reverse power protection trips, 4-117
Revert to Default Cal Settings softkey, 4-49
RF frequency

setting, 2-2
RF OFF annunciator, 3-10
RF On/Off hardkey, 3-4, 4-90
RF output

low, 2-16

none, 2-16
RF OUTPUT connector, 3-4
RF output power level

setting, 2-3
right arrow key, 4-20
RS-232 Baud Rate softkey, 4-133
RS-232 connector, 3-13
RS-232 Echo Off On softkey, 4-133
RS-232 Pace softkey, 4-133
RS-232 Timeout softkey, 4-133
RTS On softkey, 4-134
RTS/CTS Pacing softkey, 4-134
RTS/CTS softkey, 4-134
RWCDMA softkey, 4-134

S

S annunciator, 3-10

safety, 6-1

safety notes, 6-2

sales and service offices, 2-21

Save hardkey, 3-6, 4-91

Save Seq[n] Reg[nn], 4-94

Save User Preset softkey, 4-135

saving and recalling an instrument state, 2-12

saving instrument states, 2-12

SCPI softkey, 4-135

screen saver, 1-5

Screen Saver Delay softkey, 4-135

Screen Saver Mode softkey, 4-136

Screen Saver Off On softkey, 4-136

Select Item softkey, 4-136

Select Reg softkey, 4-94

Select Seq softkey, 4-88, 4-95

Seq softkey, 4-137

serial number, 4-117

service request annunciator, 3-10

setting a frequency reference and frequency offset,
2-3

setting AM depth, 2-5

setting AM rate, 2-6

setting an amplitude reference and amplitude offset,
2-4

setting carrier frequency (amplitude modulation), 2-5

setting carrier frequency (frequency modulation), 2-7

setting FM deviation, 2-7

setting FM rate, 2-8

setting frequency and power levels, 2-2

setting internally-generated amplitude modulation,
2-5

setting power level (amplitude modulation), 2-5

setting power level (frequency modulation), 2-7

setting RF frequency, 2-2

setting the RF output power level, 2-3

setting up internally-generated frequency
modulation, 2-7

Shape softkey, 4-137
shipment

checking, 1-2
signal generation

installation, 1-2
Sine softkey, 4-10, 4-31, 4-60, 4-77
Single Sweep softkey, 4-105
softkey descriptions, 4-1
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softkey labels, 3-8

softkeys
# Points, 4-96
®M Dev, 4-68
®M Dev Couple Off On, 4-69
®M Off On, 4-69
®M Path 1 2, 4-70
dM Rate, 4-70
®M Source, 4-71
®M Start Rate, 4-71
®M Stop Rate, 4-72
OM Sweep Time, 4-72
®M Sweep Trigger, 4-72
®M Tone 1 Rate, 4-73
®M Tone 2 Ampl Percent Of Peak, 4-73
®M Tone 2 Rate, 4-73
®M Waveform, 4-74
Add Comment To Seq[n] Reg[nn], 4-91
Adjust Phase, 4-34
ALC BW Normal Narrow, 4-13
ALC Off On, 4-14, 4-42
Alt Ampl Delta, 4-15
Alt Ampl Off On, 4-15
Alt Ampl Trigger, 4-15
Alternate Amplitude, 4-14
AM Depth, 4-2
AM Depth Couple Off On, 4-2
AM Off On, 4-3
AM Path 1 2, 4-3
AM Path 1 2 WB, 4-3
AM Rate, 4-4
AM Source, 4-4
AM Start Rate, 4-5
AM Stop Rate, 4-5
AM Sweep Time, 4-6
AM Sweep Trigger, 4-6
AM Tone 1 Rate, 4-6
AM Tone 2 Ampl Percent Of Peak, 4-7
AM Tone 2 Rate, 4-7
AM Waveform, 4-7
Ampl, 4-96
Ampl Offset, 4-16
Ampl Ref Off On, 4-16
Ampl Ref Set, 4-16
Ampl Start, 4-97
Ampl Stop, 4-97
ARB, 4-111
ARB Catalog Types, 4-111
Atten Hold Off On, 4-17
Binary, 4-111
Bit, 4-111
Black Pixels Screen Test, 4-112

Brightness, 4-112

Burst Envelope Off On, 4-43

Burst Gate In Polarity Neg Pos, 4-112
Burst Source, 4-43

Bus, 4-7, 4-22, 4-51, 4-74, 4-97
Calibrate Selected Items, 4-112
Calibration Type User Full, 4-44
Catalog Type, 4-113

CDMA, 4-113

Clear Error Queue(s), 4-113

Clear Text, 4-92, 4-114

Configure List Sweep, 4-97

Configure Step Sweep, 4-98

Copy File, 4-114

Data Clock Out Polarity Neg Pos, 4-115
Data Clock Polarity Neg Pos, 4-115
Data Out Polarity Neg Pos, 4-115
Data Polarity Neg Pos, 4-116

DATA/CLK/SYNC Rear Outputs Off On, 4-115

DC, 4-51

DCFM/DC®M Cal, 4-22, 4-74

Delete All List Files, 4-116

Delete All Sequences, 4-86, 4-92

Delete File, 4-98, 4-116

Delete Item, 4-98

Delete Row, 4-98

Diagnostic Info, 4-117

Display, 4-117

DMOD, 4-118

Do Power Search, 4-17, 4-44

Dual Sine, 4-8, 4-22, 4-52, 4-74
DWCDMA, 4-118

Dwell Type List Step, 4-99

Edit Item, 4-99

Editing Keys, 4-93, 4-118

Editing Mode Insert Replace, 4-93, 4-118
Error Info, 4-119

Event 1 Polarity Neg Pos, 4-119

Event 2 Polarity Neg Pos, 4-119

Execute Cal, 4-44

Ext, 4-8, 4-23, 4-52, 4-74

Ext 1 AC-Coupled, 4-8, 4-23, 4-75

Ext 1 DC-Coupled, 4-8, 4-23, 4-75

Ext 2 AC-Coupled, 4-9, 4-24, 4-76

Ext 2 DC-Coupled, 4-9, 4-24, 4-76

Ext 1/Q, 4-45

Ext 1/Q Phase Polarity Normal Invert, 4-45
Ext Pos, 4-99

Extl DC, 4-44

Ext2 DC-Coupled, 4-82
Fast Pulse Off On, 4-82
FCDMA, 4-119
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FIR, 4-119

FM Dev, 4-25

FM Dev Couple Off On, 4-25
FM oM, 4-24

FM ®M Normal High BW, 4-76
FM Off On, 4-26

FM Path 1 2, 4-26

FM Rate, 4-27

FM Source, 4-27

FM Start Rate, 4-28

FM Stop Rate, 4-28

FM Sweep Time, 4-28

FM Sweep Trigger, 4-29

FM Tone 1 Rate, 4-29

FM Tone 2 Ampl Percent Of Peak, 4-29
FM Tone 2 Rate, 4-30

FM Waveform, 4-30

Freq, 4-99

Freq Multiplier, 4-35

Freq Offset, 4-35

Freq Ref Off On, 4-36

Freq Ref Set, 4-36

Freq Start, 4-100

Freq Stop, 4-100
Freq&Ampl, 4-100

FSK, 4-119

Function Generator, 4-52
FWCDMA, 4-120

Goto Bottom Row, 4-100
Goto Middle Row, 4-101

Goto Row, 4-101

Goto Top Row, 4-101
Hardware Options, 4-120
Help Mode Single Cont, 4-120
High Crest Mode Off On, 4-45
HP8648A/B/C/D, 4-121
HP8656B,8657A/B, 4-121
HP8657D NADC, 4-121
HP8657D PDC, 4-122
HP8657J PHS, 4-122

HP-IB Address, 4-122
HP-1B/RS-232, 4-123

| Offset, 4-46

1/Q, 4-124

1/Q Adjustments, 4-46

1/Q Adjustments Off On, 4-46
1/Q Calibration, 4-46

1/Q Gain, 4-47

1/Q Off On, 4-47

1/Q Source, 4-47

Immediate, 4-9, 4-30, 4-52, 4-77, 4-102
Insert Item, 4-102

Insert Row, 4-102

Installed Board Info, 4-123
Instrument Adjustments, 4-123
Instrument Info/Help Mode, 4-124
Int Burst, 4-48

Int 1/Q, 4-48

Internal, 4-10, 4-30, 4-77

Internal Modulation, 4-53
Internal Pulse, 4-83

Internal Square, 4-83

Inverse Video Off On, 4-124
labels, 3-8

LF Out Amplitude, 4-53

LF Out Freq, 4-53

LF Out Off On, 4-54

LF Out Period, 4-54

LF Out Source, 4-55

LF Out Start Freq, 4-55

LF Out Stop Freq, 4-56

LF Out Sweep Time, 4-56

LF Out Sweep Trigger, 4-57

LF Out Tone 1 Freq, 4-57

LF Out Tone 2 Ampl % Of Peak, 4-58
LF Out Tone 2 Freq, 4-58

LF Out Waveform, 4-59

LF Out Width, 4-59

List, 4-124

Load From Selected File, 4-102
Load List From Step Sweep, 4-103
Load/Store, 4-103

location, 3-5

Manual Mode Off On, 4-103
Manual Point, 4-103

MCDMA, 4-124

MDMOD, 4-125

MDWCDMA, 4-125

Memory Catalog, 4-124
MFCDMA, 4-125

MFWCDMA, 4-125

Mod Status Info Off On, 4-126
Mode 1 Optimize <10kHz Offset, 4-36
Mode 2 Optimize >10kHz Offset, 4-36
Modify License Key, 4-125
Modulation Catalog Types, 4-126
MTONE, 4-126

Noise, 4-10, 4-31, 4-59, 4-77
NVARB, 4-126

Off, 4-104, 4-126

Optimize ® Noise, 4-37

Page Down, 4-104, 4-127

Page Up, 4-104, 4-127

Pattern Trigger In Polarity Neg Pos, 4-127
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Phase Ref Set, 4-37

PN9 Mode Preset Normal Quick, 4-127
Point Trigger, 4-104

Power On Last Preset, 4-128

Power On/Preset, 4-128

Power Search, 4-18

Power Search Manual Auto, 4-18, 4-48
Power Search Reference Fixed Modulated, 4-18
Preset Language, 4-129

Preset List, 4-105

Preset Normal User, 4-129

Proceed With Reconfiguration, 4-129
Pulse, 4-60

Pulse Off On, 4-83

Pulse Rate, 4-84

Pulse Source, 4-84

Pulse Width, 4-85

Q Offset, 4-49

Quadrature Skew, 4-49

Ramp, 4-10, 4-31, 4-60

RCDMA, 4-130

Recall Ref Osc Setting, 4-130

Recall Reg, 4-87

Receive Pace None Xon, 4-130

Ref Osc Coarse, 4-118, 4-130

Ref Osc Fine, 4-131

Ref Oscillator Source Auto Off On, 4-37
Reference Oscillator Adjustment, 4-130
Remote Language, 4-131

Rename File, 4-131

Reset RS-232, 4-132

Restore Default Signal Polarities, 4-132
Reverse Power Protection Normal HP8648, 4-132
Revert to Default Cal Settings, 4-49
RS-232 Baud Rate, 4-133

RS-232 Echo Off On, 4-133

RS-232 Pace, 4-133

RS-232 Timeout, 4-133

RTS On, 4-134

RTS/CTS, 4-134

RTS/CTS Pacing, 4-134

RWCDMA, 4-134

Save User Preset, 4-135

SCPI, 4-135

Screen Saver Delay, 4-135

Screen Saver Mode, 4-136

Screen Saver Off On, 4-136

Select Item, 4-136

Select Reg, 4-94

Select Seq, 4-88, 4-95

Seq, 4-137

Shape, 4-137

Sine, 4-10, 4-31, 4-60, 4-77
Single Sweep, 4-105
Software Options, 4-137
Square, 4-10, 4-31, 4-60, 4-78
Start Frequency, 4-50
State, 4-137
Step Dwell, 4-105
Step/Knob Ratio, 4-138
Stop Frequency, 4-50
Store Ref Osc Setting, 4-138
Store To File, 4-105
Sweep, 4-106
Sweep Direction Down Up, 4-106
Sweep Repeat Single Cont, 4-106
Sweep Trigger, 4-107
Sweep Type List Step, 4-107
Swept Sine, 4-11, 4-31, 4-61, 4-78
Symbol Sync Out Polarity Neg Pos, 4-138
Symbol Sync Polarity Neg Pos, 4-138
Transmit Pace None Xon, 4-139
Triangle, 4-11, 4-32, 4-61, 4-78
Trigger In Polarity Neg Pos, 4-11, 4-32, 4-61, 4-78
Trigger Key, 4-12, 4-32, 4-62, 4-79, 4-107
Trigger Out Polarity Neg Pos, 4-12, 4-33, 4-62,
4-79, 4-108
Unselect All Items, 4-117
Unselect Item, 4-117
UWCDMA, 4-139
View Next Error Message, 4-139
View Previous Error Message, 4-140
WCDMA, 4-140
White Pixels Screen test, 4-140
software option
enabling, 2-15
Software Options softkey, 4-137
Square softkey, 4-10, 4-31, 4-60, 4-78
standby LED, 3-5
standby symbol, 6-3
Start Frequency softkey, 4-50
State softkey, 4-137
statement of compliance, 6-5
Step Dwell softkey, 4-105
step sweep
configuring, 2-9
creating, 2-9
step sweep (continuous)
turning on, 2-10
step sweep dwell time, 4-105
step sweep points, 4-96
step sweep, creating, 2-9
Step/Knob Ratio softkey, 4-138
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Stop Frequency softkey, 4-50
Store Ref Osc Setting softkey, 4-138
Store To File softkey, 4-105
sweep

creating, 2-9

list not recalled, 2-17

list points, editing, 2-10

stepped, configuring, 2-9

triggering point-by-point, 4-104

turning off, 4-104
SWEEP annunciator, 3-10
Sweep Direction Down Up softkey, 4-106
sweep list dwell time, incorrect, 2-18
sweep mode

turning off, 2-17
SWEEP OUT connector, 3-14
Sweep Repeat Single Cont softkey, 4-106
Sweep softkey, 4-106
sweep trigger

bus, 4-97

external, 4-99

immediate, 4-102

trigger key, 4-107
Sweep Trigger softkey, 4-107
Sweep Type List Step softkey, 4-107
Sweep/List hardkey, 4-96
Swept Sine softkey, 4-11, 4-31, 4-61, 4-78
switch, power, 3-5
SYMBOL SYNC input connector, 3-7
SYMBOL SYNC OUT connector, 3-13
Symbol Sync Out Polarity Neg Pos softkey, 4-138
Symbol Sync Polarity Neg Pos softkey, 4-138

T

T annunciator, 3-11

talk mode annunciator, 3-11

temperature requirements, 1-4

text area, 3-9

Transmit Pace None Xon softkey, 4-139

Triangle softkey, 4-11, 4-32, 4-61, 4-78

Trigger hardkey, 3-3, 4-109

TRIGGER IN connector, 3-14

Trigger In Polarity Neg Pos softkey, 4-11, 4-32, 4-61,
4-78

Trigger Key softkey, 4-12, 4-32, 4-62, 4-79, 4-107

TRIGGER OUT connector, 3-14

Trigger Out Polarity Neg Pos softkey, 4-12, 4-33,
4-62, 4-79, 4-108

troubleshooting, 2-16

can't turn off help mode, 2-18

empty registers, 2-17

incorrect LF output signal, 2-18

incorrect register contents, 2-17

incorrect sweep list dwell time, 2-18

no modulation at RF output, 2-17

no RF output, 2-16

optional features not working, 2-16

power supply shut down, 2-17

RF output too low, 2-16

signal generator locked up, 2-19

sweep list not recalled, 2-17

turning off sweep mode, 2-17
turning on a step sweep (continuous), 2-10
turning on amplitude modulation, 2-6
turning on frequency modulation, 2-8
turning on list sweep for a single sweep, 2-11

U

UNLEVEL annunciator, 3-11
UNLOCK annunciator, 3-11
Unselect All Items softkey, 4-117
Unselect Item softkey, 4-117
up arrow key, 4-20
Update in Remote softkey
softkey, Update in Remote, 4-139
usage requirements, 1-4
user files
copying, 5-4
deleting, 5-4
renaming, 5-4
viewing, 5-3
Utility hardkey, 4-111
UWCDMA softkey, 4-139

Vv

ventilation, 1-4

ventilation requirements, 1-4

verification, operation, 1-7

View Next Error Message softkey, 4-139
View Previous Error Message softkey, 4-140
volatile memory, 5-2

W

warning sign, 6-2

WCDMA softkey, 4-140

White Pixels Screen Test softkey, 4-140
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